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Part 1: ON1 Photo RAW 2017 Overview

ON1 Photo RAW 2017 is a complete photo editor that includes:
•  A super-fast Browse module that lets you quickly cull, tag and organize your pho-

tos;
•  True non-destructive Raw editing capabilities in the Develop and Effects modules;
•  Industry-standard image enlargement—with full print capabilities—in the Resize 

module; 
•  Layers, which lets you composite and blend images in a fully layered workflow.

Flexible workflow
ON1 Photo RAW 2017 incorporates a state-of-the-art Raw processor, which lets you work in 
a fully non-destructive workflow: you can quickly sort and view Raw photos in Browse, edit 
them in either the Develop or Effects modules without having to worry about saving your 
edits. The next time you edit your photo, all of your settings will be remembered, and you 
can easily change any settings, add new ones, or start over from scratch, all without having 
to save additional versions of your photo. Photo RAW is even non-destructive when working 
with such non-Raw formats as JPG, Photoshop (PSD), PNG and TIFF.

If you have an existing Raw editing and workflow app such as Adobe’s Photoshop, Pho-
toshop Elements or Lightroom or Apple Photos, ON1 Photo RAW can also work as a plug-in 
to these apps, letting you perform advanced editing tasks on your photos while preserving 
your traditional workflow. And, with ON1’s optional Smart Photo technology—available when 
using Photo RAW as a plug-in for Lightroom and Photoshop, or when working with photos in 
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the Layers module—you can save your photo back to your primary app, and still be able to 
re-edit your photo later in Photo RAW with its settings intact: reopening a Smart Photo inside 
Photo RAW will display the image exactly as you left it previously. 

Using the Help System
Find and watch free video tutorials at the ON1 Photo RAW 2017 Product Training site, avail-
able at ON1.com. This is the best and quickest way to dig into the ON1 workflow and discov-
er new techniques that will help you with your photo editing and organizing. There, you can 
search our Knowledge Base for frequently asked questions, common issues and more.

System requirements
Minimum Recommended

Operating System Mac OS 10.9, 10.10, 10.11, 10.12
Windows 7, Windows 8 or Win-
dows 10 current maintenance 
releases, 64-bit only

Mac OS 10.11, 10.12
Windows 7, Windows 8 or Win-
dows 10 current maintenance 
releases, 64-bit only

Processor Intel Core 2 Duo, Xeon or better 
processor

Intel Core i5, Xeon or better pro-
cessor

RAM 4 GB (8 GB when used as a Photo-
shop plug-in)

16 GB RAM

Hard Drive 1.5 GB for installation 1.5 GB for installation 
Fast 7200 RPM or SSD drives for 
optimal performance

Display OpenGL 3.3 compatible vid-
eo card with 512 MB video 
RAM,1280x720 resolution

OpenGL 4.2 compatible video 
card with 1 GB dedicated video 
RAM, 1920x1080 resolution

Third-party apps 
supported (plug-
in)

Photoshop CS6, CC (all versions)
Photoshop Elements 13, 14, 15
Photoshop Lightroom 5, CC (all versions)
Apple Photos

Other Internet connection for activation, 
auto update checking, content 
downloads and tutorials.

Internet connection for activation, 
auto update checking, content 
downloads and tutorials.
Wacom tablet for pressure-sensi-
tive input 
Hardware display calibration tool

https://www.on1.com/blog/category/product-training/
https://on1help.zendesk.com/hc/en-us
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Installation
To install ON1 Photo RAW 2017, double-click the installer icon and allow the installer to 
guide you.

Be sure to close any supported host applications such as Adobe Photoshop, Elements or 
Lightroom, as well as any previous versions of ON1 products before installing or updating.

Mac OS
The application is installed in the ON1 Photo RAW 2017 folder in the Applications folder.

All plug-in files for supported host applications (such as Adobe Photoshop, Lightroom, or 
Photoshop Elements) found during the installation process will be installed automatically. You 
will see a summary of installed plug-ins at the end of installation.

If a previous version of ON1’s Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application 
Support/ folders.

Windows
The application is installed in the ON1 Photo RAW 2017 directory in the ON1 directory in the 
Program Files directory.

All plug-in files for supported host applications (such as Adobe Photoshop, Lightroom, 
Photoshop Elements) found during the installation process will be installed automatically. You 
will see a summary of installed plug-ins at the end of installation.

If a previous version of ON1’s Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\ on Windows.
 
Launching ON1 Photo RAW
To launch Photo RAW as a standalone app, with access to all modules, follow these steps:

Mac OS
•  Open your Finder.
•  Navigate to the Applications folder.
•  Navigate to the ON1 Photo RAW 2017 folder.
•  Double click on the ON1 Photo RAW 2017 application icon.
You can add ON1 Photo RAW 2017 to your dock for easy access by clicking and holding 

the icon in the dock and selecting the Keep In Dock option. If you use Launchpad it can be 
found there as well.

Windows 7
•  Go to your Start Menu.
•  Select the ON1 group.
•  Select ON1 Photo RAW 2017.
•  If you selected the “Add Icon to Desktop” option during installation you can also 

access ON1 Photo RAW 2017 from there.



ON1 Photo RAW 2017 User Guide	 Part 1: Overview	 4

Windows 8.1 and Windows 10
•  Open the Start screen by pressing the Window key.
•  Select ON1 Photo RAW 2017.
•  If you selected the “Add Icon to Desktop” option during installation you can also 

access ON1 Photo RAW 2017 from there.

To launch ON1 Photo RAW from an external application, such as Adobe Photoshop or Light-
room, see the sections below for complete instructions.

Licensing and registration
When you first launch ON1 Photo RAW, you will be presented with a window asking you to 
activate your software. In this window, you can either enter your ON1 account information (if 
you have purchased the app) or can start a free trial of the app.

If you have purchased ON1 Photo RAW 2017:
Fill in your ON1 account information (email and password) to register the app with us. (You 
should have set up an account when you purchased the software.) If the computer you are 
signing in with does not have access to the internet, you can manually register your software 
by clicking on the “No Internet connection” link in the 
license dialog. 

Your license lets you install ON1 Photo RAW 2017 on 
five computers. When you enter your ON1 account info, 
Photo RAW communicates with the ON1 activation server 
and registers your software for that computer.

If you wish to move your copy of ON1 Photo RAW from 
one registered computer to a new one you will need to sing 
out first. Open Photo RAW and select Sign Out from the 
Help menu. This will turn off Photo RAW on the current ma-
chine, and you can install and sign in on another machine.

You can log into your ON1 user account area (https://
www.on1.com/login/) at any time to download the software, 
see the number of computers you have registered, and 
make basic changes to your account information, including 
updating your email address, changing your password, and 
turning notifications on or off.

If you have issues related to installing or activating Photo RAW, please contact ON1’s 
customer support, which can be reached by clicking on the Support tab (https://on1help.
zendesk.com/hc/en-us) on the main ON1 website.

Trial version
ON1 Photo RAW can also operate as a fully featured trial version for 30 days from when you 
first launch it. This gives you time to evaluate the product and see if it fits your needs. If you 
have downloaded Photo RAW to try it out, simply click on the Trial button in the Activation 
window. Each time you launch ON1 Photo RAW during the trial period, you will see the win-

If you have purchased ON1 Photo RAW, simply 
enter in your ON1 account info to register and 

activate it. If you would like to try the app free for 
30 days, click the Try It button.

https://www.on1.com/login/
https://www.on1.com/login/
https://on1help.zendesk.com/hc/en-us
https://on1help.zendesk.com/hc/en-us
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dow, which will tell you how many days remain in the trial. 
You can purchase ON1 Photo RAW at any time from this window by clicking on the Pur-

chase button. If you do that, just enter your ON1 account information the next time you 
launch the product and the activation window will no longer appear.

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many 
methods to gather your ideas and feedback including: emails, surveys, direct conversations, 
market analysis and the Product Improvement Program. The Product Improvement Program 
is built into our software and gathers information about how our software is used. It is the 
most accurate way for us learn what features are important to you and how our products fit 
into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information 
about how you use our programs and basic information about your computer. This informa-
tion helps us learn what features are important to you and how we can make our software 
easier to use. No personal information is collected and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you 
launch an on1, Inc. product. You can change your participation later, just click the Help menu, 
then Help Improve ON1, Inc. Products.

To learn more about the Product Improvement Program, go to the Support area of the 
ON1.com website.

Uninstalling ON1 Photo RAW 2017
To uninstall ON1 Photo RAW 2017, follow these instructions:

First, deactivate your product: open ON1 Photo RAW and select Sign Out… from the Help 
menu. (This will allow you to transfer your license to another computer.)

Mac OS
Go to the Applications/ON1 Photo RAW 2017/Documentation folder.
Double click on the Remove ON1 Photo RAW 2017 application.

Windows
Go to Control Panels.
Under Programs select Uninstall a program.
In the list that comes up select ON1 Photo RAW 2017 and then click on the Uninstall button.
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Working with Files
ON1 Photo RAW 2017  supports the opening and saving of the following file types, in RGB 
color mode, either 8 or 16 bits per pixel.

•  Raw files from most major camera manufacturers (file extension varies by manufac-
turer)

•  Digital Negative (DNG)
•  Photoshop (PSD)
•  Photoshop Large Document (PSB)
•  Tagged Image File Format (TIFF)
•  Joint Photographic Experts Group JPEG (JPEG)
•  Portable Network Graphic (PNG)

File access when using Photo RAW as a standalone application (Browse)
When used as a standalone app with Browse as your starting module, ON1 Photo RAW 2017 
uses your camera manufacturer’s Raw format as the default format when editing your photos. 
ON1 Photo RAW’s non-destructive editing capabilities let you view your Raw files—or any 
other supported file type listed above—in Browse, edit them in the Develop or Effects mod-
ules without having to create any intermediary files. There are no multiple versions of images 
cluttering up your directory; ON1 Photo RAW remembers the edits you’ve made to your 
photos in Develop and Effects and applies them non-destructively to your original.

This means is that there is no need to “open” the files to edit them in Develop or Effects; 
you just work with them as desired, and ON1 Photo RAW will remember your edits as you 
travel across the modules. You’ll only need to save them in a different form when you wish to 
export or share them in non-Raw formats, or when you wish to work with the Layers or Resize 
modules.

File access when using Photo RAW as a standalone application (Layers)
When used as a standalone app with Layers as your default module, you lose the capability 
to work in a non-destructive editing environment, but you still get the benefits of the edit-
ing modules, as well as Layers’ advanced layering and masking options. If you would like to 
preserve edits made in the Develop or Effects modules from within Layers, you can convert 
the image layer to a smart layer by right-clicking on the layer and choosing Convert to Smart 
Layer. (Smart layers are a layered version of Smart Photos—see below for more.) 

For more on how to use this feature effectively, see the Layers section of this guide. 

File access when using Photo RAW as a plug-in
If you use ON1 Photo RAW as a plug-in for another Raw editor (Lightroom, for example), 
using Photoshop-format (.PSD) files will maintain all the layers and layer masks you create in 
ON1 Photo RAW and are recommended as your main file format. Photoshop files may also 
be saved inside Photo RAW as a Smart Photo, which is an ON1-specific variant of the Photo-
shop format that allows you to re-edit your settings at a later date (see below). If your saved 
file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved 
in the .PSB (or Large Document) format. This is a newer version of the PSD format and still 
maintains all your layers and masks.
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Smart Photos
A Smart Photo is a special ON1-specific version of the Photoshop (PSD) file format that saves 
your editing settings and masks from the Develop or Effects modules so you can go back and 
re-edit them later. Any settings you make, including masks and control points, are readjust-
able. Smart Photos are primarily used when you access ON1 Photo RAW from within Light-
room, or when you use Layers as your editing home. (Re-editability is available from within 
Photoshop when you use Photoshop’s Smart Objects, as detailed in the Working with Adobe 
Photoshop section below.)

For complete information on how to create Smart Photos, see the Lightroom and Layers 
sections of this user guide.

Similar to Smart Objects in Photoshop, Smart Photos have certain limitations. You cannot 
use any tool that will change the original pixels, size or proportions such as the Crop or Trans-
form tools. (This includes the retouching tools in Layers.) Smart Photo information is limited 
to the operations you can provide in the Develop and Effects modules.

NOTE: Even though a Smart Photo is a variant of the Photoshop file format, 
Photoshop does not recognize the information ON1 Photo RAW uses to provide re-
editing capability. If you open a Smart Photo inside Photoshop, you will be prompted 
to flatten the document. If you are sure you do not want to re-edit the photo inside 
Photo RAW, click OK; otherwise, cancel and make a copy of your photo before 
opening it inside Photoshop.

Re-Editing a Smart Photo
There are two ways to open and re-edit a Smart Photo depending on your product configura-
tion, but both methods require that you open the Smart Photo first in Layers:

•  If you are working in Browse, you can tell if a PSD photo is a Smart Photo by the 
gear symbol in the lower right corner of the image’s thumbnail. To re-edit it, click 
on the photo, then choose Edit in ON1 Layers from the Edit menu.  

•  If you are using Lightroom, to send a Smart Photo to ON1 Photo RAW, Select ON1 
Layers 2017 from the File > Plug-In Extras menu.

Once you have the Smart Photo inside Layers, you will see the modules you worked in 
underneath the main photo layer, which is represented as a Smart Layer. Double-clicking on 
the module name will launch either Develop or Effects, letting you view the previous edit set-
tings, and letting you reset or make changes to the photo. Clicking Done inside the module 
will return you to Layers, where you can make any other 
adjustments to the photo, then save it back to Lightroom.

A Smart Photo opened in Layers has the 
modules used to edit the original file. Double-
clicking on the module name (Effects, in this 
case) will launch that module and let you make 
any changes or additional edits.
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ON1 Photo RAW 2017 Modules
ON1 Photo RAW 2017 has five modules: Browse, Develop, Effects, Resize and Lay-
ers. Each module focuses on one task, giving you access to just what you need to get 
that task done. Browse handles all file-management operations; Develop and Effects 
perform non-destructive pixel editing; Resize is used to enlarge images, largely for 
printing to large-format printers; and Layers is a complete, layered workflow tool for 
compositing images. 

NOTE: If you used an earlier version of ON1 Photo or Perfect Photo Suite, the 
Black & White and Portrait modules have been incorporated into Effects.) 

Starting modules in standalone mode
When used as a standalone application, Browse is the default module at first launch, 
it is used to navigate your drives and cloud services to find images to begin working 

with. If you wish to use ON1 Photo RAW in a non-destructive workflow with your Raw files, 
you should keep Browse as your default module. 

If you prefer a layered workflow you can use the Layers module as the heart of your work-
flow; this is similar to using Adobe Photoshop. You can change the default startup module to 
Layers in ON1 Photo RAW’s Preferences.

The Module Selector
The Module Selector is on the right side of the screen, visible at all times. Depending upon 
which module you are working in, and where you started—in standalone mode, or when 
you’re using ON1 Photo RAW as a plug-in—some or all of the modules might be disabled, 
depending upon where you start from:

•  If you use Photo RAW as a standalone, with either Browse or Layers, you can click 
on any module to go to that module.

•  If you access Photo RAW as a Photoshop plug-in you see the Module Selector, but 
all of the modules will be disabled, with the exception of Develop and Effects: You 
can move freely between those modules.

•  If you use Lightroom, which modules are visible depends upon the method in which 
you came from Lightroom. For more complete information, see the Working with 
Adobe Lightroom section below.
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Using ON1 Photo RAW as a Raw editor
ON1 Photo RAW 2017 can be used as a standalone application without the need of Photo-
shop, Lightroom or another editing application. Using it in this manner gives you access to all 
the modules and a complete Raw-based workflow with non-destructive editing capabilities.

ON1 Photo RAW workflow, from Browse to Develop and Effects
When used as a standalone photo editor, ON1 Photo Raw offers true non-destructive Raw 
editing capabilities. This means you can view your images in the Browse module, open a 
Raw file in Develop or Effects and apply edits—including cropping, healing and local adjust-
ments—and ON1 Photo RAW will always be working with your original Raw file. At any point, 
you can go back to Develop or Effects and change any or all settings you have made. 

If you wish to export your photo, share it with online services, or add it to a layered doc-
ument for compositing and editing in the Layers module, ON1 Photo RAW will apply your 
changes to a copy of the Raw file and let you save it in a number of popular file formats.

Understanding the Raw pipeline in ON1 Photo RAW
There are many editing operations you can make to a Raw file with ON1 Photo RAW, from 
broad global adjustments for exposure and color, the application of effects, to cropping, 
retouching and local adjustments on portions of a photo. Because there has to be some 
structure of how edits are applied to a Raw file, it might be helpful to understand the order 
in which edits are applied to a Raw file. Whenever you view an edited image in ON1 Photo 
RAW, this his how the image ‘stack’ is ordered:

•  The Raw image is always at the bottom of the stack. This is your original, and you 
can always get back to that file.

•  Since retouching—operations like removing dust spots, editing blemishes or skin 
imperfections—is often the first thing many photographers do to their images, 
ON1 Photo RAW applies any retouching first. This way, all subsequent edits will 
incorporate these changes.

•  Following that, any cropping or transformations (rotating a photo, for example) are 
applied. Like everything else, these operations are re-editable.

•  Next are settings applied in the Develop module. This includes global exposure, 
color correction, sharpening and noise reduction.

•  Edits made in the Effects module are applied on top of the Develop settings.
•  Any local adjustments made to an image are applied at the ‘top’ of the image-edit-

ing stack.
You don’t have to edit your photos in this order; this is just the way in which Photo RAW 

applies the edits you make to an image. You might find a dust spot, for example, only after 
changing exposure settings in Develop or applying a filter in Effects. You can use the Perfect 
Eraser to remove the spot and continue with your editing, and Photo RAW will apply it at the 
proper place in the stack.

Note: While editors like ON1 Photo RAW, Lightroom, Photoshop and others can open 
and edit Raw files, they are not compatible with one another. Any edits made to a 
Raw file in one program will not be visible in the other. For best practices, you should 
generally choose one program to be your organizational and Raw editing tool.
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Using ON1 Photo RAW with Adobe® Photoshop®
When you edit an image sent from Photoshop to ON1 Photo RAW, you are editing Photo-
shop’s currently selected layer. By default, Photo RAW makes a copy of the layer, so your 
original layer is saved, unless it is a Smart Object (see below). If you’d like to change this 
preference, see the Plug-Ins section of the Preferences window.

ON1 Photo RAW 2017 is accessible from within Photoshop in two ways, from the File > 
Automate menu, and from the Filter > ON1 menu. From the Automate menu, you can access 
the Develop, Effects and Resize modules; from the Filter menu, you can access the Develop 
and Effects modules. (Browse, Layers and Export are not accessible from within Photoshop.) 

There are two options for editing an image in ON1 Photo RAW. Which method you 
choose depends upon whether you think you might wish to re-edit your image in ON1 Photo 
RAW. 

To use ON1 Photo RAW 2017 inside of Photoshop without re-editability follow these steps:
•  Open the image you want to work on in Photoshop.
•  Select the layer you want to work on. Make a duplicate if you want to preserve the 

original layer (Layer > Duplicate).
•  From the Filter menu, select ON1 and then the module you would like to use.
•  When you’re finished editing your photo, click the Done button in ON1 Photo 

RAW. The edited version of the layer will replace your originally selected layer.

If you would like to be able to re-edit your Photoshop images at a later point inside ON1 
Photo RAW, follow these steps:

•  Open the image you want to work on in Photo-
shop.

•  Select the layer you want to work on. 
•  Right-click on the layer and choose Convert to 

Smart Object. 
•  From the Filter menu, select ON1 and then the 

module you would like to use.
•  When you’re finished editing your photo, click the 

Done button in Photo RAW.

To re-edit your Smart Object 
layer again inside ON1 Photo RAW, double-click on the ON1 
module name in the edited layer in Photoshop. ON1 Photo RAW 
will then launch that module, and let you change your previous 
settings or make new ones.

To re-edit a Smart Object layer in 
Photo RAW, double-click on the ON1 
module name in the layer.



ON1 Photo RAW 2017 User Guide	 Part 1: Overview	 11

Using ON1 Photo RAW with Adobe® Lightroom®
ON1 Photo RAW 2017 can be accessed from within Lightroom, providing an integrated, 
round-trip workflow of your images. All of the modules, with the exception of Browse, are 
accessible from within Lightroom.

Note: Lightroom is a Raw editor similar to ON1 Photo RAW 2017; while both programs 
can open and edit Raw files, they are not compatible with one another. Any edits made 
to a Raw file in one program will not be visible in the other. For best practices, you 
should generally choose one program to be your organizational and Raw editing tool.

There are two primary ways to use ON1 Photo RAW 2017 with Lightroom, via the Plug-In Ex-
tras command in the File menu and the Edit In command in the Photo menu. Using the Photo 
> Edit In menu gives you quick access to the Develop or Effects and Resize modules, while 
File > Plug-In Extras gives you access to those three modules, plus Layers and Export.

Using ‘Plug-In Extras’
Accessing ON1 Photo RAW from the File > Plug-in Extras menu is the preferred way to ac-
cess the app. It gives you access to all installed modules (except Browse) and has the most 
flexibility in how the files are handled. To edit an image in ON1 Photo RAW, select the image 
in Lightroom, go the File menu and select the Plug-In Extras sub-menu, and choose the mod-
ule you would like to use. (If you use either Develop or Effects, you can move between the 
modules directly inside ON1 Photo RAW.)

File creation characteristics when using Plug-In Extras
When you use ON1 Photo RAW through the Plug-In Extras menu there are important 
file-handling options that are controlled in the ON1 Photo RAW Preferences dialog. These 
need to be configured in advance based on your desired workflow. Once these are set, all 
images sent to Photo RAW via the Plug-In Extras sub-menu will 
use these characteristics:

•  Save Photoshop Files As: Controls how Photoshop files 
opened from Lightroom are saved, as smart photos or 
regular PSDs.

•  File Type: The file type drop-down menu determines 
what type of file will be created. The default is PSD, 
which maintains layers. You can also select JPG or TIFF, 
if you prefer those formats and are not concerned about 
maintaining layers. 

•  Color Space: The color space drop-down menu deter-
mines what RGB working color space is used; Adobe 
RGB 1998, sRGB or ProPhoto RGB.

•  Bit Depth: The bit-depth drop-down menu determines 
the bit depth, either 8-bit or 16-bit per pixel.

•  Resolution: The resolution drop-down menu determines 
the resolution of the file.

When sending a file from Lightroom 
to Photo RAW via Lightroom‘s Plug-
In Extras menu, the edited file will be 
created according to your settings in the 
Files section of Photo RAW’s Preferences 
window.
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Selecting Multiple Images (Layers module only)
If you wish to open multiple Lightroom photos as individual layers in a single canvas in the 
Layers module, choose File > Plug-In Extras > Open as Layers in Layers. If you wish to open 
multiple photos as separate files in the Layers module, choose File > Plug-In Extras > ON1 
Layers.

Using ‘Edit In’ from Lightroom
For quick editing of photos in Develop, Effects and Resize, select your image in Lightroom, 
go to the Photo menu and select the Edit In sub-menu and choose the module you wish to 
work in. (If you use either Develop or Effects, you can move between those two modules 
directly inside ON1 Photo RAW.)

File creation characteristics when using Edit In sub-menu
When you use the Photo > Edit In sub-menu, Lightroom will 
ask you each time how you wish to edit the selected image. 
You have three editing options—Edit a Copy with Lightroom 
Adjustments, Edit a Copy, or Edit Original (not available when 
editing Raw photos—and can set the file type (TIFF, Photoshop 
or JPEG), color space and bit depth for the resultant file. We 
suggest using the Photoshop format, which is required if you 
wish to create a Smart Photo for re-editing later.

Batch processing with Lightroom’s Export and ON1 Resize
If you want to use the Resize module to enlarge a group of photos in Lightroom, you can 
batch-process the group through the Export menu in Lightroom:

•  Select the images you wish to batch process.
•  Go the Export under the File menu.
•  At the top under the Export To drop-down, select ON1 Resize 2017.
•  Complete the module specific options. If you wish to use an existing Resize pre-

set, select the Category and Preset; otherwise, choose the Image Size option and 
adjust your settings accordingly.

•  Set any other Lightroom-specific export settings you wish to use.
•  Press the Export button.

Note: You cannot save Lightroom export presets or use the Export with Previous 
option. 



ON1 Photo RAW 2017 User Guide	 Part 1: Overview	 13

Using ON1 Photo RAW with Apple® Photos
ON1 Photo RAW 2017 integrates tightly with Apple Photos (for Mac OS only) and provides a 
seamless experience for enhancing your images. 

NOTE: The connection between Photo RAW and Photos does not include Smart 
Photo capability; any edits made inside Develop or Effects are final, although you can 
reset your photo to its original state inside Photos.

If you have Photos on your computer when 
you install ON1 Photo RAW, the appropri-
ate plug-in will be installed, but you will 
need to manually activate it in order to use 
it. To do so, go to Apple’s System Prefer-
ences and click on the Extensions icon. In 
the Extensions pane, click on Photos, then 
check the ON1 Develop 2017 and ON1 
Effects 2017 boxes. This will let you send 
images from Apple Photos to Photo Raw. 

To edit an image in ON1 Photo RAW 2017 follow these 
steps:
•  Select the image you wish to edit in Photos.
•  Click on the Edit button.
•  On the right side of the window, at the bottom of 
the editing controls, you’ll see an Extensions pop-up. 
Click on that button, and choose the module you wish 
to edit.

After installing ON1 Photo RAW 2017 on your Mac, you must turn the 
Photos extension on via Apple’s Extensions System Preference.

Click the pop-up menu next to the Extensions 
label, and you’ll see the options for sending your 
photo to either Develop or Effects.
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Printing
ON1 Photo RAW 2017 has full printing capabilities built directly into the product, and you 
can print your photos from any module, using the Print command from the File menu. 

To print an image, follow these steps:
•  Select Print from the File menu.
•  Select your printer from the Printer pop-up.
•  Press the Print Setup button to adjust printer specific options such as paper size 

and type and printer specific color management options.
•  Adjust the number of copies, orientation and output resolution.
•  In the Print Area section set the area to fit, fill or actual size. The preview on the 

left shows the paper size and margins as well as the print area and how the image 
will fit or fill the print area. (When using Fill Entire Area, you can move the photo 
around the print area box.) 

•  Select the output Printer Profile and Rendering Intent to properly adjust the photos 
colors to your printer and paper combination. You may also select the Printer Man-
aged Color option to let your printer driver manage the color instead.

TIP: If you have already cropped and sized your image to your desired print area size, 
simply set the width and height to match in the Print Area section. 

Extras
ON1 Photo RAW 2017 supports a number of additional file types that can be used in various 
modules, called Extras. These file types include:

•  Backgrounds that can be imported and used in Layers.
•  Borders than can be imported and used in Layers and Effects.
•  Textures that can be imported and used in Layers and Effects.

ON1 includes a number of extras in the product when you install ON1 Photo RAW, and you 
can create your own, or add extras downloaded from the ON1 website. You can use the Ex-
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tras Manager to import and manage your own extras, creating categories for each extra type, 
and deleting user-added extras that you no longer want.

How to Import Extras
To import backgrounds, textures and borders, choose Manage Extras from the File menu in 
Browse and Layers, then follow these steps:

•  Select the type of extras you wish to import in the left column (Backgrounds, Bor-
ders, etc.) You can only import extras of one type at a time.

•  Click on the Import button in the footer of the left column. A Finder or Explorer 
Window will appear where you can select the files to import. If you want to import 
an entire folder, click into the folder then select the first file, then shift-click on the 
last file. Click import when you selection is complete.

•  Select a category for your extras to live in. This is where you will be able to find it 
inside of the ON1 Photo RAW 2017. You can select from an existing category or 
create a new one.

When your extras have been imported you will see them in the Extras Manager in the catego-
ry you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?
Backgrounds and textures may be any image file that ON1 Photo RAW 2017 can open in-
cluding JPEG, TIFF, Raw or Photoshop files. Border files must have a large central area that is 
transparent, so only files that support transparency, such as PNG, can be imported as bor-
ders.

NOTE: Presets are managed separately inside the Develop and Effects modules, and 
if you download an .ONP (preset) file, you can simply double-click on it to install it. 
For more information, check the Develop and Effects sections of this user guide.

Using Extras in Layers
Click on the Extras tab of the left column mini-browser. You will see top-level folders for ON1 
Extras and User Extras. Inside of these will be sub-folders for Backgrounds, Borders and Tex-

The Extras Manager lets you import textures, backgrounds and borders for use in Effects and Layers.
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tures. You can double-click on an extra to add it to your current image, just use the “Add as a 
Layer” option when asked how you want to open the file.

When working with extras, you can perform the following:
•  You can use the transform tool to size and position the extra on your image.
•  Use the Layers pane to change the order, opacity and blending mode.
•  Use the Masking Brush and Masking Bug to selectively apply the extra.
•  Use the Perfect Eraser to remove distractions from the extra if needed.
•  If you save your file as a layered PSD file, you can always re-open the file again and 

have access to all of the layers and masks for further editing.

Using Extras in Effects
You can access certain extras—borders and textures—inside of Effects. To use them follow 
these steps:

•  Open an image into Effects.
•  In the Filter Options pane, select either the Borders or Textures filter type.
•  From the Category pop-up, select a category you have imported. User-added ex-

tras categories will appear at the bottom of the category list.
•  From the Texture or Borders pop-up select a texture or border from the category 

you selected.

Note: More information on the Borders and Textures filters can be found in the 
Effects section of this user guide. 

How to Delete Extras
You can remove imported extras using the Extras Manager. Follow these steps:

•  Open the Extras Manager in Browse or Layers (File > Extras Manager).
•  Click on the extras type that contains the content you wish to remove. This will dis-

play categories within that extras type.
•  To delete an entire category, select in the left column and click on Delete button in 

the footer of the left column.
•  To delete individual extras, select them in the right column and click on the Delete 

button in the footer of the right column.
Deleting extras is permanent and can not be undone.
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Preferences
ON1 Photo RAW 2017 has a number of system-wide settings that you can set via the Pref-
erences window. To access Preferences, either click on the gear icon at the lower left side of 
the screen, or choose Preferences from the ON1 Photo RAW 2017 menu (Mac OS) or the Edit 
menu in Windows. 

The Preferences window has six tabs: General, Files, Plug-Ins, System, Services, Photo Via. 
The settings in each tab are described below.

General Settings

Working Color Space
When a new file is created or file is opened and has no color profile associated with it, this is 
the assumed color profile for the image. Images that come from plug-ins or have tagged or 
embedded profiles will use the associated profile instead.

Scrolling Controls
Lets you select how the mouse scroll wheel or scrolling gesture works. The options are:

•  None: Default.
•  Preview Zoom: Adjusts the zoom of the preview window. Scrolling up increases the 

zoom, scrolling down decreases the zoom.
•  Preview Pan: Pans the image, like using the pan tool or navigator. It is important 

that the panning is comfortable, not too fast or slow or jerky.
•  Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color
You may select the color of the background behind the preview image. The default color is 
black. There is options for black, white, light gray, dark gray and custom. The custom option 
has a color picker where you can select your own background color.
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Start In
Determines which module will open at launch. Browse is the default.

Check for Update on Launch
Enabled by default, the product will communicate with ON1 server at launch and if an update 
is available it will prompt you to download or skip.

Warn when leaving files in Layers
Enabled by default. If you have unsaved files open in Layers and want to close the program a 
warning dialog will appear with the options to Save & Close, Cancel or OK (close without saving).

Files

The Files tab is used to determine what file type ON1 Photo RAW will create when opening a 
file in Resize, or as a plug-in from an external application, or when creating copies to send to 
an external editor from within Browse. 

What to Edit
There are five options in the What to Edit section of the Files tab: 

•  File Format: Sets the file type you wish to create: PSD, TIFF, or JPEG. If you wish to 
use a layered workflow, you must choose PSD.

•  Color Space: Sets the default color space when opening a copy of a file; the list 
includes Adobe RGB 1998, Apple RGB (Mac OS), sRGB, ProPhoto RGB, or Color-
Match RGB. You can also import your own color profile, if you choose.

•  Bit Depth: Sets the bit depth for the file when opening a copy of a file.
•  Resolution: Sets the resolution when opening a copy of a file.
•  Show these options every time: If you do not wish to use a predefined set of file 

characteristics for opening photos from Lightroom or Photoshop, click this box.
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Sidecar Options
Click this box if you wish ON1 Photo RAW to create ON1-specific ‘sidecar’ files when you are 
editing images in Develop or Effects. This is helpful if you are using the same image library 
with multiple computers (on an external hard drive, for example), and want your edits to be 
visible on each machine.

Plug-Ins

The Plug-Ins tab is specific to using ON1 Photo RAW as a plug-in for Photoshop or Light-
room, and lets you set up certain conditions when opening files from these apps.

Smart Photos
•  Save PSD Files As: When you send a PSD file type to Photo RAW via Lightroom you 

can save the file as a Normal Photo or a Smart Photo, or have Photo RAW ask your 
preference every time you open a file from within Lightroom.

Photoshop
•  Apply Results to: When editing in Photoshop you can choose to have your effect 

added to a copy of your current layer or to the current layer. You can also choose to 
start with the last used settings when launching ON1 Photo.

Lightroom
As shown in the Working with Lightroom section above, this preference lets you choose the 
specific options for files opened via the Plug-In Extras menu in Lightroom:

•  Save Photoshop Files As: Controls how Photoshop files opened from Lightroom 
are saved, as smart photos or regular PSDs.

•  File Type: The file type drop-down menu determines what type of file will be cre-
ated. The default is PSD, which maintains layers. You can also select JPG or TIFF if 
you prefer those formats and are not concerned about maintaining layers. The last 
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option is same as source, which maintains the file type of the original file, except 
for Lightroom Raw files, which are saved as PSDs.

•  Color Space: Determines what RGB working color space is used; Adobe RGB 1998, 
sRGB or ProPhoto RGB.

•  Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.
•  Resolution: The resolution drop-down menu determines the resolution of the file.
•  Stack with Original: When enabled, the new image is stacked with the original im-

age, making it easier to organize.
•  Use Original for Single PSDs: When enabled, if you select a single PSD file, it will 

be edited directly, rather than having a copy made.

System

The System tab is where you change the performance-related characteristics of Photo RAW.

Memory Usage
•  System Usage: Specifies the amount of system memory (RAM) that is used by the 

application. The default is 80%.
•  VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the 

application. The default 80%.
•  Process 8-bit images as 16-bit: When enabled, 8-bit images are handled in a 16-bit 

space to reduce processing artifacts. This is recommended unless you have a com-
puter with low memory.

Scratch Folder Location
This setting lets you move or reset your memory cache. This is helpful if you have a small SSD 
drive as your system drive, or wish to use a faster external drive as a cache. This information 
is purged each time you quit the application.
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Browse Cache
ON1 Photo RAW stores thumbnails previews on disk so that the next time you browse a 
folder it loads much faster. This setting lets you adjust the memory cache size or amount of 
information stored, empty the cache, move it to another location, or reset it if you are having 
issues with Browse.

Services

This tab controls which online storage services are displayed in the Sources pane in Browse 
and Layers. Currently, ON1 Photo RAW 2017 supports Dropbox, Google Drive, and Microsoft 
OneDrive. Photo RAW will automatically add any of the services if finds them on your com-
puter during the installation process, but if you add (or remove) any of these services later, 
use this tab to manage them.



ON1 Photo RAW 2017 User Guide	 Part 1: Overview	 22

Photo Via

Photo Via uses your Dropbox or Google Drive account to publish photos from your computer 
to your iOS devices. (Published photos are visible via the Photo Via app, available for free in 
the iOS App Store.) To configure Photo Via on your computer, choose the service you wish to 
use—Dropbox or Google—and sign in via the button in this tab.

Further information about Photo Via is available elsewhere in this guide, and on the ON1 
website.
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Basic Commands Mac OS Windows
Cut Command X Control X

Copy Command C Control C

Paste Command V Control V

Undo Command Z Control Z

Redo Command Shift Z Control Shift Z

Print Command P Control P

Browse Folder Command B Control B

Select All Command A Control A

Select None Command D Control D

Deselect / /

Quick Export Command Shift S Control Shift S

Rotate 90° Clockwise Command ] Control ]

Rotate 90° Counter Clockwise Command [ Control [

Search Text Command F Control F

Navigate Browser Selection Arrow keys Arrow keys

Panel Commands Mac OS Windows
Show/Hide Browser (Left) Panel Command Left Arrow Control Left Arrow

Show/Hide Control (Right) Panel Command Right Arrow Control Right Arrow

Show/Hide All Panels Tab Tab

Show Navigator/Histogram/Info Command 1 Control 1

Folders Pane Command 2 Control 2

Albums Pane Command 3 Control 3

Filters Pane Command 4 Control 4

Recent Pane Command 5 Control 5

Info Pane Command 6 Control 6

Metadata Pane Command 7 Control 7

Enable Filters Command L Control L

ON1 Photo RAW 2017 Keyboard Shortcuts
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Tool & Editing Commands Mac OS Windows
Crop Tool C C

Local Adjustment Brush K K

Adjustable Gradient Shift K Shift K

Refine Brush N N

Perfect Eraser Q Q

Retouch Brush R R

Masking Brush B B

Masking Bug M M

Zoom Tool Z Z

Brush Size ] (larger)
[ (smaller)

] (larger)
[ (smaller)

Brush Feather Shift ] (softer)
Shift [ (harder)

Shift ] (softer)
Shift [ (harder)

Brush Opacity Option ] (higher)
Option [ (lower)
Option number keys 1-0 
(10% to 100%)

Option ] (higher)
Option [ (lower)
Option number keys 1-0 
(10% to 100%)

Toggle Perfect Brush Command R Control R

Toggle Tool Mode X X

Temporarily Select Hand Tool Hold Spacebar Hold Spacebar

Temporarily Toggle Tool Mode Hold Option Hold Control

Invert Mask Command I Control I

Show Mask O O

Show Mask Control M Control M

Show Clipping Option J Alt J

Temporarily Toggle Clipping View J J

Copy Settings Command Shift C Control Shift C

Paste Settings Command Shift V Control Shift V

Sync Settings Command Option S Control Option S

Reset All Settings Command Shift R Control Shift R

Rate Photos (Browse) Number keys 1-5 (1 to 5 
stars)
` (backquote key) no stars

Number keys 1-5 (1 to 5 
stars)
` (backquote key) no stars

Set Color Labels (Browse) Number keys 6-0 (red, yel-
low, green, blue, purple)

Number keys 6-0 (red, yel-
low, green, blue, purple

Set Likes (Browse) P (like)
U (clear like)
X (dislike)

P (like)
U (clear like)
X (dislike)

Delete Photo (Browse) Delete Delete
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View Commands Mac OS Windows
Toggle Preview \ \

Zoom In Command + Control +

Zoom Out Command – Control –

View Actual Pixels Command Option 0 Control Alt 0

Fit to Screen Command 0 Control 0

Full Screen Mode Command Control F F11

Detail View E E

Filmstrip View F F

Thumbnail View G G

Increase Thumbnail Size + +

Decrease Thumbnail Size - -

Preview Area Compare Command Y Control Y

Show Quick View Browser Option Up Arrow Option Up Arrow
Go From Grid to Detail (Browse) Spacebar Spacebar
Go from Fit to 100% View Spacebar Spacebar
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Part 2: ON1 Browse
ON1 Photo RAW’s Browse module is a powerful and incredibly fast photo browser and man-
ager. It gives you one place to find, view and manage your images, no matter where they are 
located.

Browse doesn’t store your photos in a database, so you don’t have to worry about cata-
loging your images in order to view and edit them. This makes Browse an ideal environment 
for performing quick sorts and edits after a shoot: You can view your images immediately 
without having to wait for a long cataloging or preview-creation process.

But Browse also has a sophisticated indexing system built in, designed to let you get ac-
cess to your favorite folders of images in a jiffy; just add a folder to the Indexed Folder pane, 
and it will index your photos in the background wherever they reside, giving you increased 
search capabilities and even faster access to your most important photos.

Browse also lets you apply any ON1 Photo RAW editing presets from the Develop and Ef-
fects modules directly to an image or group of images; you can also copy edits made on one 
photo and paste them onto a single photo or a group of photos.

Some of Browse’s key features:
•  Find your photos fast, wherever they are: local drives, network drives, or online 

storage services (Dropbox, Google Drive, Microsoft OneDrive)
•  Index most-used folders of photos to get even faster access to your most import-

ant photos across multiple sources, while still preserving your folder hierarchies 
and locations.

•  Multiple ways to view images: grid, filmstrip, and detail views
•  Apply editing presets from Develop and Effects a single image or a group of im-

ages, or sync existing edits from one image to a group.
•  Create quick albums from a selection of photos, or add simple and more-compli-

cated smart albums across your entire library 
•  Copy, move, delete and rename files
•  Sort, flag, rate or color code your images.
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The Browse Workspace
The Browse module has three main sections: the Browse/Presets panel on the left side of the screen, 
the Preview window in the center, and the Photo Info panel on the right side.
The main components of Browse module include:
A	 Short Cuts: This palette contains shortcuts to your most common photo storage locations.
B	 Preferences/Help icons: Accesses the ON1 Help menu or ON1 Photo RAW preferences.
C	 Browse/Presets Panels: Switch between the Browse panel and Presets by clicking on the tab.
D	 Folders Pane: Shows your indexed folders, local disks and cloud sources.
E	 Albums Pane: This pane allows you to create albums or collections of images.
F	 Filters Pane: This pane allows you to sort and search your images and your favorites.
G	 Recent Pane: This keeps track of recently opened files and folders.
H	 View Selector: Switches between grid, detail and filmstrip views.
I	 Thumbnail size: This slider adjusts the thumbnail size.
J	 Breadcrumbs: This shows the path of the selected image or folder in the Preview area.
K	 Preview: The window where you can view your images in thumbnail or detail view.
L	 Sort: This pop up adjusts sort order based on standard selection criteria, such as file name, date 

captured and more.
M	 Image Counter: This will display the number of files and folders you are viewing.
N	 Reset All/Sync: These buttons let you synchronize the edit settings of one image on another (or 

group). Reset All removes all edit adjustments made in Develop and Effects from the selected 
image or group of images.
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O	 Info Pane: This section will give you detailed metadata about your image when available. (Also 
displays Navigator and Histogram panes when viewing in Filmstrip mode.)

P	 Metadata Pane: This pane will show your metadata for your selected image.
Q	 EXIF/IPTC Info Panes: This will give you more detailed information about your selected file.
R	 Export/Share: Shortcuts for exporting (Resize) and sharing selected photos.
S	 Module Selector: Use this to switch to other modules inside ON1 Photo RAW 2017

Browse and Presets Panels
On the left side of the screen are two panels, Browse and Presets; clicking on the tab at the 
top of the screen will make that panel visible. You can hide the left panel completely by click-
ing on the double arrows at the bottom of the panel. 

Browse Panel
The Browse panel consists of four panes—Folders, Albums, Filters, and Recent—all of which 
perform or display file-related activities.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title bar is 
clickable).

Folders
The Folders Pane is where you look for your photos. It contains a list of all disk drives, mount-
ed drives, server shares and cloud storage services on your computer. The Folders Pane has 
three components, Indexed Folders, Local Drives, and Cloud Storage; clicking on an item in 

any of these sections will display the contents of that folder in 
the Preview area.

Indexed Folders
An indexed folder is a shortcut for your favorite or most-used 
folders of photos. A folder designated as indexed is cached in 
the background to improve the speed of loading those folders 
(and subfolders) and their photos, making it ideal for portfolios, 
your best photos, or your primary library of photos. 

Indexed folders are also necessary for the following Browse 
features:
•  For the creation of Smart Albums (see Albums, below);
•  For syncing photos to iOS devices with Photo Via;
•  When using the Filters feature to search for photos 
across multiple folders.

You can make any available folder an indexed folder by clicking 
on the ‘+’ button at the top of the Folders pane, or by dragging a folder from the Preview 
area onto the ‘Drop…’ button at the bottom of the Indexed Folders section. The indexing 
process is designed to work in the background, so it doesn’t affect other work you do in any 

The Folders pane is broken into three 
categories: indexed, Local Drives, and 
Cloud Storage
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ON1 Photo RAW module. To remove an indexed folder, right-click on the folder name in the 
pane and choose “Remove Indexed Folder.”

Local Drives
Browse automatically recognizes any disk (volume) inside or attached to your computer. This 
includes internal and external hard drives, optical drives, thumb drives, digital camera memo-
ry cards, digital cameras, any devices that support USB Mass Storage, and network-attached 
services (including mapped volumes on Windows).

Disks appear in the Folders pane under the Local Drives section with a hard drive icon 
next to them. Keep in mind that some disks, (like optical drives) are often read-only. You will 
be able to open a copy of a photo, but will be prompted to save the image to a new location.

Cloud Storage Services
Browse supports several common cloud storage services including Dropbox, Google Drive, 
Microsoft and OneDrive. All of these services keep local copies of your images on your com-
puter, and Browse finds and monitors these locations automatically. If you edit an image 
stored in one of these locations they are automatically updated to the cloud. 

During the installation process, ON1 Photo RAW automatically looks for the default instal-
lation locations for these services. If you do not have one of these services installed, or you 
have it installed to a non-standard location you will be asked to install or locate the folder 
when you click on the source. You can hide services you don’t use in the Preferences.

Navigating Sources
To view the contents of any folder in the Folders pane, click on the triangle next to the folder 
name. This will display the photos and subfolders within the selected folder inside the Pre-
view area. To view the contents of a subfolder, either click on the subfolder inside the Folders 
pane, or double-click on it in the Preview area. (You can use the breadcrumbs bar at the top 
of the Preview area to navigate back to the top of your folder system.)

Using Short Cuts
The Short Cuts selector on the left side of the Browse panel is designed to take 
you to six specific locations and display their contents in the Preview window. From 
top to bottom, the icons represent your Desktop, your Pictures folder, indexed 
folders, local drives, cloud sources, and albums.

Short cuts can be very useful when you have the Browse panel hidden to maxi-
mize viewing in the Preview window.

Managing Files and Folders in Browse
Deleting a folder
To delete a file or folder in the Preview area, simply click on it and press the Delete key or 
select ‘Delete’ from the right-click contextual menu.

Confirm that you wish to move the file to the trash. If you have multiple files and or fold-
ers selected it will move them all to the trash. If you make a mistake you can use the Undo 
command, although some files or folders, like those on a network volume, must be deleted 
immediately and cannot be undone.
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Renaming a file or folder
You can rename a file or folder by selecting it, then choose 
‘Rename’ from the right-click contextual menu.

If you select multiple files or folders you can batch rename 
them as well. You have the option to use any combination of 
the current filename, custom text and serial numbers.

Creating a New Folder
You can create a new folder from the right-click contextual menu in the preview area or 
selecting Add Subfolder in the Edit menu. This will create a new folder inside the selected 
folder.

Copying and Moving files and folders
You can copy and move files and folders in the ways you are accustomed to on your com-
puter. You can select files and folders and use the Edit > Copy command to copy them to 
the clipboard and then Edit > Paste to paste them to new location, inside or outside of 
Browse. You can use this to copy a file or folder from one place to another or to attach an 
image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. 
Dragging and dropping a file or folder will move it if it is on the same drive or copy it to 
another drive. You can drag and drop in and out of Browse module.

NOTE: Due to the non-destructive nature of ON1 Photo RAW’s workflow, copying 
a photo and pasting it outside of ON1 Photo RAW will paste the original file. If you 
have edited it in Develop or Effects and wish to incorporate those changes, use the 
Export or Quick Export commands to get a version of the photo with your edits.

Show in Finder/Show in Explorer
To view a file or folder in the Finder (Mac OS) or Explorer (Windows), right-click on an image 
or folder in the Preview area and choose Show in Finder or Show in Explorer from the pop-
up menu.

Albums
ON1 Photo RAW’s Albums feature lets you organize or keep track of photos on a project, 
event or even a broader category like a portfolio. Regular albums are created by selecting 

images manually and adding them to a new (or existing album) 
by dragging and dropping photos on the pane. 

If you want to create albums that populate automatically 
based on criteria such as date, camera type, rating or more, you 
can use the Smart Albums feature.

Creating an Album
Click the + icon in the pane and choose Create Album… from the pop-up menu. (You can 
also create an album by selecting photos and dragging them into the designated area at the 
bottom of the Albums pane.)
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Adding photos to an existing Album 
There are multiple ways to add photos:

•  Dragging and dropping a photo on the album name in the pane.
•  Selecting a photo or group of photos, right-clicking on the current photo and 

choosing Add to Album from the pop-up menu.
•  Choosing Album > Add to Album and picking the destination album from the 

menu.
•  You can also copy a photo and paste it into an album: click on a photo, choose 

Edit > Copy, then click on the album in the Albums pane, and choose Edit > 
Paste.

Creating a Smart Album
Click the + icon and choose Create Smart Album… from the pop-up menu. A dialog box will 
appear, letting you choose the criteria for your album. These include:

•  Ratings & Labels: Set the criteria for the album with like and dislike, star ratings 
and/or color labels.
•  Date Range: Choose the time period in which the other 
criteria is eligible.
•  Search: Create a custom search query based on metada-
ta.

You can edit the Smart Album later by right clicking on the 
Smart Album in the pane and choosing Edit.

NOTE: Smart Albums will only search for photos residing in 
indexed folders.

Delete an Album
To delete any album or smart album, just right-click on the album name and choose Delete.

Filters
The Filters pane allows you to find just the photos you want in your current folder or album. 
It will search for any photos that match the criteria you set. Photos must match ALL of the set 

criteria to be found. To use the Filter pane follow these steps:
•  Make sure you have the folder of images you are interest-
ed in viewing selected in the Folders pane.
•  Click the Filters check mark to turn filtering on.
•  Set your filter criteria.
You can filter your photos using the following options:
•  Liked (represented by a heart filled in), disliked (X) or not 
set (empty heart). Click on the icon to turn that setting on.

•  Star ratings from zero to five. Click on the greater than or equal symbol to the 
left of the stars to get a pop-up menu that lets you set the filter to show the ex-
act number of stars, greater than or equal to the number of stars, or less than or 
equal the number of stars.
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•  Color labels.
•  Date range: There are several preset relative date ranges or you can set your own 

defined date range by clicking on the pull-down menu.
•  Text search: You can type into the search field to find images that contain the text 

in the filename, metadata, keywords or description.
•  Search My Indexed Folders: This setting will apply the filter to all of your indexed 

folders.

Recent
The Recent Pane keeps track of recently opened files or manually browsed folders.  Files are 
listed in order of last opened. If you have not opened any files this pane will be empty. You 

can quickly access your most recent files in this pane by clicking 
on the one you want and it will appear in your main preview 
window. Keep in mind the Recent pane only shows files you 
have opened directly from within ON1 Photo RAW 2017, not 
files you have sent to ON1 Photo RAW 2017 from Lightroom, 
Photoshop, Photoshop Elements or Apple Photos.

You can clear the recent file list by pressing the trash can 
icon in the pane’s title bar.

Preview area
The Preview window is the largest part of the Browse workspace. Here, you can view folders 
of images in either thumbnail or detail view, based on the folders, albums or filters you have 
chosen via the Browse panel. There are three main views in the Preview window: 

•  Thumbnail, which displays a grid of thumbnails of your images. This view also 
displays folders, letting you go up and down a folder hierarchy quickly.

•  Detail, which you get by double-clicking on a thumbnail. You can view this image 
in either ‘fit to window’ view, or can zoom in to see more detail.

•  Filmstrip, which displays a strip of images from a folder or album at the bottom 
of the screen. The currently selected image displays in the preview area above 
the strip, and you can use the arrow keys to move through the folder, or click on 
an image in the filmstrip to view it in the preview area.

Working in Thumbnail View
The Thumbnail area is the largest part of the main window and it is responsible for displaying 
thumbnails of folders and images you have selected using the Folder Pane.	

•  Use the breadcrumbs to quickly return to the root or click “back” to return one 
folder.

•  Select your image while in thumbnail view and choose module to open.
•  Change the viewing mode between thumbnail, filmstrip and detail view.
•  Adjust the size of the thumbnails using the slider at the bottom of the screen or 

use “-/+” keys on your keyboard.
•  Sort the thumbnails by filename or date using the pull-down menu.
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•  Check on show sub-folder contents when you want to view all folders (indexed 
folders only).

•  When Previewing images at full screen you can move to the next image by using 
the arrows.	

Persistent Thumbnail Cache
When you go through a folder of photos, Browse caches thumbnails and preview images as 
well as extracted metadata. This will make it faster the second time a user browses a folder. 
It also stores user-added or adjusted metadata such as ratings, labels, keywords, captions, 
rotation and GPS data, among others.

You can adjust the size of the cache and change the storage location of the cache in the 
Performance tab in ON1 Photo RAW‘s Preferences window.

Working in Detail View
In Detail View you can see a full-screen version of your photo. By default when you go to 
Detail View, your images will be displayed in fit mode, so you can see the entire image. 
However you can click on the image to zoom in to 100% or actual pixels. This is useful for 
judging small details and sharpness. Single-clicking on a image that is magnified will return 
back to fit mode. You can click and drag a magnified image to look around. Your zoom mode 
is maintained as you move from image to image so you can compare the same spot in several 
frames.

In the Navigator pane you can reposition the preview and change the magnification 
amount.

In the footer of Detail view you can view and adjust the Like, Star Rating and Color label 
for the current image.

Working in Filmstrip View
Filmstrip view is much like Detail view, presenting a large version of your currently select-
ed image in the preview area (with all the 
viewing controls that are available in Detail 
view), and displaying other photos from the 
current folder in a strip of thumbnails at the 
bottom of the screen. The photos are sort-
ed by the current sort order, which can be 
change via the Sort pop-up above the strip.

The current image will be represented by 
a blue rectangle in the filmstrip, and you can 
use the Left and Right arrow keys to move 
from photo to photo, or you can scroll with 
your mouse and click on a photo to display 
it in the preview.

When you’re using Filmstrip view, the Navigator and Histogram panes are visible at the 
top of the Photo Panel.
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The Photo Panel
The panel on the right side of the screen contains information relative to the currently select-
ed image in the Preview area.

Info Pane
The Info Pane displays common metadata for the currently selected image in a large, easy-to-
read format. This metadata includes:

•  Camera make and model
•  Lens focal length
•  Capture date and time
•  File type
•  GPS
•  ISO
•  Shutter speed
•  Aperture
•  Exposure compensation
•  Filename
•  Color space
•  Image dimensions and resolution
•  File size

If any of the metadata fields are unavailable they will be left blank.

GPS Metadata
If your image has GPS metadata embedded in it, the GPS button will appear in the Info pane. 
Clicking on this button will open the default web browser to Google Maps and navigate to 
the location where the image was taken.

The Navigator Pane (Filmstrip View only)
This gives you a thumbnail view of your image. The white 
square region marks the image area that is visible in the pre-
view pane. You can pan your image by clicking and dragging 
inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% and 
25%). Click on one of the buttons to change the view. 

Fit zooms to fit the current canvas size, while 100 zooms to 
100%, displaying the actual pixels. 

The Histogram Pane (Filmstrip View only)
This gives you a color chart of the shadow, midtone and highlight areas based on the image 
RGB values. This is useful to show areas within the image that may be clipping. Clipping is 
when your image contains pure blacks or white and can signify loss of highlight or shadow 
detail.
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The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of each 
end is a triangle. If the triangle is lit, there is clipping on that 
side of the histogram. If you click on the arrows, you will ac-
tivate the clipping overlay on your image, which displays the 
areas that are clipped. Those areas with a blue overlay are 
pure black, while the areas with the red overlay are pure white. 
You can turn the clipping view off again by clicking on one of 

the triangles. You can also temporarily enable clipping view by holding down the J key at any 
time. The clipping view is useful when you are making adjusts to the brightness and contrast 
of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the 
pane.

Metadata Pane
The Metadata pane provides more complete metadata about 
your photo, and lets you add your own metadata elements, 
such as copyright and contact information, keywords and photo 
descriptions. You can also view the complete EXIF data embed-
ded in a photo by your camera, and add (or modify) comments 
and GPS coordinates to an image or group of images. ON1 
Photo RAW also supports the industry-standard IPTC metadata 
standard, which offers much more detailed metadata infor-
mation and is used by journalists and stock photographers to 
catalog and tag photos. 

To go back and forth between the EXIF and IPTC fields in 
the Metadata pane, just click on the label in the pane. You can 
change the metadata in multiple images at the same time by 
selecting them all, then changing one or multiple fields in the 
pane.

Embedding Metadata
Metadata you add in Browse is stored in industry-standard XMP 

sidecar files for Raw files. This facilitates the transfer of metadata to any application that sup-
ports XMP. When you edit an image, create a copy of an image for editing or use the ‘Send 
to’ command, the metadata is embedded into the file automatically (with the exception of 
camera RAW files). You can manually embed your metadata into images using the embed 
metadata command from the Photos menu. This will open each image you have selected, up-
date the metadata and re-save it. This is supported for TIF, PSD, PSB and JPG files. Camera 
Raw and PNG files do not support direct embedding of metadata.
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Editing photos in Browse
While most of ON1 Photo RAW 2017’s image-editing power is found within the Develop and 
Effects modules, you can perform many editing tasks on photos inside Browse. This includes 
changing metadata, labels and ratings, but you can also apply presets to an image or group 
of images, and can even copy Develop/Effects settings from one photo and paste them onto 
other photos directly within Browse.

Ratings, Labels and Likes
Using a standard rating and label system, it is fast to sort and cull your favorites from the 
throw-away shots. Browse offers three ways, aside from keywords and subfolders, to mark 
and group similar images. All of these methods may be set several ways: from the Photo 
menu, the right-click contextual menu, clicking the badges on the image thumbnail or in the 
footer of Image view. There are also keyboard shortcuts associated with each classification 
option.

•  Star ratings: Set from zero to five stars. Photographers often use five stars for 
their favorite images and one star for images they don’t want to keep, but you 
can use this system in whatever way works best for you. You can adjust the rating 
using the 1 through 5 keys on the keyboard. You can 
also clear the stars on any image with the ` (backquote 
or grave) key.

•  Color labels: There are five color labels as well. Color 
labels are a great way to mark sub-sets of images for 
special handling. You can set the color ratings by press-
ing the following keys: 6 (red), 7 (yellow), 8 (blue), 9 
(green), 0 (purple).

•  Likes: The most common need for photographers is to 
mark their favorite images and the ones they want to 
delete. This is best accomplished with the Like classifi-
cation. There are three options, Like (icon with a filled-
in heart), Dislike (‘X’ icon) and Not Set (empty heart). By default, images are in 
the Not Set category until you change them. You can set your Liked images with 
the P keyboard shortcut, your Dislikes with the X key and clear the settings with 
the U key.

Both star ratings and color labels are industry standards. When you use these tools, the 
settings are stored in the metadata and will be available in other photo editors and manag-
ers, like Lightroom. Likes are proprietary and will only appear in ON1 Photo RAW.

Applying Presets
ON1 Photo RAW has a preset system that lets you save your complete editing settings from 
the Develop and Effects modules. These presets are available in Browse, so you can apply 
your favorite presets quickly and easily to a photo or a group of photos. 

To apply a preset to an image, click on the Presets panel. There you will see any built-in 
presets supplied by ON1, as well as any presets you might have created or installed yourself. 

An example of a photo in Thumbnail 
view with a ratings, color and favorite 
attached.
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The panel is divided into categories, like Architecture, Landscape, Portraits, and more. Click-
ing on a category name will open it and display any presets within that category, each with a 
tiny thumbnail showing your selected image with that preset applied to it. 

If you’d like to see a larger representation of what your selected photo will look like, click 
on the Quick View Browser icon in the preset category’s title bar. That will display an overlay 
over the entire Photo RAW interface with all of the presets in that category.

To apply a preset to a photo, simply click on the preset in either the Category preset 
browser or in Quick View Browser mode. Presets applied in Browse are not cumulative; after 
you’ve applied one preset, clicking on another preset will remove the previous one and apply 
the new one. (If you have applied edits in either Develop or Effects, those modules’ settings 
will be erased if the preset has settings in those modules.)

Because ON1 Photo RAW is non-destructive, going to either the Develop or Effects 
modules will display all of the settings applied by the preset. Once in those modules, you can 
adjust the settings, switch to another preset, or make any other editing changes.

To remove a preset from a photo, click on the photo and choose Reset All Settings from 
the Settings menu. You can also remove individual settings made in either the Develop or 
Effects modules, if you prefer.

(To find out more about how to create and edit presets, see Page 60.)

Copying settings and synchronizing edits
In addition to applying presets, you can copy all of the existing edits to a photo and paste 
them onto other images directly in the Browse module. This includes most things you can 
apply in Develop or Effects, with the exception of retouching, brush masks, and cropping.

To copy the edit settings for an image, click on the 
edited file and choose Settings > Copy Settings. To apply 
that setting to another image, click on the new image and 
choose Settings > Paste Settings. A window will appear, giv-
ing you the option of applying all of the edits on the original 
photo, or you can select which module’s edits—with gradi-
ent masks or gradient tools, if used—you wish to paste into 
the new photo. (You can also select a group of photos and 
paste the edit settings onto the group.)

The flexibility of the Paste Settings is useful, especial-
ly if you wish to selectively apply settings to an image or 
group of images. However, if you want quickly to apply all 
of an image’s edits—with applied gradient masks or tools 
as well—you can use the Sync command to synchronize the 

settings from a source image to another image or group of images.
To do this, select the edited image that you want to use as your source. Then, holding 

down the Shift key (if you are selecting an image or group that is contiguous with the source) 
or the Command (Mac) or Control (Windows) key and click on the image(s) that you wish to 
apply the source file’s edits. Your selection should have the source image highlighted in blue, 
and the target images highlighted in gray. If that is correct, simply click on the Sync button at 
the bottom right of the Preview area, or choose Sync Settings from the Settings menu.

The Copy and Paste Settings options let you 
copy most Develop and Effects adjustments 
from one photo and apply them to another 
photo (or group) inside Browse, without 
requiring presets, or even having to go to the 
editing modules.
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Resetting edits in Browse
Any edits you have made with ON1 Photo RAW 2017 can be completely reset from within 
the Browse module. This includes photos you might have pasted or synchronized settings 
onto inside Browse, or edits made within the Develop and Effects modules. 

The Settings menu offers four options for erasing edits made to a photo:
•  Reset All Settings: This removes all the applied settings you made to a photo in 

the Develop/Effects modules. (This is the only setting that removes local adjust-
ments made to a photo.)

•  Reset Develop Settings: Removes only the settings applied in the Develop mod-
ule.

•  Reset Effects Settings: Removes only the settings applied in the Effects module.
•  Reset All Retouching Tools: Resets any retouching applied in either the Develop 

or Effects modules.
You can undo any of these changes immediately after making them; otherwise resetting 

with the appropriate option will permanently reset the image.

Send to
ON1 Browse lets you send images you are viewing to other applications for editing. This is 
done via the Send to option, which is available from the right-click contextual menu or the 
Edit menu. ON1 Browse automatically detects the 
following common photo managers or editors and 
lists the latest installed version:

•  Adobe Photoshop
•  Adobe Photoshop Lightroom
•  Adobe Photoshop Elements
•  Apple Photos

You can set up any application you want to send 
your photos to. Simply select the Send to Other 
Application option. Then select the application you 
want to send your photos to. The application will 
be remembered and listed with your other Send to 
options. (For example, if you use an email client you can add it to easily email photos.)

When you send an image to another application, you will be presented with the Edit in 
dialog box from ON1 Photo RAW. There you’ll have the option to send either the edited 
photo or the original, unedited image. If you choose to send a copy, you’ll have options for 
choosing the file type, color space, bit depth and resolution. If you use the same set of op-
tions every time, you can check the “Don’t ask me again” box in the window, and you won’t 
be prompted again. (To change this setting, go to the File pane in Photo RAW’s Preferences.) 

Photo Via
If you use either the Dropbox or Google Drive cloud service, you can sync your photos be-
tween ON1 Photo RAW 2017 and your iOS device with our companion app Photo Via. You 
can organize a portfolio of your images for viewing on your iPhone or iPad, and can rate your 
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images and have the ratings reapplied to the library on your computer.
To get started, click Configure Photo Via from the Photo Via menu bar in Browse. If you 

already use Dropbox or Google Drive, choose the appropriate service, sign in, and give your 
computer a name. (If you do not have an existing account, Dropbox and Google offer free 
storage plans with 2GB and 15GB of data, respectively.)

To Publish Photos to Photo Via
On your Mac or Windows computer:

•  Create an album or smart album
•  Right-click on the album name in the Album pane and choose Publish to Photo 

Via.
You can also right-click on any indexed folder and choose Publish to Photo Via.

Getting Photo Via on your iOS Device
On your iOS device:

•  Open the App Store on your iOS device
•  Search “Photo Via”
•  Install
•  Sign in using the same credentials you supplied with the Desktop configuration.
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Browse menus

ON1 Photo RAW (Mac OS Only)
About ON1 Photo: Opens the about box, displays your version 
number. (This is in the Help menu on Windows)
Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)
Quit ON1 Photo RAW: Quits ON1 Photo RAW.

File Menu
Browse Folder: Opens the browse dialog where you can select 
which folder you would like to browse.
Browse Home: Navigates to your home Pictures folder.
Browse Desktop: Navigates to your desktop.
Add Indexed Folder: Lets you choose a folder to add to the 
Indexed Folders section of the Folders pane.
Remove Indexed Folder: Removes the selected folder from the 
Indexed Folders pane.
Manage Extras: Opens the Extras Manager where you can 
import and manage extras like Borders, Backgrounds, Textures 
and Presets.
Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.
Edit in (list): Launches the selected module with the currently 
selected image.
Send to (list): Sends your image to the selected application in 
the list.
Export: Opens the export side panel.
Print: Opens up the print dialog box.

Edit Menu
Undo: Removes the last file operation.
Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.
Select All: Selects all the images in the current folder.
Select None: Deselects all the images in the current folder.
Deselect: Deselects the current item.
Copy: Copies the currently selected items.
Paste: Pastes the items in the clipboard to the current location.
Rename: Renames the selected file or folder.
Delete: Moves the selected files and/or folders to the trash.
Add Subfolder: Adds a new empty subfolder inside the current 
selected folder.
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View Menu
Smaller Thumbnails: Decreases the size of thumbnails.
Bigger Thumbnails: Increases the size of the thumbnails.
Square Thumbnails: Changes your thumbs to square.
Always Show Filename: Keeps the file name on at all times.
Enable Filters: Enables/Disables filter pane.
Search Text: Places the cursor in the Filters search box.
Filter by Label: Filters images by color.
Filter by Rating: Filters images by star rating.
Filter by Likes: Filters images by likes/dislikes.
Reset Filters: Resets your filters.
Sort: Sort by filename or date.
View Mode: Select from thumbnail or detail view.
Preview Background Color: Change the preview background 
color.
Preset Browser Mode: Sets the Preset panel browser view to 1, 
2 or 3 columns.

Album Menu
Create Album: Creates a new Album.
Create Smart Album: Creates a new Smart Album.
Rename Album: Renames selected Album.
Delete Album: Deletes selected Album.
Add to Album: Add selected photos to available Albums.
Remove from album: Removes selected photo(s) from Album.

Photo Menu
Color: Sets the color rating of a photo (None, Red, Yellow, 
Green, Red, Purple)
Rating: Sets star rating (0 to 5 stars)
Like: Sets a photo to Like, Reject or Not Set
Auto Advance: When checked, any color, rating or like setting 
applied to a photo will save it for that photo, then move on to 
the following photo.
Rotate 90 Degrees CW: Rotates an image clockwise by 90°
Rotate 90 Degrees CCW: Rotates an image counterclockwise 
by 90°
Embed Metadata: Stores adjusted metadata to a selected file. 
(Only applicable to certain file formats.)
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Settings Menu
Reset All Settings: Resets all the applied settings on a photo.
Reset Develop Settings: Resets only the settings applied in the 
Develop module.
Reset Effects Settings: Resets only the settings applied in the 
Effects module.
Reset All Retouching Tools: Resets any retouching applied in 
the Develop or Effects modules.
Copy Settings: Copies all of the settings (Develop, Effects, 
retouching) applied to a photo.
Paste Settings: Pastes the copied settings (with options)
Save Settings as Preset: Saves the editing settings of the se-
lected photo as a preset.
Update Preset with Current Settings: If an image with a preset 
has had some settings changed, this lets you update the preset 
with the new settings.
Rename Preset: Renames a preset.
Delete Preset: Deletes a preset.
Export Preset: Exports a preset as an ON1 preset file.
Import Preset: Imports ON1 preset files.
Get More Presets: Goes to ON1.com’s Photo Presets page.

Photo Via
Configure Photo Via: Sets up Photo Via sharing services in the 
Preferences window.
Pause Publishing: Lets you pause the publishing of photos to 
Photo Via service.

Window Menu
Minimize: Minimizes ON1 Photo RAW 2017.
Zoom: Zooms your window. 
Full Screen Mode: Enters or exits full-screen mode.
Folders: Opens and closes the folders pane.
Albums: Opens and closes the album pane.
Filters: Opens and closes the filters pane.
Recent: Opens and closes the recent pane.
Info: Open and closes the info pane.
Metadata: Open and closes the metadata pane.
Show Browse Panel: Hides or reveals the left Browse Panel.
Show Photo Panel:  Hides or reveals the right Photo Panel.
Hide Panels: Hides or reveals both the left and the right panels.
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Help
Search: Searches the menu options (Mac OS only).
ON1 Photo RAW 2017 Online Help: Opens ON1.com support 
page in your default web browser.
Video Tutorials: Opens ON1.com product training page in your 
default web browser.
Welcome to ON1 Photo RAW 2017: Displays the Welcome 
window.
Check for Updates: Checks with the ON1 update server to see 
if you are running the current version. If there is a newer ver-
sion, you will be notified and be walked through the update 
process.
Sign-In: Uses your ON1 account login information to authenti-
cate your copy of ON1 Photo RAW 2017. (Sign-out will remove 
an existing authentication.)
Provide Feedback: Opens the default web browser and navi-
gates to the feedback page of the ON1 website.
About ON1 Develop (Windows Only): Opens the about box 
with the version number and license code displayed.
Help Improve ON1 Products: Opens the Improve ON1 Prod-
ucts dialog.
Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Photo RAW 2017.
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Part 3: ON1 Develop
The core of ON1 Photo RAW 2017’s photo-editing power is found in the twin modules of De-
velop and Effects. These modules share many common filters and tools, and were designed 
to let you work seamlessly on all of your pixel-editing tasks, from making basic tonal changes 
to your photos, to more complicated effects-based adjustments with masks and selections. 

Develop is the module for performing basic global editing operations—adjusting tone 
and color, removing noise, sharpening and more. It is the perfect place to begin editing your 
photos, especially if you are using ON1 Photo RAW as a standalone editor.

Effects (discussed in Part 4) has some of the same adjustment types as Develop, but it has 
more filters, sophisticated masking tools for applying effects to specific areas of your images, 
and a full range of blend modes to adjust your photos exactly as you like. 

Develop and Effects also share a Local Adjustment panel that lets you apply basic edits to 
parts of your photos, with either a gradient mask or a local adjustment brush. These adjust-
ments include settings like exposure, highlights and shadows, contrast, detail, and more.

Switching between Develop and Effects is as simple as clicking on the appropriate module 
in the Module Selector. While you work on an image, all of your settings in each module are 
saved while you edit. If you use Photo RAW as your Raw editor of choice (in conjunction with 
Browse) all edits you make to an image are preserved non-destructively, and you can go back 
to any image at any time and make changes or corrections to it.

NOTE: If you use an external editor such as Lightroom or Adobe Photoshop as 
your primary Raw editor, you can use Smart Photos or Smart Objects (in Photoshop) 
to preserve edits made in ON1 Photo RAW. See Pages 10-12 of this guide for a 
description of the editing process with these apps.

To help you save time and help you create the looks that you love best, ON1 Photo RAW 
also includes a robust preset system that lets you save settings made in either or both of the 
editing modules—along with local adjustments and masks—for applying to other photos. 
Editing presets can be applied in Develop or Effects, as well as in Browse, and, like all other 
elements of Photo RAW, are re-editable.

In addition to creating and using presets, you can copy and paste the Develop and Ef-
fects settings from one file to another, or alternatively, synchronize the edits on one photo to 
a group of photos. These operations can all be performed in any of the editing modules, as 
well as in Browse, adding to ON1 Photo RAW’s extreme flexibility.
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The Develop Main Screen Overview
ON1 Develop provides you with an easy-to-use work space for editing your photos. Below is 
an overview of the main sections.
The main window sections of ON1 Develop:
A.	 Tool well: tools for working within Develop
B.	 Preferences/Help: Shortcuts to app preferences and help.
C.	 Preset panel: List of all installed presets (by category) for use in Develop and Effects
D.	 Search: Searches presets (by name).
E.	 Preview Window options: Detail view, Filmstrip view, magnification slider for current image.
F.	 Tool Options bar: Options and settings for currently selected tool.
G.	 Preview Window: displays the current photo in detail view.
H.	 Preview option toggles: compare (before/after) mode, show/hide mask, turn preview on or off.
I.	 Photo Information pane: navigator, histogram and general photo information
J.	 Settings/Local Adjustments panes: clicking tab switches between local and global adjustment 

panes.
K.	 Overall Settings pane: Where your tone, color and associated Develop settings reside.
L.	 Reset bar: Reset all (Develop and Effects settings), Reset (Develop-only settings), sync settings 

with previously edited photo (only in Filmstrip view)
M.	 Module selector: Switches between modules (if you are editing a photo as a plug-in, some mod-

ules might be disabled).
N.	 Export/Share: Shortcuts for exporting and sharing selected photos.
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Tools
There are six tools available to you when you’re working in ON1 Develop:

Crop Tool: Trim the and resize the image to your desired size.

Adjustment Brush: Paints in or out local adjustments.

Adjustable Gradient: Applies a selective gradient in local adjustment mode.

Perfect Eraser: Removes distractions like signs and power lines.

Retouch Brush: Removes blemishes like dust spots and acne.

Zoom Tool: Adjusts the magnification of the image in the Preview area.

To access a tool, simply click on the tool. When selected, the cursor will change, and 
you will see a set of options for the tool in the Tool Options bar above the Preview 
window.

Navigating the Preview Window
ON1 Photo RAW provides several ways to navigate and view your image in the Preview win-
dow:

•  By default, your image is presented in Fit view, which displays your entire image 
within the preview area, and the Zoom tool is selected. Clicking on the image 
with the Zoom tool will zoom in to 100%, and the cursor will change to the Hand 
tool. You can move around your image by clicking and dragging in the preview 
area. Clicking once will take you back to Fit view. 

•  You can also zoom in and out via the View menu and the Navigator pane. The 
Navigator pane displays a bounding box around the area currently on-screen, 
and you can reposition what is displayed in the preview area by clicking and drag-
ging the box around the pane. Clicking on one of the buttons at the bottom of 
the Navigator pane will automatically zoom to Fit, 100%, 50% or 25% views. (The 
buttons are also viewable in the tool options bar when the Zoom tool is selected.)

•  When the preview zoom is larger than the viewable area, holding down the 
spacebar will display the Hand tool if any editing tool is selected. Clicking and 
dragging while holding the spacebar will reposition your image at the current 
view level.
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Navigator, Histogram and Info panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, 
and Info panes. It contains three useful tools for inspecting and viewing details of your image.

The Navigator Pane
This gives you a thumbnail view of your image. The white 
square region marks the image area that is visible in the preview 
pane. You can pan your image by clicking and dragging inside 
the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% and 
25%). Click on one of the buttons to change the view. 

Fit zooms to fit the current canvas size, while 100 zooms to 
100%, displaying the actual pixels. 

The Histogram Pane
This gives you a color chart of the shadow, midtone and high-
light areas based on the image RGB values. This is useful to 
show areas within the image that may be clipping. Clipping is 
when your image contains pure blacks or white and can signify 
loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is a 
triangle. If the triangle is lit, there is clipping on that side of the 

histogram. If you click on the arrows, you will activate the clipping overlay on your image, 
which displays the areas that are clipped. Those areas with a blue overlay are pure black, 
while the areas with the red overlay are pure white. You can turn the clipping view off again 
by clicking on one of the triangles. You can also temporarily enable clipping view by holding 
down the J key at any time. The clipping view is useful when you are making adjusts to the 
brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the 
pane.

Info Pane
The Info Pane displays common metadata for the currently 
selected image in a large, easy-to-read format. This metadata 
includes camera make and model; lens focal length; capture 
date and time; file type; GPS location data; ISO setting; shutter 
speed; aperture; and exposure compensation. 

The Info pane also displays file-specific date, including 
name, color space, image dimensions and resolution.

If any of the metadata fields are unavailable they will be left 
blank.
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Develop Adjustment Panes
To edit your images, the Develop module has 11 adjustment panes found in the Overall Set-
tings panel. Unlike the Effects module, which lets you stack filters in any order, the Develop 
module’s adjustments are applied in the following order:

•  Tone & Color
•  Curves
•  Color Adjustment
•  Black & White
•  Split Tone
•  Skin Retouching
•  Glow
•  Sharpening
•  Noise Reduction
•  Transform
•  Vignette

Working with panes
By default, the Tone & Color pane resides at the top of the stack, and is not removable; the 
remaining 10 panes can be applied (or not) depending upon what you need to do with your 
photo. To use a pane, simply click on the Show More button above the Tone & Color pane, 
and click the adjustment you would like to add to the stack. Clicking on the checkmark will 
turn that pane on or off, which can be helpful if you want to see the effect in the context 
of other edits you have made. If you don’t like the effect, click on the trash can icon in the 
pane’s title bar to get rid of it. The Reset button at the bottom of each pane will reset that 
pane’s settings to their default.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title bar is 
clickable).  
  If you don’t want to have to scroll up and down the Settings panel when you have 
a lot of open panes, go to the Window menu and choose Solo Mode. This will leave 
only the current pane open, and will hide all the other panes. Clicking on another 
pane will open that one and collapse the previous one.

Styles
Most of the panes in Develop have a set of built-in styles in the 
top part of the pane. Styles are like preset adjustments for a 
pane: they provide a group of settings to help you get started 
in the pane, or to apply a specific effect. 

You use a style by clicking on the style’s icon in the pane, and then can adjust the sliders 
as desired to get the right effect for your photo. 

You can save your own settings as a style. Simply click on the More icon on the far right 
side of the styles list for that pane, then choose Save New Style from the pop-up. Name your 

Styles for the Split Tone pane
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style, and it will then be added to the top of the More menu. To apply 
a saved style, choose the style from the More pop-up menu. To adjust 
the settings for a saved style, apply it, make any changes you would 
like to the sliders or other options, then click on the More pop-up and 
choose Update Style with Current Settings from the menu.

Tone & Color
This pane adjusts the tonal and color characteristics of an image, letting you correct and en-
hance exposure, contrast, detail and color. It is split into two sections, Tone and Color.

Tone
The Tone sliders control the global tonality, or bright-
ness and contrast of the image. You can adjust each of 
the following:

Auto Button: The auto button adjusts all of the primary 
tone settings to balance the histogram.
Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your im-
age.
Contrast: Increase or decrease the contrast in your 
image.
Highlights: Darkens the highlights, recovering detail.
Shadows:  Lightens the shadows, revealing details.
Whites: Adjusts the white point, adding or removing 
contrast in the highlights.
Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.
Structure: Adjusts the detail in your image by changing 
the local contrast.
Haze: When moved to the left, this will remove haze 
or fog from your photos; adjusting it to the right will 
enhance fog or haze.

Color
The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a col-
or cast and enhance the color of the image. The settings in this section of the Tone & Color 
pane include:

Auto Button: The auto button attempts to detect and remove a color cast. It makes adjust-
ments to the Temperature and Tint sliders.

The More styles pop-up, with saved user style (top).
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Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray. 
White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Cus-
tom). The default is As Shot, which is the color temperature that the camera recorded when 
you took the photo.
Temperature:  This slider shifts the color either cooler (blue) or warmer (yellow).
Tint:  Shifts the color either green or magenta.
Saturation: Increases or decreases the saturation of your image.
Vibrance:  Increases or decreases the color of muted tones, leaving more saturated colors 
alone.
Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are re-
duced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.
Purity – Highlights: Reduces the saturation in the highlights.
Purity – Shadows: Reduces the saturation in the shadows.

Curves
The Curves pane is a powerful, advanced tool for adjusting 
contrast and color in your image. The buttons at the top of the 
pane let you adjust the composite RGB channel, or you can ad-
just the individual Red, Green or Blue channels independently. 

In the main part of the pane, the left side of the X-axis 
represents the dark tones in your image, while the right side 
represents the light tones. By clicking on the line at the center 
of the pane and dragging it up or down, you adjust those spe-
cific tones making them lighter or darker. (It is often helpful to 
keep an eye on the Histogram when making adjustments with 
Curves.)

Color Adjustment
This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). 

In the pane underneath are color swatches for eight colors: 
red, orange, yellow, green, aqua, blue, purple and magenta. 
Clicking on one of the colors will let you adjust the hue, satura-
tion and brightness of the selected color range. Other settings 
in the pane include:
Range: This slider lets you narrow or widen the range of the 
selected color. 

Hue: Changes the hue for the selected color range.
Saturation: Adjusts the saturation of the selected color range.
Brightness: Adjusts the brightness of the selected color range.
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You can also use the pane’s Targeted Dropper tool to click on a section of your photo and 
adjust the hue, saturation or brightness dynamically. To do this, click on the tool and choose 
which parameter you would like to adjust. Then click in your image on a color you would like 
to adjust and drag the cursor to the left or right to decrease or increase the effect.

Black & White
This pane is used to turn a color image into a monochromatic 
image. The styles at the top of the pane represent different 
filter types often applied to an image, while the Auto button 
selects optimal mix of the Color Response sliders. 

To manipulate the tones manually, move the color range slid-
ers to the right (increasing brightness) or the left (decreasing). 

To change the tones directly inside a photo, choose the Col-
or Response tool in the pane. It works like the Targeted Drop-
per in the Color Adjustment pane: click on it to select the tool, 
then click and drag in the image to increase or decrease the 
brightness of the selected color range. 

To add film grain to your photo, choose from the drop-down 
list of popular black and white films. The Amount slider controls 
the strength of the effect, while the Size slider adjusts the scale 
of the grain.

NOTE: The Black & White filter in ON1 Effects has more options for toning, tuning 
and creating a monochrome image, as well as the full masking capabilities of the 
Effects module.

Split Tone
This filter applies a duotone-style effect by using a gradient 
map that tints the dark and light portions of the image in dif-
ferent hues. This can be used to age an image and give it an 
antique or vintage look, as well as for cinematic, color-grading 
looks. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders 
to choose a map for the highlight and shadow colors. 

To use the pane, you can use the Hue slider in each of the 
sections to choose the colors you want for highlights and shad-
ows. The Amount slider controls the strength of the color, and 
Balance sets the balance between the shadow and highlight 

colors, letting you make one of the colors more dominant.
The Mode pop-up sets the blending mode for the split tone. The options you can choose 

from are Normal (no blending), Color, Lighten, Darken, Multiply or Screen.
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Skin Retouching
The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you 
to choose from, depending upon your image. Other settings 
include:

Blemishes: Adjusts the strength of acne, pores and fine lines.
Smoothing: Adjusts the strength of smoothing similar to make-
up foundation.

Shine: Reduces the amount of the skin shine.
Evenness: Adjusts how consistent the skin color is across the entire face. It is great for cor-
recting highlights that may be too yellow, shadows that may be too green or reducing red-
ness in noses and ears. 
Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.
Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.
Range: Adjusts the precision of the color selected.

Glow
This pane adds a soft-focus glow to the image. The styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

Amount: Controls the overall glow strength.
Halo: Sets the radius of the glow effect, creating a fuzziness to 
your image’s edges.

Mode: Lets you set the blending mode for the glow effect.

Sharpening
This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Photo RAW offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which 
one you use depends upon the image or your personal pref-
erences. The styles section and the More pop-up have a wide 
range of sharpening styles—using all three methods—to help 
you get started.

Type: Chooses the sharpening method. Each sharpening meth-
od has its own set of sliders.
Amount (all types): Controls the overall strength of the sharpen-
ing for each sharpening type.

Sharpening pane, High Pass option.
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Halo (Unsharp Mask, High Pass): Sets the radius of the sharp-
ening effect. Smaller amounts keep fine detail, while larger 
amounts can exaggerate edge detail.
Threshold  (Unsharp Mask, Progressive): Controls the sharp-
ening effect based on contrast in your photo. Larger settings 
means that smoother areas do not get sharpened. 
Detail (Progressive): Controls sharpening in small details.

The Protect section protects highlight, and shadow areas and 
skin tones from having  sharpening applied.

Noise Reduction
Use this pane to reduce luminance and color noise, while main-
taining image detail. The styles section includes a number of 
different noise reduction options, based on the type of image 
you’re working on.

Luminance: Adjusts the overall strength of the noise reduction 
applied to the luminance or detail of the image. Hold down the 
Alt/Option key to see just the luminance while adjusting this 
slider.
Color: Controls the amount of noise reduction applied just to 

the color or chroma of the image.
Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.
Apply to: Allows you to limit the noise reduction to just a portion of the image based on col-
or or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range or fuzziness of the 
color range to apply the noise reduction to.

Sharpening pane, Progressive option.

Sharpening pane, Unsharp Mask option.
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Transform
Transform applies distortion and perspective correction to your 
image, and offers rotation (separate from the Crop tool) and 
scaling options as well. You can use these settings to make small 
adjustments to perspective or distortion.

Curve: Adds or removes pincushion or barrel distortion, com-
mon with wide-angle lenses.

Vertical: Adjusts the vertical perspective.
Horizontal: Adjusts the horizontal perspective.
Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.
Scale: Scales your image up from the center, to 100%.

Vignette
The Vignette pane creates flexible vignettes which focus a view-
er’s eye toward the center of the image by darkening the edges 
of the frame. The buttons at the top of the pane let you quickly 
apply a vignette and then customize the look with the advanced 
controls. Styles apply common vignette types.

Brightness: Controls how light or dark the vignette is.
Size: Controls the size of the vignette.
Feather: Controls the hardness of the edge of the vignette.

Roundness: Controls the shape of the vignette from square to round.
Type: This drop-down menu lets you select a normal, subtle or soft vignette effect.
The Center Tool at the bottom of the pane lets you to select the center point of the vignette.  
Click on the tool icon to activate and then click on the area in the image you wish to make 
the center of your vignette.
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Develop tools

Crop Tool
This tool lets you crop your image, and is 
fully non-destructive inside Develop and 
Effects when you are using Photo RAW as 
a standalone app. 

NOTE: The Crop tool is disabled when 
you use Photo RAW as a plug-in; you 
should use the host app to crop your 
photos. When used inside Layers or 
Resize, the Crop tool is destructive.

To crop an image, select the Crop 
tool from the tool well. If desired, select 
any preset crop ratio you would like to 
use from the Options bar; the default is 
Freeform, which lets you crop in whatever 
size or ratio you would like. Adjust the corner handles of the crop tool overlay to get the area 
you wish. (The area outside the crop box appears darkened for guidance.) You can resize and 
move the image inside the crop box. When you are satisfied with your settings, press the 
Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also 
nudge the image using the arrow keys on your keyboard.

To resize the crop box, click and drag on any of the handles. Clicking on a corner handle 
allows you to adjust two sides at the same time; clicking on a side handle allows you to adjust 
that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options 
bar when the Crop Tool is active. Click on it, and drag the tool across an element in your 
image that should be level.

Crop Tool Options bar:
Preset pop-up: Lets you choose from Freeform or constrained preset ratios
Width: Sets the width of the crop box.
Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
Height: Sets the height of the crop box.
Leveling Tool: Click and drag this tool across an element in your image that should be level.
Angle: See and adjust the angle of rotation.
Reset: Resets the crop area to the size of your original photo.
Apply: Applies the crop.

The Crop interface, with the Crop Preset pop-up open.
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Adjustment Brush / Adjustable Gradient tools
For information on the Adjustment Brush and Adjustable Gradient tools, see the Local Ad-
justments section on Page 57.

Perfect Eraser
The Perfect Eraser can be used to remove distracting elements and blemishes from your 
image. It uses a content-aware algorithm that replaces the pixels with a natural-looking result 
within the boundaries that are painted.

Using the tool is easy: click on it in the tool well, and paint over the area you wish to 
remove. Make sure you cover the entire area. A red overlay appears where you paint. If the 
first attempt does not give you a perfect result, simply paint over it again and it will improve 
with each pass. You can also fine tune the area after applying the Perfect Eraser by using the 
Retouch Brush (see below).

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or 
smaller by clicking on the Brush Size in the Tool Options bar, or by pressing the right or left 
bracket keys on your keyboard. The maximum brush size is 500 pixels.

If you have a Wacom pressure-sensitive tablet, select the Pressure Adjusts Size button in 
the Tool Options bar.

Retouch Brush
Use the Retouch Brush to remove small imperfections like dust or blemishes.

Just dab the brush on areas that contain spots or other imperfections, such as acne, sen-
sor dust, power lines and more. The tool looks at the neighboring areas in your image and 
fills in the brushed area with an area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than mak-
ing large brush strokes. If you dab with the Retouch Brush and don’t like the results, use the 
Undo command and try using a smaller brush or vary your brush stroke and try again. The 
Retouch Brush is also great for retouching skin.

Retouch Brush Options bar:
Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.
Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.
Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click on the button to activate the Wacom sensitivity 
controls.

Zoom Tool
This tool, which is the default tool selected when you open an image in Develop, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the 



ON1 Photo RAW 2017 User Guide	 Part 3: ON1 Develop	 57

Preview window to zoom in and center the image at the location clicked.
You can also double-click the Zoom tool in the tool well to set the image to 1:1 (or 100%) 

magnification view, which shows every pixel. This is best when examining small details.

Local Adjustments
In addition to the primary adjustment panes, you can make local adjustments to portions of 
an image in ON1 Photo RAW 2017. You can apply these adjustments using either the Adjust-
ment Brush or the Adjustable Gradient, and you can create as many local adjustments as you 
need on an image. Local adjustments can be used to apply a gradient filter to darken a sky, 
for example, or to add a more complicated vignette to an image.

Operations you can perform with local adjustments include tone (exposure, contrast, high-
lights and shadows, detail) and color (white balance, saturation and vibrance). Each adjust-
ment pane can have completely different settings and work on different parts of your image.

Local adjustments are shared between the Develop and Effects modules; you can create a 
local adjustment while working in Develop, switch to Effects, and when you click on the Local 
Adjustments panel, your settings will be intact.

Adjustment pane
Local adjustments are controlled from the Adjustment pane. To create one, click on the Local 
Adjustments tab and choose Add Layer. This creates a new Adjustment pane. This pane in-
cludes the following options:

Opacity: Sets the opacity of the adjustment. Since local 
adjustments are at the top of the image stack, this lets you 
tune an adjustment after you’ve applied other edits to a pho-
to. (See Page 9 for more.)

Styles: The pane has a number of canned styles for you to 
start with, including ones for lightening or darkening, adding 
vibrance, fixing teeth or red eye, and many more. (You can 
also save your own styles via the More pop-up menu.) 

The main section of the Adjustment pane has a subset of 
options found in the Tone & Color pane in the Overall Set-
tings panel: Exposure, Contrast, Highlights, Shadows, Detail, 
and Color Temperature, Tint, Saturation and Vibrance. These 
controls work the same way inside the Local Adjustments pan-
el. One difference is that, since a local adjustment is actually a 
layer that sits on top of your global adjustments, ON1 Photo 
RAW provides you with a number of blending options for each 
adjustment. Blending modes determine how the selected lay-
er blend with the items below it in the image stack.

Click on the Blending Options gear icon at the top of the 
Adjustment pane to drop down the Blending Options. The blending option controls are:
Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

Adjustment panes let you adjust basic 
tone and color settings on the parts of the 
image you choose. You can also set the 
opacity of the adjustment, as well as apply 
advanced blending options (accessed via 
the gear menu).



ON1 Photo RAW 2017 User Guide	 Part 3: ON1 Develop	 58

Apply To: This lets you apply the blending mode to a specific 
color or tonal range. The options are; All (the default), High-
lights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the Dropper 
Tool in the pane and clicking on a color in your image.) 
When you choose one of the options in this menu, the adjust-
ment is only applied to that part of the image that is based on 
the lightness, hue, or saturation range specified. The Range 
slider expands or contracts the selected option, and the High-
lights, Shadows, and Skin sliders protect those settings from 
your adjustments.

NOTE: How to apply blending modes, which ones to use, and when to use them, are 
beyond the scope of this guide. PhotoshopCafe.com has a free tutorial on belneding 
modes, which can be found here: http://bit.ly/2hlfX5h

Local Adjustment tools
There are two tools specifically designed to create local adjustments, the Adjustment Brush 
and the Adjustable Gradient:

Adjustment Brush
The Adjustment Brush works like a standard paint brush tool, with adjustable sizes and feath-
ering, and settings for opacity. You can paint an adjustment in or out via the Mode pop-up in 
the Tool Options bar, and adjust the size and feathering of the brush via the bar or with the 
bracket keys on your keyboard. What makes the Adjustment Brush powerful is when it is used 
with the Perfect Brush option, represented by the icon in the Tool Options bar. 

The Perfect Brush option incorporates a color-based, self-masking technology to help cre-
ate precise selections and masks. When you turn the Perfect Brush option on, the Ad-
justment Brush collects the colors under the center of the brush and applies the effect 
only to those colors. This protects the adjustment from being applied across edges. A 
great of example of using the Perfect Brush option would be if you wanted to darken 
the sky in an image, but didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between keep and drop colors, 
based on the area you are working on. For example you may want the Perfect Brush to be 
very precise and only paint away very similar colors, other times you want it to paint away a 
broad range of colors in the same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a 
soft edge, increase the transition. To create a harder edge you need to decrease the transi-
tion.

Tip: You can turn the Perfect Brush on and off using the Command-r keyboard 
shortcut (Control-r on Windows). You can also temporarily lock the color to remove 
by holding down the Control key (Windows) or the Command key (Mac). This is useful 
when brushing through areas with a lot of openings like tree branches.

Perfect 
Brush

The Adjustment pane’s Blending 
controls give you extensive options for 
applying local adjustments to targeted 
tonal and color ranges in an image.
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Adjustable Gradient Tool
The Gradient Adjustment tool is very similar to the Masking Bug found in Effects. It lets you 
create a linear or radial gradient mask across part of your image, The gradient mask goes 
from dark to light in tone, applying more of the adjustment where the gradient is lighter, and 
less of the adjustment where the gradient’s tone is dark. The most common use of gradient 
masks is to darken the sky in an image, while preserving the brightness of the foreground, 
similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the 
image roughly where you wish the effect to be. You’ll see the outline of the gradient, which is 
called a bug. You can use the handles on the bug to move your gradient around, increase or 
decrease the length of the gradient, or rotate it. 

You can change the gradient shape via the Tool Options bar: in addition to the standard 
dark-to-light horizontal gradient, you can also create a circular gradient and a reflected gra-
dient, which is like the horizontal gradient, but goes from black (no effect) at the outer edges 
to white (full effect) in the center.

TIP: To see the mask created by the Gradient Adjustment tool, and the range of black 
to white tonality, choose Show Mask from the View menu. You can choose either a red 
overlay, which presents the mask over your image, or grayscale, which just shows the 
mask as black to white tones. These views can be helpful in understanding how these 
gradients work.

Adjustable Gradient Tool Options Bar:
Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current 
bug (if there is one) to match the preset. 
Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new gradient using the current settings.
Delete: Deletes the current gradient.
Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a linear gradient mask
Once you’ve added a gradient to an image, you can modify it easily by accessing the follow-
ing parts of the gradient overlay: 

•  To move a gradient, click on the big circle at the center of the gradient and drag.
•  To resize a radial gradient, click and drag on the solid line.
•  To adjust the feather (hardness) of the mask, click and drag along the dashed line.
•  To rotate the mask, click the smaller circle near the gradient center and drag.
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Presets
Presets are a fast and easy way to get consistent results when 
editing a group of images, as well as help you hone your own 
photographic look. Presets are stored “recipes” that include a 
set of Develop and Effects adjustments, and can easily be ap-
plied to one or 100 images with ease. 

ON1 Photo RAW comes with more than 200 built-in presets, 
in more than a dozen categories, ranging from landscapes to 
portraits, color grading, film looks and much more. You can also 
create your own presets, or import presets from other ON1 
users and photographers.

Presets do not store crop settings, retouching information, 
or masks created with brush tools. Masks created with Effects’ 
Masking Bug, or with the Adjustable Gradient Tool in the Local 
Adjustments panel, can be stored in a preset, however.

Using a Preset
To apply a preset to an image, click on the Presets panel. There 
you will see any built-in presets supplied by ON1—ordered by 
category—as well as any presets you might have created or 
installed yourself. Clicking on a category name will open it and 
display any presets within that category, each with a tiny thumb-
nail showing your selected image with that preset applied to it. 

If you’d like to see a larger representation of what your se-
lected photo will look like with a category’s presets, click on the Quick View Browser icon in 
the category’s title bar. That will display a window over the entire Photo RAW interface with 
all of the presets in that category. (Press the Escape key to close the Quick View Browser.)

TIP: To change the size of the thumbnails in the Presets panel, select the Browser 
Mode option from the View menu and choose One, Two or Three Column View.

To apply a preset to a photo, simply click on the preset in either the Category min-brows-
er or in the Quick View mode. Presets are not cumulative; after you’ve applied one preset, 
clicking on another preset will remove the previous one and apply the new one.

Once you’ve applied a preset, you can still make changes to any of the panes and set-
tings, add or remove adjustments, switch to another preset, perform any retouching or more.

If you don’t like a preset, clicking on another one will replace the settings of the previous 
preset with the settings of the new preset. To remove a preset entirely from an image, choose 
one of the reset options from the Settings menu, or remove the individual settings from the 
appropriate panes in Develop and Effects. (The latter approach is recommended if you have 
created masks or local adjustments that you wish to preserve.)

TIP: If you hover over a preset’s thumbnail in the browser, you’ll see a heart icon. 
Clicking this will fill the heart in and add that style to your Favorites. This category 
resides at the top of the Presets panel, and contains the presets you have selected as 
a favorite. To remove a favorite, open the Favorites, and click again on the heart icon.

Preset panel, in its default (closed) view. 
As you hover over a category, the Quick 
View Browser icon appears on the left 
side of the category’s name.
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Saving a Preset
Once you have a group of edited settings that you wish to save, go 
to the Settings menu and select Save Preset. The New Preset dialog 
will appear, with options for which module’s settings you wish to save, 
naming the preset, and adding it to an existing or new category.
If you’ve applied a preset to an image, and update any of the edit 
settings (or add or remove adjustments), you can update the preset 
with the new settings by choosing Update Preset with Current Settings 
from the Settings menu. This will only change the preset in your app; 
any images that had the old version of the preset will keep those set-
tings unless you reapply the preset.

Deleting a Preset
You can remove a preset if you no longer want to have access to it. To 
remove a preset, follow these steps:
•  Select the preset you wish to remove in the Preset panel.
•  Select Delete Preset from the Settings menu.

Importing & Sharing Presets
You can import presets you have down-
loaded from the ON1 website or other 
source. Some files will be individual 
presets, while others might include more 
than one preset, and might be known as 
preset “packs.” 

A preset will have an ‘.ONP’ exten-
sion, while a preset pack has an ‘ON-
Preset’ extension; all you need to do is 
double-click on the file—or choose Im-
port Preset from the Settings menu—and 
Photo RAW will ask you to pick a catego-

ry where you wish to place the preset or pack, and it will copy 
the preset(s) into the app. (You can delete the downloaded files, if desired.)
To export a preset, click on it and choose Export preset from the Settings menu.

TIP: Many preset management options can also be performed by clicking on a preset 
in the Preset panel and right-clicking on the preset. This is helpful if you want to 
update, export or rename a preset without applying it to an image in Develop or 
Effects.

The Landscape category, set 
to 1-column preview. To apply 
a preset, just click on it in this 
view. With the Save Preset dialog box, you 

can save your Develop and Effects 
settings, and any gradient masks and 

Local Adjustment settings that used the 
Adjustable Gradient tool.



ON1 Photo RAW 2017 User Guide	 Part 3: ON1 Develop	 62

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a full-
screen representation of that category’s presets, giving you a larger representation of how that preset will look when applied to your image.
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Part 4: ON1 Effects
If Develop is the base from which you start editing your photos, Effects is the finishing school. 
With more than 20 filters that can be stacked in any order, with extensive blending and mask-
ing options, Effects lets you create stunning, pro-level photos with ease. And, since it is built 
upon ON1 Photo RAW’s non-destructive editing engine, you can go from Browse to Develop 
to Effects and back again, preserving your edits, masks and more without having to worry 
about saving multiple versions of your files. 

NOTE: If you use an external editor such as Lightroom or Adobe Photoshop as your 
primary Raw editor, you can use Smart Photos (via Lightroom) or Smart Objects (in 
Photoshop) to preserve edits made in ON1 Photo RAW. See Pages 10-12 of this guide 
for a description of the editing process with these apps.

While Develop and Effects share some tools and even some adjustment types, Effects is 
much more customizable in how adjustments—called filters in Effects—are applied. The edit-
ing stack inside Develop is fixed, while the stack in Effects is extremely flexible. Here are just 
a few of the things you can do with an image in Effects: 

•  You can add filters in any order (even multiple instances of the same filter).
•  Move filters up and down in the stack.
•  Add blending options to all or some of the filters and set the opacity of each 

filter individually.
•  Create complex masks for each filter you add, letting you selectively apply a filter 

to specific portions of an image. (Effects includes more tools for creating masks 
and selections than Develop.)

Because Effects and Develop are so tightly integrated with one another, you can move 
back and forth between the two modules without any worries—edits you make in one mod-
ule are preserved in the other. Presets can be saved (and applied) using any edits you make in 
either or both modules, and can include gradient and adjustable gradient masks. (See Page 
60 for more on presets.)

Effects also shares the Local Adjustments panel with Develop; any local adjustments made 
while you were working in Develop will be visible and available inside Effects, and vice versa. 
(See Page 57 for information on how to use local adjustments.)

In addition to creating and using presets, you can copy and paste the Develop and Ef-
fects settings from one file to another, or alternatively, synchronize the edits on one photo to 
a group of photos. These operations can all be performed in any of the editing modules, as 
well as in Browse, adding to ON1 Photo RAW’s extreme flexibility. 



ON1 Photo RAW 2017 User Guide	 Part 4: ON1 Effects	 64

ON1 Effects Main Screen Overview
A.	 Tool Well: tools for working within Effects
B.	 Preferences/Help: Shortcuts to app preferences and help.
C.	 Presets/Filters Panels: Switch between list of installed presets (by category) or list of all filters 

available inside Effects. Clicking tab switches between panels. Clicking on an item in the list ap-
plies that preset or filter style to your image.

D.	 Search: Searches presets or filter styles (by name).
E.	 Preview Window Options: switch between detail view or filmstrip view; magnification slider ad-

justs zoom for current image.
F.	 Tool Options bar: Options and settings for currently selected tool.
G.	 Preview Window: displays the current photo in detail view.
H.	 Preview Option toggles: compare (before/after) mode, show/hide mask, turn preview on or off.
I.	 Photo Information pane: navigator, histogram and general photo information
J.	 Overall Settings/Local Adjustments panes: clicking tab switches between filter stack and local 

adjustment panels.
K.	 Filter Stack: Where you add filters to apply to your photo. Click the Add Filter button at the top of 

the stack to add filters.
L.	 Reset bar: Reset all (Develop and Effects settings), Reset (Develop-only settings), sync settings 

with previously edited photo (only in Filmstrip view)
M.	 Module Selector: Switches between modules (if you are editing a photo as a plug-in, some mod-

ules might be disabled).
N.	 Export/Share: Shortcuts for exporting and sharing selected photos.



ON1 Photo RAW 2017 User Guide	 Part 4: ON1 Effects	 65

Tools
Effects has nine tools available for you when you are working on a photo:

Crop Tool: Trims an image to your desired size or ratio.
Adjustment Brush: Paints in or out local adjustments.
Adjustable Gradient: Applies a selective gradient in local adjustment mode.
Masking Brush: Mask large similar areas quickly. (Includes Perfect Brush option.)
Masking Bug: Applies a selective gradient as a mask in any filter (or to the entire 
stack).
Refine Brush: Lets you refine an existing mask’s edges, to help mask difficult areas, 
such as hair.
Perfect Eraser: Removes distractions like signs and power lines.
Retouch Brush: Removes blemishes like dust spots and acne. (Includes Perfect Brush 
option.)
Zoom Tool: Adjusts the magnification of the image in the Preview area.

To access a tool, simply click on the tool. When selected, the cursor will change, and 
you will see a set of options for the tool in the Tool Options bar above the Preview 
window.

Filters
Filters are the building blocks of Effects’ editing power. Each 
filter is an adjustment type, much like the basic adjustment 
panes inside Develop, but Effects filters have much more 
functionality than the basic panes inside Develop. Each filter 
is like a movable, editable layer over the base image you are 
working on. You can use Effects’ masking tools to apply a filter 
to only part of an image and can change the blending mode 
(and opacity of the filter) to alter the way the filter interacts 
with those above and below it in the stack.

The Effects module has 23 filter types, found in the Overall 
Settings panel (they are also accessible via the Filters pane on 
the left side of the window). Unlike Develop, you can apply 
filters in any order, and you can have more than one instance 
of a filter in the stack. (This can be helpful when you are creat-
ing complicated masks on an image and wish to apply a filter 
differently in parts of the image.)

Applying filters with the Filter Browser
Much like the Presets panel found in the Browse, Develop and Effects modules, Effects has 
a Filter panel that lets you browse all of the filters inside Effects, and display previews of 
those filters with the available styles for that filter. To choose the Filters panel, click on the 
Filters tab. A list of the filters will appear, and clicking on a filter will display thumbnails of 
your image with that filter’s available styles. To choose one, click on the style, and Effects will 

Contents of a filter pane (Blur filter shown):
A.Checkmark turns filter on or off.
B. Show/Hide Mask
C. Blending mode options
D. Deletes filter from the stack.
E. Sets opacity of the filter.
F. Styles pane for quickly applying filter presets.
G. Settings area for adjusting a filter’s settings. 
(Settings dependent upon the filter chosen.)
H. Resets filter settings to its default state; 
does not reset masks.
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add that filter to the Overall Settings pane. Note that this will replace the 
currently selected filter in the stack; to add a new one on top of the stack, 
click the Add Filter button in the Overall Settings panel, then choose a 
filter from the list. 

TIP: If you hover over a filter style’s thumbnail in the browser, you’ll 
see a heart icon. Clicking the icon will fill the heart in and add that 
style to your Favorites category. This category resides at the top 
of the filter list, and contains all filter styles you have selected as a 
favorite. To remove a favorite, open the Favorites category, and click 
again in the heart icon.

If you’d like to see a larger representation of what your selected photo 
will look like with a filter’s styles, click on the Quick View Browser icon in 
the category’s title bar. That will display a window over the entire Photo 
RAW interface with all of the presets in that category. (Press the Escape 
key to close the Quick View Browser.)

TIP: To change the size of the thumbnails in the Presets panel, select 
the Browser Mode option from the View menu and choose One, Two 
or Three Column View.

To apply a filter style to a photo, simply click on the style in either the 
Filter Browser or in the Quick View Browser. 

Searching for filter styles inside the Filter Browser
To search for styles inside the Filter Browser, type in the name you’re looking for in the search 
field. The search results appear in a new sub-folder called search results, which will be select-
ed automatically. 

Working with filter panes
By default, the filter stack is empty, although, if you have applied a preset in Browse or De-
velop that uses filters from Effects, you will see those filters in the stack. To add a filter, simply 
click on the Add Filter button at the top of the stack, and click the filter pane you would like 
to add to the stack. Clicking on the checkmark will turn that pane on or off, which can be 
helpful if you want to see the effect in the context of other edits you have made. If you don’t 
like the effect, click on the trash can icon in the pane’s title bar to get rid of it. The Reset but-
ton at the bottom of each pane will reset that pane’s settings to their default.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or 
down. A heavy white line will appear between panes as you drag; simple let go of the mouse 
at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title bar is 
clickable).  
  If you don’t want to have to scroll up and down the filter stack when you have a lot 
of open panes, go to the Window menu and choose Solo Mode. This will leave only 

The Filter Browser has 
a list of all the filters 
available in Effects. 
Clicking on a filter will 
display thumbnails of the 
filter’s styles using your 
image.
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the current pane open, and will hide all the other panes. Clicking on another pane will 
open that one and collapse the previous one.

Styles
Most of the panes in Effects have a set of built-in styles in the top part of the pane. Styles are 
like preset adjustments for a pane: they provide a group of settings to help you get started in 
the pane, or to apply a specific effect. 

You use a style by clicking on the style’s icon in the pane, and 
then can adjust the sliders as desired to get the right effect for 
your photo. 

You can save your own settings as a style. Simply click on the More icon on the far right 
side of the styles list for that pane, then choose Save New Style from the pop-up. Name your 
style, and it will then be added to the top of the More menu. To apply a saved style, choose 
the style from the More pop-up menu. To adjust the settings for a saved style, apply it, make 
any changes you would like to the sliders or other options, then right-click on the More pop-
up and choose Update Style with Current Settings from the menu.

NOTE: It can be easy to confuse presets and filters, but filters are individual 
adjustments (as are the adjustment pane options inside Develop). Presets are a 
composite of all saved adjustments (and some masks) made across both the Develop 
and Effects modules. For more on presets, see Page 60. 

Filter Masks
Every filter has a mask associated with it, which lets you apply that filter’s effect to specific 
areas of an image, using the Masking Brush and Masking Bug tools. By default, the mask is 
white, which means that the effect is visible in every area of the image. Using the Masking 
Brush, for example, you can ‘paint out’ the effect in areas that you wish not to be affected by 
the filter. Alternatively, you can invert a filter’s mask and choose to ‘paint in’ the filter where 
you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting 
and using one of the two masking tools, or by clicking the 
Show/Hide Mask icon in the title bar of the filter pane (this 
icon will initially be represented with a plus sign in the mid-
dle of it). When you add a mask in either way, the contents 
of the Show Mask icon will represent the mask on that filter 
layer.

Once you have a mask on a filter layer, you can manip-
ulate it by expanding the Show Mask section of the pane, 

where you will have options for inverting the mask, copying it and resetting it. Because it can 
sometimes be helpful to use the same mask on different filters, you can copy the contents of 
a mask from one filter and paste it onto the mask of another filter. If you have a mask copied 
to the clipboard, the Paste option will be active in the Show Mask pane.

Effects has two options for viewing the contents of a mask: you can choose to view a mask 
as either a red overlay on top of your image, or you can choose to see only the mask itself, 

Clicking on the Show Mask icon will display 
the current mask (if there is one) and give 
options for resetting, inverting and copying 
and pasting the mask.

Styles for the Split Tone pane
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represented as grayscale. These options are available from the Mask menu; select Show Mask 
to see the mask, while the View Mode option lets you switch between the two modes.

NOTE: There is one other mask type you can create in Effects, called a Luminosity 
Mask. This mask uses the brightness (or luminance) values in your image to create a 
mask that includes either all the dark tones or the light tones (if you invert the mask). 
To add one of these masks, choose Create Luminosity Mask from the Mask menu. 

For more detailed information on how to create masks, see the Masking Tools section on 
Page 82.

Deleting a Filter
You remove a filter by selecting it and pressing the trash icon to the right of the filter’s pane.

Filter Opacity
Every filter has an opacity setting, which effectively adjusts the strength of the filter. The 
Opacity slider, which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 
(full effect). What this means is that at 100, all of the filter is applied to the image in the stack. 
At 50, the filter strength is half, and the effect is much less strong. Playing with a filter’s opac-
ity can often help soften an effect in a way that you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted 
color effect, simply reduce the opacity of that filter. The more you reduce the opacity, the less 
effect the Black & White will have. 

By default, when you add a filter, the opacity will be set to 100. You can create presets, 
however, with whatever opacity you wish for a given filter.

Blending Modes
In addition to opacity, you have one other very powerful option for adjusting the strength 
and effect of a filter: blending modes. Blend modes determine how a filter interacts with the 
filters below it in the image stack. Blend modes can darken or lighten an image, depending 
upon the mode chosen, while others adjust contrast or color. ON1 Photo RAW’s blend modes 
also let you apply a blend mode to specific colors or tones in your image, making them a very 
useful tool for precision editing of your images. You can apply sharpening, for example, only 
to the midtones in an image, which can be very helpful in a landscape image. 

To see the blending modes, click on the Blending Options 
gear icon at the top of a filter’s pane. The Blending Options 
area will drop down from the top of the panel. The blending 
option controls are:

Blending Options: A pop-up list of blending modes. There 
are 24 common blending modes available in the list, including 
Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

Apply To: This lets you apply the blending mode to a spe-
cific color or tonal range. The options are; All (the default), 
Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 

Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a color 

Clicking the gear icon in a filter’s title bar 
will open the Blending Options section 
of the pane.
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range by selecting the Dropper Tool in the pane and clicking on a color in your image.) 
When you choose one of the options in this menu, the adjustment is only applied to that 

part of the image that is based on the lightness, hue, or saturation range specified. The 
Range slider expands or contracts the selected option, and the Highlights, Shadows, and Skin 
sliders protect those settings from your adjustments.

NOTE: How to apply blending modes, which ones to use, and when to use them, are 
beyond the scope of this guide. PhotoshopCafe.com has a free tutorial on belneding 
modes, which can be found here: http://bit.ly/2hlfX5h

Master Opacity, Blending and Mask options
Effects also has master opacity and master blend mode options for the entire image stack, 
and includes a Master mask option. The Master Opacity slider, found at the top of the Over-
all Settings panel, controls the strength of the composite filter stack against the original im-
age—if you haven’t performed any Develop operations on it—or against the image as it was 
edited inside Develop. 

The Master Blend Mode options can be accessed via the gear icon at the top of the 
Overall Settings panel. It has the same controls as the blending options in the individual filter 
panes, and, like Master Opacity, what it blends the filter stack with depends upon what edits 
you have made on your image in Develop.

To create a Master mask, click on the mask icon next to the Save Preset icon in the Over-
all Settings panel. This mask works on the entire effects stack, letting you selectively add (or 
remove) an entire effect on a photo. 

NOTE: For more on the image stack and how ON1 Photo RAW applies edits and 
settings to your image during a session, see “Understanding the Raw pipeline in ON1 
Photo RAW” on Page 9.
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Filter Types
Effects has 23 filter types available for you to use inside ON1 Photo RAW. Each filter has a 
set of styles in the top row, providing a range of popular or useful options for using that filter. 
You can also save your own preset styles by clicking the More pop-up at the end of the Styles 
row. 

NOTE: A few of the filters in Effects—Black & White, Noise Reduction, Sharpening, 
Split Tone, Glow, Color Response—are based upon the same algorithms as the 
adjustment panes inside Develop. If you apply an adjustment pane in Develop, and 
then add the same filter in Effects, you are in effect adding the filter a second time, at 
a different place in the image pipeline. While there are times when you might wish to 
do this, you can sometimes exaggerate an effect in a way that might not be beneficial 
to your image.

Antique
The Antique filter gives your image an aged look; unlike the Vin-
tage filter, this filter focuses more on a monochromatic or hand 
colored look.
Color: Drop-down menu displays a list of color options that are 
similar in tone to the Split Tone filter, providing a duotone-style 
effect.
Brightness: Adjusts the overall brightness of the image.
Fade: Adds a white fill to the image, giving the illusion of a fad-
ed photograph.
Saturation: Adjusts the color saturation. Moving the slider to 
the left decreases the saturation; moving it to the right increas-
es it.
Film Grain: Amount controls the strength and size dictates how 
large the grain appears.

Black & White
This pane is used to turn a color image into a monochromatic image, and, while it shares 
some of the same settings as the Black & White pane in Develop, you’ll find additional toning 
features in Effects. 

The styles at the top of the pane represent different filter types often applied to an im-
age, while the Auto button selects the black and white points of your image automatically. To 
manipulate the tones manually, move the color range sliders to the right (increasing bright-
ness) or the left (decreasing). Alternatively, you can choose the Channel Mixer option from 
the Conversion pop-up, and use the slider to choose a look that accentuates the color tones 
you are most interested in.

To change the tones directly inside a photo, choose the Color Response tool in the pane: 
click on it to select the tool, then click and drag in the image to increase or decrease the 
brightness of the selected color range.
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Tone
The Tone section of the Black & White pane is similar to the one 
in the Tone & Color pane in Develop: you can adjust brightness, 
contrast, highlights and shadows, whites and blacks, and detail 
directly within the filter pane.

Toner
The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from 
sepia tones to platinum, selenium, coffee and more. You can 
choose from more than 20 toning options via the Type pop -up 
menu, and adjust the combination of paper (which is represent-
ed by the Highlights section of the pane) and silver (represented 
by the Shadows). To tune your options, you can adjust the Hue 
or Amount of each setting, and use the Swap tones icon (next 
to the Highlights color well) to swap the highlights and shadows 
colors. The Preserve Whites and Blacks keeps the pure whites 
and blacks neutral instead of taking on the color of the toner.

Film Grain
The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain 
look to your photos. To add film grain, choose from the drop-
down list of popular black and white films. The Amount slider 
controls the strength of the effect, while the Size slider adjusts 
the scale of the grain. 

Bleach Bypass
This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.
Amount: Controls the strength or amount of the bleach bypass 
appearance.
Brightness:  Adjusts the overall brightness of the image.
Contrast: Increases or decreases the global contrast.
Detail: Enhances the details by increasing the micro contrast.
Saturation: Adjusts the underlying saturation.
Tint: Choose a new color by clicking in the color icon or by us-
ing the Hue slider.
Amount: Adjusts the strength of the tint.
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Blur
The blur filter contains five options for adding blur to your im-
ages: Gaussian, Motion, Radial, Surface and Box. Each blur type 
has its own look: 
Gaussian: This is a simple Gaussian blur applied to your image. 
It has one slider, Amount, which controls the strength of the 
blur by adjusting the radius.
Motion:  A motion blur adds the appearance of movement. 

The Amount slider controls the strength of the blur, and Distance controls the blur relative 
to area between the subject and camera. Angle sets the angle of the blur, while the Smooth-
ing slider softens the lines created by the motion.
Radial: These blurs are circular, zooming out from a central point. 

The Amount slider controls the overall strength of the blur. Quality controls how noisy or 
grainy the blur is, with 1 being grainy and 100 being smooth. Smoothing softens the lines 
created by the motion. 

The Radial blur type also includes a center spot selector at the bottom of the pane. Click 
on the spot selector icon and then click on the part of the image you want to make the cen-
ter of the blur.
Surface: These blurs tend to maintain edges but add blur to the details. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.
Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a blur; use 
the amount sliders instead.

Borders
ON1 Photo RAW has a large collection of pre-made borders 
and edges that you can add to your photos. These borders 
range from classic film borders to viewfinders to artistic effects 
to emulsion transfers and many more. 

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders 
you choose. 

You can also import your own borders, either directly into 
the Borders filter pane, or via the Extras Manager (available in 
Browse). Border files need to be a standard PNG file type with a 
large central transparent area

NOTE: See the Overview on Page 14 about how to use the 
Extras Manager to import borders (and other extras), as 
well as more information on preparing files for Borders and 
Textures.

The Category and Border pop-ups at the top of the pane are used to select the border 
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category and the specific borders within each category. There are 8 built-in categories, sort-
ed by type. Any user-imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending mode and opacity, 
and, if the border has color, you can adjust its hue, saturation and brightness. Alternatively, if 
the border is black or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you scale the border up or 
down in size, to help you get the look you’re after, and the Fit Image slider adjusts the size of 
the image under the border.

You can rotate or flip the currently selected border by clicking the buttons at the bottom 
of the screen.
 
Color Enhancer

The Color Enhancer is designed to give you complete control 
over color manipulation in your image, whether it is on a global-
ly across your entire image, or by adjusting different color rang-
es. (It is a combination of the Color section of the Tone & Color 
pane and the Color Adjustment pane in Develop.)

The styles at the top of the pane are designed to help en-
hance specific scene types (Foliage, Fall, Desert, Sky). To adjust 
global color in an image, work in the Color section of the top 
half of the filter pane; to work with individual color ranges, use 
the Color Range section at the bottom of the pane.

Color
The Color sliders in the top half of the pane control Tempera-
ture, Tint and Vibrance. They are used to remove a color cast 
and enhance the color of the image. The settings in this section 
of the Tone & Color pane include:

Auto Button: The auto button attempts to detect and remove 
a color cast. It makes adjustments to the Temperature and Tint 
sliders.

Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray. The sliders will automatically adjust according to 
the sample you have selected.
White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Cus-
tom). The default is As Shot, which is the color temperature that the camera recorded when 
you took the photo.
Temperature:  This slider shifts the color either cooler (blue) or warmer (yellow).
Tint:  Shifts the color either green or magenta.
Saturation: Increases or decreases the saturation of your image.
Vibrance:  Increases or decreases the color of muted tones, leaving more saturated colors 
alone.
Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are re-
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duced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.
Purity – Highlights: Reduces the saturation in the highlights.
Purity – Shadows: Reduces the saturation in the shadows.

Color Range
In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, 
green, aqua, blue, purple and magenta. Clicking on one of the colors will let you adjust the 
hue, saturation and brightness of the selected color range. Other settings in the pane in-
clude:
Range: This slider lets you narrow or widen the range of the selected color. 
Hue: Changes the hue for the selected color range.
Saturation: Adjusts the saturation of the selected color range.
Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and 
adjust the hue, saturation or brightness dynamically. To do this, click on the tool and choose 
which parameter you would like to adjust. Then click in your image on a color you would like 
to adjust and drag the cursor to the left or right to decrease or increase the effect.

Cross Process
This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.
Color: A drop-down list of cross-processing types (Blue, Green, 
Yellow, with Strong options).
Amount: Controls the overall strength of the filter.
Brightness: Adjusts the overall brightness.
Contrast: Adjusts the overall contrast.
Saturation: Adjusts the underlining saturation.

Dynamic Contrast
Dynamic contrast adds clarity—also known as tonal contrast—
to your image, making it pop. It can be a strong effect, so it is 
often combined with masks to help lessen the effect in certain 
areas of an image (clouds in a sky, for example, often look surre-
al with too much Dynamic Contrast applied to them). 

The top portion of the pane lets you adjust the contrast in 
areas of small, medium and large detail; moving the slider to 
the left decreases the contrast in those areas, while moving the 
sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect 
the tonal qualities of your image the bottom section of the 
Dynamic Contrast pane lets you make adjustments to the high-
lights and shadows to recover detail, while adjusting the con-
trast in the white and black areas, and increasing vibrance.
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Glow
This pane adds a soft-focus glow to the image. The styles sec-
tion and the More pop-up include a number of different glow 
types. Adjustable settings for the Glow pane include:
Amount: Controls the overall glow strength.
Halo: Sets the radius of the glow effect, creating a fuzziness to 
your image’s edges.
Mode: Lets you set the blending mode for the glow effect.

Grunge
This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:
Amount: Adjusts the overall strength of the grunge.
Brightness: Adjusts the overall brightness of the image.
Saturation: Adjusts the underlying saturation.
Detail: Adjusts the amount of detail.
Glow Amount: Adds a glow to the grunge.
Mode: Lets you choose the blending mode for the glow effect.
Film Grain Amount: Adds film grain to the image.
Film Grain Size: Controls the grain size.

HDR Look
This filter recreates the HDR style of tone mapping, with accen-
tuated edges and sharpening. This one, like dynamic contrast, 
often benefit from masking or blend modes. Settings for this 
filter include:
Compression: Compresses the tone to reveal highlight and 
shadow detail.
Detail: Increases the local contrast of details and edges in your 
image.
Clarity: Increases the global contrast.
Highlights: Recovers detail in the highlights.
Shadows: Recovers detail in the shadows.
Vibrance: Adjusts the vibrance of muted colors.
Glow: Adds a bright glow.
Grunge: Adds a dark gritty look.
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Lens Blur
This filter creates a blur, based on a camera lens such as a tilt-
shift or a shallow depth of field look. You can use the Masking 
Bug gradient tool to adjust the amount of blur through your im-
age, or brush in or out the effect where you want it. The filters 
settings include:
Amount: Adjusts the overall strength of the blur.
Optic Quality: Controls the aperture shape in the inner and 
outer feather.
Sides: Sets the number of blades in the lens aperture, which 
changes the shape of the bokeh.
Curvature: Sets the curvature of the aperture blades.
Blooming: Adjusts the highlight bokeh.

Brightness: Controls the overall brightness of the blur.
Contrast: Controls the contrast of the blurred areas.
Noise: Adds simulated film grain to the blurred areas.

Lens Flare
The Lens Flare filter is used to create or enhance images shot 
into the sun. It reduces contrast, shifts color and renders a real-
istic lens flare.
Type: Sets the style, either lens flare or sun spot.
Amount: Adjusts the overall strength of the effect.
Size: Controls the size of the effect.
Light Source Tool: Click and drag with this tool to set the lo-
cation of the light source. This can be off the image canvas, to 
give the effect of light coming in from outside the camera point 
of view.
Camera Position Tool: Click and drag with this tool to set the 
location of the camera. This changes the shape of the lens flare. 
This can also be off the canvas.

Show Rings: Shows or hides round aperture shaped artifacts in the lens flare.
Color: Select a vintage color look.
Amount: Control the amount of the vintage color look.
Vibrance: Add vibrance to the underlying image.
Fade: Decreases the shadow density by brightening the shadows. Adds a matte or faded 
look to your image.
Blooming: Adjusts the highlight bokeh.
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Noise Reduction
Use this pane to reduce luminance and color noise, while main-
taining image detail. The styles section includes a number of 
different noise reduction options, based on the type of image 
you’re working on.
Luminance: Adjusts the overall strength of the noise reduction 
applied to the luminance or detail of the image. Hold down the 
Alt/Option key to see just the luminance while adjusting this 
slider.
Color: Controls the amount of noise reduction applied just to 
the color or chroma of the image.

Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.
Apply to: Allows you to limit the noise reduction to just a portion of the image based on col-
or or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range or fuzziness of the 
color range to apply the noise reduction to.
 
Photo Filter

This filter recreates traditional, solid color lens filters used for 
warming and cooling effects, as well as gradient, bi-color and 
center-spot filters. You choose the filter type from the pop-up 
menu at the top of the pane, then adjust the settings to your lik-
ing. Each type offers different options for selecting a filter color 
(or colors, in the case of the Bi-Color type), adding saturation or 
polarization, and more.

The Solid option includes a section for choosing the single 
color you wish the filter to be, and an Amount slider for how 
strong you want the effect. The Polarizer slider adds a polar-

ization effect, which can sometimes help clear haze or enhance the blues and greens in an 
image.

The Bi-Color and Graduated filter options let you choose filter color (or colors), feather for 
the filter transition, and a direction for the effect. 

The Center type works much like the Graduated option, with the difference being that the 
filter radiates from the center of your image, and you can choose the center to be either clear 
or colored.
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Sharpening
This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Photo RAW offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which 
one you use depends upon the image or your personal pref-
erences. The styles section and the More pop-up have a wide 
range of sharpening styles—using all three methods—to help 
you get started.
Type: Chooses the sharpening method. Each sharpening meth-
od has its own set of sliders.
Amount (all types): Controls the overall strength of the sharpen-

ing for each sharpening type.
Halo (Unsharp Mask, High Pass): Sets the radius of the sharpening effect. Smaller amounts 
keep fine detail, while larger amounts can exaggerate edge detail.
Threshold  (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened. 
Detail (Progressive only): Controls sharpening in small details.

The Protect section protects highlight, and shadow areas and skin tones from having  
sharpening applied.

Skin Retouching
The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you 
to choose from, depending upon your image. Other settings 
include:
Blemishes: Adjusts the strength of acne, pores and fine lines.
Smoothing: Adjusts the strength of smoothing similar to make-
up foundation.
Shine: Adjusts the strength of the skin shine.

Evenness: Adjusts how consistent the skin color is across the entire face. It is great for cor-
recting highlights that may be too yellow, shadows that may be too green or reducing red-
ness in noses and ears. 
Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.
Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.
Range: Adjusts the precision of the color selected.
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Split Tone
This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different 
hues. This can be used to age an image and give it an antique 
or vintage look. The styles section has a selection of popular 
split-tone effects, and you can create your own by manipulating 
the sliders to choose a map for the highlight and shadow colors. 

To use the pane, you can use the Hue slider in each of the 
sections to choose the colors you want for highlights and shad-
ows. The Amount slider controls the strength of the color, and 
Balance sets the balance between the shadow and highlight 
colors, letting you make one of the colors more dominant.

The Mode pop-up sets the blending mode for the split tone. The options you can choose 
from are Normal (no blending), Color, Lighten, Darken, Multiply or Screen.

Sunshine
This filter increases the appearance of sunshine. It makes a flat 
cloudy day more vivid. The controls are fairly straightforward, 
including adjustments for the strength (Amount), warmth and 
saturation. You can use the Glow slider to add a bright glow to 
your image.

Textures
The Textures filter places a texture over the image to add a 
stylized look and is similar to the Borders filter in scope and 
functionality. ON1 Photo RAW comes with an extensive set of 
textures that you can add to your photos, ranging from fab-
ric, metal, stone, text and more. You can also import your own 
textures directly into the Borders filter pane, or via the Extras 
Manager (available in Browse). Texture files can be almost any 
image format (JPEG, TIFF, Raw or Photoshop).

NOTE: See the Overview on Page 14 about how to use the 
Extras Manager to import textures (and other extras), as 
well as more information on preparing files for Borders and 
Textures.

When loading a texture file, it will be rotated automatically 
to match the orientation of your image. You can override this 
with the rotate and flip tools, and use the Transform option to 
scale the texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top of the pane, used to help 
you narrow your texture search. There are nine texture categories, sorted by type, and any 
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user-imported textures will also appear in this list.
Once you have chosen a texture, you can adjust its blending mode and opacity, and, if the 

texture has color, you can adjust its hue, saturation and brightness. Alternatively, if the tex-
ture is black or white, you can colorize it by clicking on the Colorize button in the bottom half 
of the pane.

The Transform section at the bottom of the pane lets you scale the texture up or down 
in size. You can also rotate or flip the texture by clicking the buttons at the bottom of the 
screen, which can be helpful to achieve the look you desire.

Tone Enhancer
The Tone Enhancer controls the brightness and contrast, or 
tone, of the image and lets you recover detail in the highlights 
and shadows, and adjust the white or black point. It offers simi-
lar controls to the Tone section of Develop’s Tone & Color pane, 
and also includes a curves dialog if you wish to fine tune your 
image in that manner.
Auto Button: The auto button sets the white and black points 
automatically, adjusting all of the primary tone settings to bal-
ance the histogram.
Exposure: Adjusting this slider to the right will lighten your im-
age. Adjusting to the left will darken your image.
Contrast: Increase or decrease the contrast in your image.
Highlights: Darkens the highlights, recovering detail.
Shadows:  Lightens the shadows, revealing details.
Whites: Adjusts the white point, adding or removing contrast in 
the highlights.

Blacks: Adjusts the black point, adding or removing contrast in the shadows.
Compression: Compresses the tone to reveal highlight and shadow detail.
Detail: Increases the local contrast in the image.
Clarity: Enhances large edges to add clarity.
Curves: The curves dialog is a powerful, advanced tool for adjusting contrast and color. (See 
the section on Curves in the Develop section, on Page 50 for more on how to adjust the 
curves.) 

Vignette
The Vignette pane creates flexible vignettes which focus a view-
er’s eye toward the center of the image by darkening the edges 
of the frame. The buttons at the top of the pane let you quickly 
apply a vignette and then customize the look with the advanced 
controls. Styles apply common vignette types.
Brightness: Controls how light or dark the vignette is.
Size: Controls the size of the vignette.
Feather: Controls the hardness of the edge of the vignette.
Roundness: Controls the shape of the vignette from square to 
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round.
Type: This drop-down menu lets you select a normal, subtle or soft vignette effect.

The Center Tool at the bottom of the pane lets you to select the center point of the vi-
gnette.  Click on the tool icon to activate and then click on the area in the image you wish to 
make the center of your vignette.

Vintage
The Vintage filter is for adding an aged, vintage look reminis-
cent of films and papers from the mid-to-late 20th Century.
Color: A drop-down menu of various color styles to apply to 
your image.
Amount: Controls the overall strength of the filter.
Saturation: Adjusts the saturation of the original image.
Film Grain Amount: Adds film grain to the image.
Film Grain Size: Controls the grain size.
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Effects Tools
Effects and Develop share four tools between them: the Crop tool, the Perfect Eraser, Re-
touch Brush, and the Zoom Tool. The Crop tool remembers any crop you made in the De-
velop module, so if you are editing an image and want to reset the crop, simply click on the 
Crop tool in Effects and you will see your existing crop. 

NOTE: To see the options for all of these shared tools, as well as the Local 
Adjustment tools, please see Page 57 in the Develop section of the user guide.

The unique tools inside Effects are related to the creation and refinement of masks. The 
Masking Brush lets you brush a mask in or out on a filter’s mask layer, and lets you use ON1‘s 
Perfect Brush technology to create very precise masks. The Masking Bug is very much like 
the Adjustable Gradient tool in the Local Adjustments panel, providing three types of gradi-
ent masks to apply selectively to your images. And lastly, the Refine Brush helps improve the 
transition between the edge of your masks and the unmasked areas, giving you more realistic 
looking masks. The operation of these tools is described below.

Masking Brush
The Masking Brush is one of two tools in Effects for masking filters. When you select the 
Masking Brush, your cursor changes to look like two concentric circles, one representing the 
inner hard edge of the brush, and soft outer, feathered edge of the brush. At the center of 
the brush is either a plus or minus. The plus means that you are painting “in” a filter’s effect, 
while minus means the brush mode is set to paint out.	  

Masking Brush Tool Options 
Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting 
in (restoring the effect). You can tell your current mode by looking at the plus or minus icon 
in the center of the brush. If the icon is minus, you are painting out, and  if the icon is a plus, 
you are painting in. You can change the mode in the Tool Options bar, or by pressing the X 
key, or by holding down the option (alt) key temporarily.

NOTE: If you would like to invert the mask (turn it from black to white), in order to 
paint a filter’s effect into your image, select the Masking Brush tool, then choose 
Invert Mask from the Mask menu.

Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

•  Use the Size pop-up in the Tool Options bar.
•  Use the left and right bracket keys: ‘ [ ‘ and  ‘ ] ’ .
•  Use your mouse’s scroll wheel (this option can be set in ON1 Photo RAW’s Prefer-

ences window).
•  Use your Wacom pressure-sensitive tablet.
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Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use 
a small feather at high magnification for precise, hard-edged work and a large, soft-edged 
brush in Fit to screen mode for general work. You can visually see your feather by watching 
the outer concentric circle of the brush tool. In addition to the Feather pop-up, you can ad-
just the size of the feather by holding down the Shift key and pressing the right or left brack-
et keys on your keyboard.
Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

•  Use the Opacity pop-up in the Tool Options bar.
•  Press the option (Mac OS) or alt (Windows) key on your keyboard and press one 

of the number keys. Each number represents an opacity percentage from 10% (1) 
to 90% (9); 0 represents no opacity.

•  Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your mask. While 
white in a mask represents 100% of an effect showing and black represents no effect 
showing, all opacity settings in between will show a percentage of the effect. This can 
be very useful when you wish to blend masks in a realistic manner.

Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you turn the Perfect Brush option on—by 

clicking on the Perfect Brush icon in the Tool Options bar—the Masking Brush col-
lects the colors under the center of the brush and applies the effect only to those 
colors. This protects the adjustment from being applied across edges, such as tree 
branches.

Further settings for the Perfect Brush can be found by clicking on the gear icon in 
the Tool Options bar. There, you can set the following options:
Color Threshold: This option lets you control the balance between keep and drop colors, 
based on the area you are working on. For example, you may want the Perfect Brush to be 
very precise and only paint away very similar colors, while at other times you want it to paint 
away a broad range of colors in the same neighborhood.
Transition: This slider controls the feather of the Perfect Brush based on color. To create a 
soft edge, increase the transition. To create a harder edge, decrease the transition amount.

TIP: You can turn the Perfect Brush on and off using the Command- (Mac OS) or 
Control-r (Windows) keyboard shortcut. You can also temporarily lock the color to 
remove by holding down the Control key or the Command key. This can be useful 
when brushing through areas with a lot of openings like tree branches. 

Wacom support
ON1 Photo supports pressure-sensitive tablets from Wacom with the Masking Brush. When 
you use the Masking Brush you can enable pressure sensitive controls for the brush size, 
brush opacity, or both simultaneously. To turn this support on, click on the gear icon in the 

Perfect 
Brush
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Tool Options bar. You can activate pressure sensitivity for both sizer and opacity by clicking 
the appropriate buttons in the drop-down menu.

Masking Bug
The Masking Bug is used for blending layers by creating radial, gradient and reflected gradi-
ent mask shapes quickly. It works in a similar manner to the Adjustable Gradient tool in the 
Local Adjustments pane. The mask goes from 
dark to light in tone, applying more of the ad-
justment where the gradient is lighter, and less 
of the adjustment where the gradient’s tone is 
dark. The most common use of gradient masks 
is to darken the sky in an image, while preserv-
ing the brightness of the foreground, similar to 
using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click 
on the Masking Bug in the tool well, then click 
in the image roughly where you wish the gradi-
ent to go. You’ll see the outline of the gradient, 
which is called a bug. You can use the handles on the bug to move your gradient around, 
increase or decrease the length of the gradient, or rotate it. 

You can change the gradient shape via the Tool Options bar: in addition to the standard 
dark-to-light horizontal gradient, you can also create a circular gradient and a reflected gra-
dient, which is like the horizontal gradient, but goes from black (no effect) at the outer edges 
to white (full effect) in the center.

TIP: To see the mask created by the Masking Bug, and the range of black to white 
tonality, choose Show Mask from the View menu. You can choose either a red overlay, 
which presents the mask over your image, or grayscale, which just shows the mask as 
black to white tones.

Masking Bug Tool Options Bar:

Preset: The preset pop-up includes several common ways to use the tool (top down, bottom 
up, left and right, and circular vignettes), and changes the current bug (if there is one) to 
match the preset. 
Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new gradient using the current settings.
Delete: Deletes the current gradient.
Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

In this image, a Dynamic Contrast filter has been applied, with a 
Masking Bug added, to keep the filter’s effect out of the clouds.
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Manipulating a linear gradient mask
Once you’ve added a gradient to an image, you can modify it easily by accessing the follow-
ing parts of the gradient overlay: 
To move a gradient, click on the large circle at the center of the gradient and drag.
To resize a radial gradient, click and drag on the solid line.
To adjust the feather (or hardness) of the mask, click and drag along the dashed line.
To rotate the mask, click on the smaller circle near the center of the gradient and drag.
 
Working with multiple Masking Bugs
You can have up to six Masking Bugs per layer. Each bug is re-editable when you’re using 
ON1 Photo RAW as a standalone app, or when you use Smart Filters (Photoshop) or Smart 
Photos (Lightroom). 

To add another Masking Bug, press the Add button or click outside of the current bug 
while the Masking Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the 
active bug while your mouse is over the preview area. Inactive bugs are marked with a small 
circle; to select an inactive bug clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When 
Masking Bugs overlay each other they may hide more of the layer too. You can always use the 
Masking Brush to over-ride and paint areas back in hidden by the Masking Bugs.

Refine Brush
This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning 
up a mask created with the Masking Brush. For example, when you wish to apply an effect to 
a subject, and there are areas such as hair, or tree branches that are difficult to remove with 
the Masking Brush. 

To use the Refine Brush, you select the tool and paint along the edges where you would 
like the mask to be refined. The brush strokes are displayed as a red overlay, and when you 
let up off the mouse button, ON1 Photo RAW will work to make making the mask edge more 
defined, improving the overall mask.

Refine Brush Tool Options
Mode: Controls the refinement mode, either Paint Out, which always refines to remove from 
the mask, Paint In, which always refines to add to the mask, or Auto, which does both at the 
same time. Paint out is recommended in most cases.
Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.
Pressure Adjusts Size (gear icon): If you have a Wacom tablet you can control the size of the 
brush with pressure when this setting is turned on.
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Develop & Effects Menus

ON1 Photo RAW (Mac OS Only)
About ON1 Photo Raw: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)
Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)
Quit ON1 Photo RAW: Quits ON1 Photo RAW.

File Menu
Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.
Export: Opens the export side panel.
Print: Opens up the print dialog box.

Edit Menu
Undo: Removes the last file operation.
Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.
Cut: Cuts the currently selected item. 
Copy: Copies the currently selected item.
Paste: Pastes (copies) the items in the clipboard to the current 
location.
Preferences (Windows): Opens the Preferences dialog.

Mask Menu
Invert Mask: Inverts the mask, what was hidden is revealed and 
vice versa.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask.
Paste Mask: Pastes the mask.
Create Luminosity Mask: Creates a luminosity layer mask based 
off of a photo’s black or white tonal values.
Show Mask: Displays the current mask either as a red overlay 
or as grayscale.
View Mode: Sets the Show Mask mode to either red overlay or 
grayscale.
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Settings Menu
Reset All Settings: Resets all the applied settings on a photo.
Reset Develop Settings: Resets only the settings applied in the 
Develop module.
Reset Effects Settings: Resets only the settings applied in the 
Effects module.
Reset All Retouching Tools: Resets any retouching applied in 
the Develop or Effects modules.
Copy Settings: Copies all of the settings (Develop, Effects, 
retouching) applied to a photo.
Paste Settings: Pastes the copied settings (with options)
Save Settings as Preset: Saves the editing settings of the se-
lected photo as a preset.
Update Preset with Current Settings: If an image with a preset 
has had some settings changed, this lets you update the preset 
with the new settings.
Rename Preset: Renames a preset.
Delete Preset: Deletes a preset.
Export Preset: Exports a preset as an ON1 preset (.onp) file.
Import Preset: Imports ON1 preset (.onp) files.
Get More Presets: Goes to the ON1 website’s Photo Presets 
page.

View Menu
Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.
Zoom Out: Zooms the preview window out one increment. This 
will make the preview images smaller.
Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.
Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you to 
see every pixel in the image. This is useful when making preci-
sion adjustments.
Browser Mode: Sets the Preset panel browser view to 1, 2 or 3 
columns.
Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.
Show Preview: Toggle to enable or disable the preview.
Compare: Displays a split-screen view of the current image, 
with the Before view on the left side of the preview area.
View Mode: Toggles between Filmstrip and Detail view.
Preview Background Color: Lets you set the background color 
options.
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Window
Minimize: Minimizes your screen.
Zoom: Zooms your window to full-size (doesn’t hide menu bar). 
Full Screen: Toggles to and from full-screen mode (hides menu 
bar).
Navigator: Hides or shows the Navigator, Loupe, Histogram 
and Info pane.
Solo Mode: When enabled, this feature keeps only one control 
pane open at a time.
Open Quick View Browser: Opens the Quick View Browser 
overlay for  the currently selected preset category.
Show Browser Panel: Hides or shows the Browser Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help
Search: Searches the menu options (Mac OS only).
ON1 Develop Online Help: Opens ON1.com support page in 
your default web browser.
Video Tutorials: Opens ON1.com product training page in your 
default web browser.
Welcome to ON1 Photo RAW 2017: Displays the Welcome 
window.
Check for Updates: Checks with the ON1 update server to see 
if you are running the current version. If there is a newer ver-
sion, you will be notified and be walked through the update 
process.
Sign-In: Uses your ON1 account login information to authenti-
cate your copy of ON1 Photo RAW 2017. (Sign-out will remove 
an existing authentication.)
Provide Feedback: Opens the default web browser and navi-
gates to the feedback page of the ON1 website.
About ON1 Develop (Windows Only): Opens the about box 
with the version number and license code displayed.
Help Improve ON1 Products: Opens the Improve ON1 Prod-
ucts dialog.
Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Photo RAW 2017.
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Part 5: ON1 Resize
ON1 Resize lets you get the highest quality photo enlargements, using the patented, indus-
try-standard Genuine Fractals algorithms to enlarge photos without the loss of sharpness or 
detail. It includes the following features:

•  Complete control over adjustment size and resolution
•  Crop and level
•  Sharpening
•  Multiple resize algorithms let you get the highest quality results with any subject 

matter
•  Add film grain
•  Crop to common preset sizes for different paper and screen sizes
•  Add gallery wrap wings for printing on canvas
•  Divide an image into tiles for printing mosaics or murals
•  Crop, resize, and print all in one place without having to create a new file
•  Hundreds of presets to create the desired size print and adjust options for your 

printer and paper combination

When Should I Use ON1 Resize?
ON1 Resize should be used as one of the last steps in your workflow before printing. The 
power of ON1 Resize is in the concept of resolution on demand. You can work with a modest 
size file, which makes your editing faster and takes less hard drive space and memory. Then 
when you are ready to output your file, you resize it with ON1 Resize to the desired size and 
sharpen it for output. This means you don’t have to keep multiple versions of a file at differ-
ent print sizes; you just create what you need on-the-fly. ON1 Resize also supports layered 
Photoshop files so you can maintain all your layers in the entire process.

NOTE: A much fuller discussion of resolution and print size can be found in the “How 
Big Can I Print?” and “How Much Resolution Do I Need?” sections at the end of this 
chapter, starting on Page 100.
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The Resize Workspace
ON1 Resize provides you with an easy-to-use work area for editing your photos. Below is an 
overview of the main sections.
The main sections of Resize module include:
A. Presets: This panel is located on the left side of the window and is where you view a Library of 

presets.
B. Tool Well: This is where the tools are located.
C. Settings/Help: This is where you can access preferences and help.
D. Search: This is where you can search for presets.
E. Preview Window: This is the main section where you preview and work on images.
F. Navigator/Loupe/Histogram/Info Pane: This pane gives you access to each of the four areas.
G. Pixel Dimensions: This is where you can view the pixel dimensions of your image.
H. Document Size: This is where you access your document size.
I. Control Panes: You can access settings, sharpening, film grain, tiling and gallery wrap from these 

panes.
J. Export/Share: This is where you can export or share your image.
K. Save/Close: Buttons to save and/or close your image.
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Navigating the Preview
The Preview Window above is the main section where you preview and work on images. Re-
size includes two tools for navigating this window, the Zoom and Hand tools.

Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the pre-
view zoom is larger than the viewable area.

To pan (scroll) in the Preview window:
•  Select the Hand Tool and drag the image until you locate the area you wish to view.
•  With any other tool selected, hold down the spacebar while you drag the image in 

the window.
•  Double-click the Hand tool in the Tool well to set the image to a magnification that 

fits completely in the current window size.

Zoom Tool 
The Zoom tool changes the magnification of the image in the Preview window.

With the Zoom tool selected:
•  Click in the Preview window to zoom in and center the image at the location 

clicked.
•  Click and drag in the Preview window to draw a rectangular, the screen fills with the 

area within the rectangle when you release the mouse.
•  Hold the Option key (Mac) or Alt key (Win) and click to zoom out.
•  Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnifi-

cation, showing every pixel. This is best when examining small details.

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window are the Navigator, Loupe, 
Histogram, and Info panes. These four panes can be useful for inspecting and viewing details 
in your image.

The Navigator Pane
This gives you a birds-eye view of your image. The white 
square region marks the image area that is visible in the pre-
view pane. You can pan your image by clicking and dragging 
inside the white region.

At the bottom of the Navigator pane are several Zoom pre-
sets. Click on a Zoom preset to activate.

•  FIT: Zooms to fit the current canvas size.
•  100: Zooms to 100% or actual pixels.
•  50: Zooms to 50%
•  25: Zooms to 25%

 

The Navigator pane
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The Loupe Pane
This gives you a magnified view of the section of the preview 
under the cursor. This allows you to view the quality of your 
results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting 
the zoom level.

 

The Histogram Pane
This gives you a color chart of the shadow, mid-tone and high-
light areas based on the image RGB values. This is useful to 
show areas within the image that may be clipping. Clipping is 
when your image contains pure blacks or white and can signify 
loss of highlight or shadow detail. 

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is a 
triangle. If the triangle is lit, there is clipping on that side of the 

histogram. If you click on the arrows, you will activate the clipping overlay on your image. The 
areas of your image with a blue overlay are pure black, while the areas with the red overlay 
are pure white. You can turn the clipping view off again by clicking on one of the triangles. 
You can also temporarily enable clipping view by holding down the J key at any time. The 
clipping view is useful when you are making adjusts to the brightness and contrast of your 
image. 

The Histogram pane also displays the RGB values under the cursor at the bottom of the 
pane.

The Info Pane
The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions
File Size

If your camera allows for GPS the GPS button will be viewable and you can click on it to get 
the GPS cordinates for where the image was taken. This feature only works if you have GPS 
enabled on your camera or mobile device. Otherwise you will not see the GPS button.
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Crop Tool
The Crop tool is used to crop and resize the entire image. Unlike the non-destructive Crop 
tool in Develop and Effects, Resize’s Crop tool removes any pixels outside a crop box and 
changes the canvas size at the same time. 

To crop the image, select the Crop Tool from the tool well. 
Then adjust the corner handles of the crop tool overlay. The 
area outside the crop box appears darkened for guidance. You 
can resize and move the image inside the crop box. When you 
are satisfied with your settings, press the Apply button in the 
Tool Options Bar or press enter.

Working with the Crop tool overlay
Moving the Image: To move the image inside the crop box, sim-
ply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard.

Resizing a Crop Box: To resize the Crop Box, click and drag on 
any of the resize handles. Clicking on a corner handle allows you 
to adjust two sides at the same time. Clicking on a side handle 
allows you to adjust that side. If you hold the shift key down while 
adjusting the size, the proportions of the box are maintained. To rotate the crop box, move 
outside a corner until the tool changes to rotate. You can also set the aspect ratio or size of 
the crop box in the Tool Options bar.

NOTE: The Crop tool is not available when using a Smart Photo, or when you are 
using ON1 Photo RAW as a plug-in from Photoshop, Lightroom or Apple Photos.

Crop Tool Options Bar
Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets.
Width: Sets the width of the crop box.
Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
Height: Sets the height of the crop box.
Units: Determines the unit of measure: Pixels, inches, centimeters, etc.
Leveling Tool: Click and drag this tool across an element in your image that should be level.
Angle: See and adjust the angle of rotation.
Rotate: Rotates the image 90 degrees.
Cancel: Resets the crop tool.
Apply: Applies the crop and resizes your photo.

Crop Overlay
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Crop Tool Modes
The Crop Tool works in three modes, which are all accessible via the Pre-
set pop-up in the Tool Options bar:
Freeform: In this mode you can adjust the crop box any way you like. The 
image will not be resized. Any area outside the crop box will be trimmed 
off. Use this mode if you just want to change the shape or recompose 
your image for general use.
Aspect Ratio: You can lock the crop box to an aspect ratio. This makes 
sure the crop box shape doesn’t change, just the size. Use this option to 
trim existing pixels while maintaining a ratio without resizing the image.
Document Size Presets: Document Size Presets allow you to crop and 
resize your image at the same time. If you know your intent is to print the 
image at a certain size you can crop and resize the image at the same 
time. Many common sizes are included plus you can create your own.
 

Leveling the Image
The Crop Tool has a special Leveling Tool for automatically rotating your image to be level. 
To access it, first select the Crop tool, then perform the following:

•  Select the Leveling Tool from the Crop Tool Options Bar. Your cursor will change to 
the Leveling Tool.

•  Click and drag a line across your image that should be level, either horizontally or 
vertically. When you release the mouse the image will be rotated automatically to 
the correct angle.

Adjusting the Image Size
In ON1 Resize, you can adjust your image size using either the Document Size pane or the 
Crop Tool Options Bar. The information in these areas are interrelated and locked together. 
Adjusting the values in either pane will lead to changes in the other pane.

In the Document Size pane it displays the current desired Document Size or the original 
image size if you have not adjusted anything. You can simply type into the Width or Height 
fields to change the Document Size.

Keep in mind that the Width and Height fields are locked to-
gether to maintain the photo proportions. Changing the width 
will change the height proportionally. Resize does not support 
non-proportional scaling. If you would like to change the pro-
portions of the image it requires cropping, so use the crop tool.

NOTE: If you need to stretch a photo non-proportionally, 
use the Transform tool in the Layers module.

The Document Size Presets make it easy to crop and resize your photo at the same time. 
Simply select one to set the width and height automatically. This also selects the Crop Tool so 
you can adjust the document size to fit your photo. You also control your resolution, known 
as pixels per inch or dots per inch. This is important to adjust based on your output device.

The Pixel Dimensions pane displays the flattened, uncompressed image size in pixels as 
well as the file size, bit-depth and scaling factor.

Crop Tool modes, 
accessed via the Presets 
pop-up in the Tool Op-
tions bar.
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Using Document Size Presets
Document size presets allows you to crop and resize your im-
age simultaneously. Often, when you are using ON1 Resize it 
is to create a file for print output at a known common size. In 
these cases, using a Document Size Preset can be the fastest 
way to set your Document Size and crop your image to the 
needed proportions.

Follow these instructions to use a Document Size Preset:
•  Select your desired size from the Document Size preset pull-down in the Document 

Size pane, or Crop Tool Options Bar. You will see that the Document Size fields will 
be completed automatically for you and that a crop box is drawn on your image 
matching the proportions of the document size preset that you selected.

•  If needed, select the rotate crop box to rotate your crop box to the proper orien-
tation. It will automatically rotate to match the orientation of your image, but if you 
want to crop differently you may need to rotate it.

•  Now, you can use the crop tool to reposition and change the size of the crop box 
so that it contains just the image area that you want. Note that the crop box pro-
portions and Document Size are locked so that you will always have the finished 
document size that you requested.

•  Adjust your resolution to what is needed for your output device. If you are unsure 
what to select, use the resolution drop-down menu for common settings.

Resize comes with many commonly used print, paper and video document size presets but 
you can also create your own:

•  Select your image and launch Resize.
•  From the Document Size Preset pull-down, select Custom > Manage Custom Sizes.
•  Click on the Add button.
•  Double-click on the highlighted untitled name and name your preset.
•  Double-click on the width and height and fill in the proper values.
•  Click on the units and select the proper unit.
•  Click on the OK button.

TIP: If you select the incorrect Document Size Preset you can change it by selecting 
a different one. If you do not wish to use a Document Size Preset after you have 
selected one you can press the Reset button in the Document Size pane or the Cancel 
button in the Crop Tool Options Bar.

TIP: The lock crop option locks the proportions and document size settings for the 
given crop. This is enabled by default when you use a Document Size Preset.
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Settings pane
The Settings pane contains the controls for selecting the 
resizing method, or algorithm and its settings. Every im-
age is different and selecting the correct settings here can 
improve the quality of the results. To help you get started, 
try one of the presets in the Image Type drop-down menu. 
This pop-up contains presets that adjust the settings for 
Amount and Threshold automatically.

Method
The Method drop-down selects the method, or algorithm, used to resize the image. The op-
tions are:

•  Genuine Fractals: This is the classic, patented, fractal-based algorithm that has 
made Perfect Resize the standard for over a decade.

•  ON1 Resize Portrait: This is a new variation on the Genuine Fractals algorithm 
designed for portrait images. It is slightly softer and does a better job representing 
skin and hair textures.

Texture controls
When you select the Genuine Fractals method there are several other controls—Texture, 
Threshold, and Smoothness—that tune the resizing algorithm based on the image. These all 
have to deal with the texture of the image. If you were to analyze an image from a detail per-
spective you could break it into three categories: Edges, Continuous Tone and Textures. 

Edges are the sharp details that define the edges of the subject in your image. It’s para-
mount that these be maintained in order for your enlargement to maintain quality.

Continuous tone areas—like skin or skies—are mostly solid or graduated color. These 
resize easily as there is little detail in these areas. 

Texture, in Resize’s nomenclature, are the areas that fall between these two. They are ar-
eas that still contain detail but are not sharp edges. These are things like the surface of rocks, 
tree bark, fabric, animal fur, etc. The amount of detail in these texture areas can have a large 
impact on the perceived sharpness and quality of an image. 

With ON1 Resize you can control the key algorithm variables that effect these areas. And, 
you can use presets for different image types and subject matters that help you get the best 
results in reproducing these textured areas.

Here’s how to think of the sliders in the Settings pane, as you adjust the look of an image:
•  Texture: This controls the amount of detail in flat, non-edge areas of an image. If 

your image contains lots of small detail that does not have defined edges (many 
organic patterns like leaves, rock, bark; or man-made patterns like fabric) it may 
be good to increase the amount to a setting of 4 or 5. Settings beyond 5 will often 
introduce a bumpy noise pattern which is undesirable unless your original image 
was from scanned film. Settings lower than the default 3 are useful for images with 
large areas of continuous tone that have no appreciable detail (sand, snow, sky) but 
have hard edged foreground subjects such as landscape images, architecture or 
portraiture.
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•  Threshold: This controls the amount of hard edge detail that is enhanced. The de-
fault setting is 25. Decreasing the threshold will focus the algorithms only on edge 
information. This may be useful for portraiture or for reducing noise in your image. 
Settings higher than 25 will increase the amount of small detail in flatter areas of 
the image. Settings as high as 100 are useful for highly detailed images such as hair 
or feathers. Higher threshold settings will also make ON1 Resize process faster. A 
good way to start adjusting these controls is by setting the threshold to 100 and 
then move the amount up until the image is too noisy (bumpy) and then reduce the 
threshold to smooth out the noise in continuous tone areas. For detailed images 
with no little or no continuous tone, you might try the amount at 4 and the thresh-
old at 100. For portrait images or images with significant JPG artifacts you should 
try an amount of 2-3 and threshold of 25 or lower.

•  Smoothness: The smoothness slider is used to reduce artifacts along hard curved 
edges. Use the lowest setting needed.

TIP: Always make sure your zoom is set to 100% or 1:1 when adjusting the controls in 
the Texture Control Pane.

Sharpening pane
The Sharpening pane contains the controls to add additional sharpness to your image.
ON1 Resize features three sharpening methods:

•  Unsharp Mask: Good for general sharpening. Similar to 
Photoshop’s Unsharp Mask function. Resize’s sharpening 
is different in that it is only applied to the luminance of 
the image, to prevent color artifacts.

•  High Pass: High Pass sharpening is helpful when the orig-
inal image is not sharp.

•  Progressive: Similar to Unsharp Mask, except it sharpens 
different amounts depending on the size of the details in the image. Small details 
are enhanced more than large ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharp-
ening before printing and can help compensate for loss of sharpness due to dot gain from 
your printer. Sharpening should only be applied at the end of your workflow just before print-
ing. If you plan to do additional retouching or compositing work after resizing your image, 
you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document 
Size pane controls: 

•  Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset 
located in the Navigator pane.

•  Enable the Sharpening controls by toggling the on/off control in the Sharpening 
pane title bar.

•  Select the sharpening method that will provide the best results for your image. You 
may need to experiment to determine this.

•  Adjust the amount slider to determine the amount of sharpening desired.
•  Use the Highlight and Shadow sliders to limit the sharpening from being applied to 

the darkest and lightest areas of the image which can prevent sharpening of noise.
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Film Grain pane
The Film Grain setting controls the amount of simulated Film 
Grain (noise) to your image. Adding a modest amount of grain 
can make your image appear sharper visually and can help hide 

imperfections (such as JPG artifacts). 
Adding film grain can be especially useful for monochrome images, and should be added 
just before printing. If you need to do other retouching or compositing work in Photoshop or 
Layers after resizing your image, you should disable the Film Grain controls in Resize.

To add Film Grain to your image follow these steps: 
•  Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset 

located in the Navigator pane.
•  Enable the Film Grain controls by toggling the on/off control in the Film Grain pane 

title bar.
•  Adjust the slider up or down until the desired amount of Film Grain is added.
You can preview just the effect of the Film Grain by toggling the on/off control in the 

pane’s title bar. 

Tiling pane
The tiling feature in Resize divides an enlargement into smaller 
pieces so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet 
tall by 12 feet wide, but your printer can only print 24-inch wide 
strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create 
your mural in sections. 

With the tiling feature all you do is specify the size of paper 
you have to print on and if you would like the pages to overlap. Then ON1 Resize will resize 
your image and section it down into the individual tiles.

To use the Tiling pane, follow these instructions:
•  Turn Tiling on by toggling the on/off switch 

in the pane header.
•  Set the Width and Height fields to the size 

and orientation of paper that you wish to 
print on, or you can select the number of 
rows and columns instead.

•  Set the Overlap size. The overlap makes 
each tile overlap so you can tape multiple 
panels together and corrects for printer 
margins if you are not printing borderless.

•  Set the file type for the newly created files 
for each tile.

•  Set the destination folder for the new files. Each file will be named with the original 
filename and the tile indicated in the filename.

The Tiling Preview Overlay.
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The preview will show cyan guide lines for each tile that will be created. The bottom of 
the Tiling pane will tell you how many tiles will be created.

Gallery Wrap
The Gallery Wrap feature is designed to help you print on 
canvas. When making enlargements for canvas it is common 
to wrap a portion of the image around wooden stretcher bars. 
These can be several inches thick and are used for mounting 
the canvas. These are commonly called gallery wraps. However, 
if the photographer had important detail near the edges of the 
image they may be lost in the wrapping process. The Gallery 

Wrap feature in ON1 Resize automatically creates extended margins by reflecting or stretch-
ing the areas near the edge of the image allowing the photographer to create a gallery wrap 
without having to sacrifice any of the original image. The Gallery Wrap feature allows you to 
select the thickness of the canvas mounting bars and offers a variety of techniques for creat-
ing additional margins.

To use the Gallery Wrap feature follow these instructions:
•  Turn on the Gallery Wrap feature by toggling the on/off switch in the pane header.
•  Set the Thickness control to the amount of margins you would like to add. A good 

rule of thumb is the thickness of the stretcher bars, plus half an inch.
•  Select the Type you would like to use.
•  If you wish to add a color overlay to the gallery wrap wings set the color and opac-

ity.

The Gallery Wrap feature has several settings for 
adding margins and adjusting the look of the wrap. 
The Type pop-up has four options:

•  Reflect: Copies an area equal to the thickness 
setting around your image, then flips each 
side and adds it as the margins. This is a good 
general purpose technique.

•  Reflect Soft: Does the same as the Reflect 
method but softens the added margins.

•  Stretch: The Stretch method takes a small 
area around the edge of the image and 
stretches it to add the margins.

•  Stretch Soft: Does the same as stretch, but softens the added margins.
The Thickness slider controls how thick your canvas stretcher bars are. Two inches gener-

ally works well for most gallery wraps.
You can darken the wrap or add a solid color to the wrap area with the Overlay Color and 

Opacity sliders. (The Opacity’s default is 0, which means that there is no color overlay added.)
The Add to New Layer option places the wrap wings on their own layer, rather then merg-

ing them with the image. This only applies when working via Layers or Photoshop in a layered 
workflow.

The Gallery Wrap overlay shows you what your wrap will 
look like with the chosen settings. Here, the Reflect Type 
option is chosen.
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Presets
Resize has a preset system built into it, much like the one used 
by Develop and Effects, but which is designed to help you get 
very specific crops for a wide range of paper and printer types. 
These include settings for photo lab print sizes, and many 
Epson, Canon and HP large-format printers, with Matte, 
Resin Coated, and Canvas types. 

In addition to being able to set document size and settings, 
and settings in any of the other panes, Resize presets always 
contain a Crop adjustment. What that means is that any time 
you apply a preset, Resize selects the Crop tool and places the 
crop overlay on top of your file. There, you can move the over-
lay to the appropriate crop area (or resize the crop) for your 
photo. 

To apply a preset, choose the category you would like 
to use from the Presets panel. The category will expand 
to a list of the available presets for that group. Then, just 
click on the preset you want to apply.

Saving a Preset
Once you have your settings that you wish to save, go to the Preset menu and select Save 
Preset, and choose a category you would like to save it in. If you have applied a preset to 
an image and make adjustments to any of the settings in the left panel, you can update that 
preset with the new setting by choosing Update Preset with Current Settings from the View 
menu.

To delete a preset, right-click on the preset in the Presets Browser and choose Delete 
Preset.

Understanding Resize: How Big Can I Print?
People often ask how large a print can be made with ON1 Resize. If your original image is 
sharp, has good details and little noise, you could go as large as 1000% of the original size. 
1000% is ten times the size of the original file. For example, an original file that is 8” x 10” 
could be resized to 80”x100”. Viewing distance plays a big part of this. Standard viewing 
distances are two-times the diagonal of a print. For example, for an 8”x10” it would be about 
two feet away. An 80”x100” would be about 21 feet. That seems like a lot but that image is 
almost 7’x9’. Keep in mind that many photographers scrutinize their images closer than stan-
dard viewing distances.

Images are perceived in color, tonality and sharpness. Other interpolation techniques 
maintain color and tonality but sacrifice sharpness by “inflating” the image uniformly. The 
image still looks familiar but will not be crisp. Depending on the amount of interpolation, 
this can be severe and noticeable even at standard viewing distances. ON1 Resize maintains 
the color, tonality, and sharpness of an image at all sizes. It will always look the same when 
viewed at the proper distances.

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 
8×10 and an 80×100 created by ON1 Resize. ON1 Resize will maintain the edges which per-
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ceptually make the image sharp, but it cannot create detail where there was none in the past. 
When the shutter is pressed, a finite amount of detail is captured. A good way to think about 
this is to look at an insect on a leaf. If you look at it with a magnifying glass, you will see more 
detail than you did than when looking at it with the naked eye. Now if you take a digital pho-
tograph of that same insect and look at it in the computer and zoom in past 100% you do not 
see any more detail. The information you see is limited by what the camera captured. ON1 
Resize works the same way, it cannot create new detail but instead takes the finite amount of 
detail available and increase it in size.

ON1 Resize isn’t magic. We have all watched CSI, where they take a security photo and 
enlarge the reflection in the victim’s eye to see the killer, with results that look amazing. This 
is science fiction. You cannot create detail where there was none before. But if your original 
file has good detail and little noise, you will be able to make very good looking enlargements 
from your files. This is what ON1 Resize does better than any other software.

How Much Resolution Do I Need? 
To answer this, you need to know two things: 

•  The size of the print you need to make.
•  The resolution that your printer needs for best results.
The size of the print is as large you would like. This may be limited by the size of your 

printer. Resolution is the density of the pixels for a given distance, usually measured in pix-
els or dots per inch. Most modern inkjet printers print anywhere from 1200 to 4800 dots per 
inch (what the printer manufacturers really mean is 1200-4800 droplets of ink per inch). Inkjet 
printers use many tiny round droplets of 4-12 ink colors to reproduce one square pixel in your 
image that could be one of any millions of colors. A common mistake is to set the resolution 
of the file to the resolution of the printer. In all but a few special printers this will lead to huge 
files that will not print well, if at all. The secret is that the human eye cannot see more than 
250-300 pixels per inch. So the ideal resolution for your files should be close to this. Once 
you know the print size and resolution, it is easy to use ON1 Resize to resize your file to the 
desired output. Simply input the resolution and then either the print width or height. You’ll 
see that the corresponding dimension is automatically filled in by ON1 Resize based on the 
proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors and 
paper can all be different. For example, most digital camera sensors are proportioned so that 
the height is two-thirds the width or 1:1.5; While the most common paper size, in the US, is 
the letter which is 8.5×11 inches or about 1:1.25. These kind of proportion mis-matches are 
common and require that the original image be cropped to fit the proportions of the paper 
size. If your image cannot be cropped without ruining the composition then you will need to 
adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This 
process is called interpolation or resampling. There are many mathematical ways, called 
algorithms, to do this. The most common method used by many pixel editing applications 
is called bicubic interpolation. Bicubic along with its newer variants bicubic smoother and 
bicubic sharper work by averaging a small group of neighboring pixels to determine the color 
value of the new pixels to be added. While this technique is fast, it does not distinguish edg-
es so there is a uniform loss of sharpness and detail across the image.
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Resize’s patented scaling algorithm is fundamentally different from bicubic or other inter-
polation methods. While other methods sample nearby pixels and decide new pixel values 
one by one, ON1 Resize uses a sampling technique called Fractal Scaling.  Fractal Scaling 
samples nearby “blocks,” square groups of pixels, and varying sizes, compares them to 
smaller versions of the original image and mosaics these patches together to create a larger 
version of the original. By doing this repeatedly, often the characteristics of the image like 
edges, smooth areas, and textures are reinforced for each larger version. Noise is de-empha-
sized and sharp details are maintained. All this number crunching may take a bit longer than 
the single pass interpolation methods like bicubic, but good things come to those who wait 
and the reward is far superior results.



ON1 Photo RAW 2017 User Guide	 Part 5: ON1 Resize	 103

Resize Menus

ON1 Photo RAW (Mac OS Only)
About ON1 Photo Raw: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)
Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)
Quit ON1 Photo RAW: Quits ON1 Photo RAW.

File Menu
Done: Saves the current image and returns to Browse (or exter-
nal source).
Cancel: Cancels any Resize operations and returns to Browse 
(or external source).
Export: Calls up the Export pane.
Print: Opens up the print dialog box.

Edit Menu
Undo: Removes the last file operation.
Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.
Cut: Cuts the currently selected item. 
Copy: Copies the currently selected item.
Paste: Pastes (copies) the items in the clipboard to the current 
location.
Reset All: Resets all of the settings.
Preferences (Windows): Opens the Preferences dialog.

Preset Menu
Save Preset: Saves the current Resize settings as a preset.
Delete Preset: Deletes the currently selected preset.
Edit Preset: Lets you rename a preset, choose a different cate-
gory for it, and add metadata information (creator, description). 
Update Preset with Current Settings: If an image with a preset 
applied has had some settings changed, this lets you update 
the preset to reflect those new settings.
Import Preset: Imports ON1 preset (.onp) files.
Show Presets: Opens the Presets folder on your computer.
Manage Extras: Opens the Extras Manager window.
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View Menu
Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.
Zoom Out: Zooms the preview window out one increment. This 
will make the preview images smaller.
Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.
Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you to 
see every pixel in the image. This is useful when making preci-
sion adjustments.
Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.
Preview Background Color: Lets you set the background color 
options.

Window
Minimize: Minimizes your screen.
Zoom: Zooms your window to full-size (doesn’t hide menu bar). 
Full Screen: Toggles to and from full-screen mode (hides menu 
bar).
Navigator/Loupe/Histogram: Hides or shows the Navigator, 
Loupe, Histogram and Info pane.
Pixel Dimensions: Opens or closes the Pixel Dimensions pane.
Document Size: Opens or closes the Document Size pane.
Settings: Opens or closes the Settings pane.
Sharpening: Opens or closes the Sharpening pane.
Film Grain: Opens or closes the Film Grain pane.
Tiling: Opens or closes the Tiling pane.
Gallery Wrap: Opens or closes the Gallery Wrap pane.
Solo Mode: When enabled, this feature keeps only one control 
pane open at a time.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Document Name: Shows the name, zoom level and bit depth 
of the open image.
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Help
Search: Searches the menu options (Mac OS only).
ON1 Photo Raw Online Help: Opens ON1.com support page 
in your default web browser.
Video Tutorials: Opens ON1.com product training page in your 
default web browser.
Welcome to ON1 Photo RAW 2017: Displays the Welcome 
window.
Check for Updates: Checks with the ON1 update server to see 
if you are running the current version. If there is a newer ver-
sion, you will be notified and be walked through the update 
process.
Sign-In: Uses your ON1 account login information to authenti-
cate your copy of ON1 Photo RAW 2017. (Sign-out will remove 
an existing authentication.)
Provide Feedback: Opens the default web browser and navi-
gates to the feedback page of the ON1 website.
About ON1 Photo Raw (Windows Only): Opens the about box 
with the version number and license code displayed.
Help Improve ON1 Products: Opens the Improve ON1 Prod-
ucts dialog.
Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Photo RAW 2017.
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Action Mac OS Windows
Print  Command P  Control P

Undo  Command Z  Control Z

Redo  Command Shift Z  Control Shift Z

Cut  Command X  Control X

Copy  Command C  Control C

Paste  Command V  Control V

Save Preset  Command Shift S  Control Shift S

Open Selected Category  Right Arrow  Right Arrow

Close Selected Category  Left Arrow  Left Arrow

Zoom In  Command +  Control +

Zoom Out  Command –  Control-

Fit to Screen  Command 0  Command 0

Actual Pixels  Command Option 0  Control Alt 0

Show Clipping  Option J  Alt J

Navigator/Loupe/Histogram  Command 1  Control 1

Pixel Dimensions  Command 2  Control 2

Document Size  Command 3  Control 3

Settings  Command 4  Control 4

Sharpening  Command 5  Control 5

Film Grain  Command 6  Control 6

Tiling  Command 7  Control 7

Gallery Wrap  Command 8  Control 8

Show Browser Panel  Command Left Arrow  Control Left Arrow

Show Control Panel  Command Right Arrow  Control Right Arrow

Full Screen Mode  Command Control F  F11

Hand Tool  H  H

Zoom Tool  Z  Z

Crop Tool  C  C

Temporarily Select Hand tool  Hold Spacebar  Hold Spacebar

Rotate Crop Clockwise  Option Right Arrow  Alt Right Arrow

Rotate Crop Counter Clockwise  Option Left Arrow  Alt Left Arrow

Slow Nudge (selection)  Arrow keys  Arrow keys

Fast Nudge (selection)  Shift Arrow keys  Shift Arrow keys

Resize Keyboard Shortcuts
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Part 6: ON1 Export
Export is a special panel that is available throughout ON1 Photo 
RAW 2017. It the engine for the export process, whether you’re 
exporting final files from within Browse, Develop or Effects, 
or from within Resize. The Export pane gives you much of the 
power of Resize in a quick and easy to use panel, letting you 
export your photos with incredible flexibility, ease and control.

The Export pane is always available, from any module, as 
long as you have a photo selected (you can also batch export 
files selected as a group in Browse). 

To open the panel, click on the Export icon in the lower right 
corner of the main Photo RAW window, or can choose Export 

from the File menu. Once selected, the Export panel 
opens on the right side of the Photo RAW window, 
letting you select a group of options as you prepare 

to export a photo. By default, the panel includes three panes, 
which are fairly straightforward in their operation: File Type, Lo-
cation, and File Names. These are the minimum options needed 
to export a file, but you can also add the following panes to the 
panel, expanding your export controls: Photo Size, Watermark, 
Sharpening, Tiling and Gallery Wrap. 

File Type 
The File Type lets you choose what format you want your photo 
to be exported as, along with a color profile that you wish to 
assign to the exported file. The type options are Photoshop, 
Photoshop Large Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 
being the highest.

Location
Click the Choose button to select a location, or click on the 
Save To pop-up for more options, including:

•  Current Location will write the file to the same location 
as the original file.

•  Roundtrip (this option is only available exporting through 
Adobe Lightroom) saves the file over the original and 
uses the same format, bit-depth, color space and name.

With regard to the other options in this pane, If Prevent Over-
write is selected the word ‘copy’ will be added to the file(s); 
otherwise it will overwrite your original image if the destination is set to Current Location. 
You can also have Photo RAW open the folder you exported your image to by choosing the  
Show in Finder (Mac OS) or Show in Explorer (Windows) option from the After Export menu.  

The Export panel lets you make simple 
exports, just by choosing an export file 
type, a location and a name, but you 
can also perform enlargements (using 
Resize’s Genuine Fractals engine), add 
gallery wraps and watermarks, tiling and 
more.
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File Names
This option may be used to rename the file name. The options include: Current Name, Text 
and Number.  The field to the right allows you to enter a custom name. The plus and minus 
icons will allow you to add or remove naming elements.  Current Name will use the source 
name without the file extension. Text is used for assigning a custom text string.  Number cre-
ates an automatically incremented number, starting with the number input in the field. Reset 
will clear all current settings.

Photo Size
The Photo Size pane displays the original image size when you 
first open it. You can simply type into the Width or Height fields 
to change the document size, or you can choose from a variety 
of preset sizes by clicking on the pop-up menu underneath the 
Resize To pop-up.

NOTE: Export does not offer any options for cropping, and if you choose an aspect 
ratio that is different from that of your photo, on export, your photo will be cropped 
from the center point out to meet the new ratio. If you wish to crop to a different 
ratio, it is better to use Resize.

Keep in mind that the Width and Height fields are locked together to maintain the pho-
tos proportions. Changing the width will change the height proportionally. Export does not 
support non-proportional scaling. If you would like to change the proportions of the image it 
requires cropping.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want 
to lock one edge to a specific length or width and don’t care about the sizing of the other 
edge. Simply choose which option is the important one for your photo, enter the dimensions, 
and Export will resize your photo accordingly.

The units of measurement can be switched by clicking the down arrow. You also control 
your resolution in pixels per inch. Use this setting to optimize for your output device.

The Photo Size Presets make it easy to set the width/height of your image in a preset size. 
Use the drop down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:
•  General (ON1 Resize) uses the ON1 Resize algorithm also known as Genuine Frac-

tals: This is the classic, patented, fractal-based algorithm that has made Perfect 
Resize the standard for over a decade.

•  Low-Res JPG for enlarging low resolution JPEGs (this setting use the bicubic algo-
rithm method).

•  Portrait for resizing portraits protects skin tones from artifacts (uses bicubic algo-
rithm method).

•  Landscape is great for Landscape photos (uses ON1 Resize algorithm).
•  High Detail is great for images with many small items (uses ON1 Resize algorithm).
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Watermark
The Watermark module allows you to add an overlay to the 
image, most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD. 

The module has the following options:
Choose:  Click the Choose button to select the file you wish to 
use as your watermark.
Size:  This slider controls the size of the watermark file.
Inset:  This will determine the percentage in which the file is 
inset from the edge.
Opacity:  This sets the opacity of the watermark.
Location:  This grid sets the location of the watermark.  Click on 
the square of the location you desire.
 

Sharpening
The Sharpening pane adds additional sharpness to your im-
age, and are designed to be general options for either screen 
or print work. Using the Sharpening controls can save you the 
workflow step of adding additional sharpening before printing 
and can help compensate for loss of sharpness due to dot gain 
from your printer. Sharpening should only be applied at the end 
of your workflow just before printing. If you plan to do addition-
al retouching or compositing work after resizing your image, 
you should disable the sharpening controls.

Tiling
The tiling feature in Export divides an enlargement into smaller pieces so that the image can 
be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet 
tall by 12 feet wide, but your printer can only print 24-inch wide 
strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create 
your mural in sections. 

With the tiling feature all you do is specify the size of paper 
you have to print on and if you would like the pages to overlap. 
Then Export will resize your image and section it down into the 
individual tiles. 

To use the Tiling pane, follow these instructions:
•  Set the Width/Height fields to the size and orientation of 
paper you wish to print on, or select the number of rows and 
columns instead.
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•  Set the Overlap size. The overlap makes each tile overlap so you can tape multiple 
panels together and corrects for printer margins if you are not printing borderless.

The preview will show cyan guide lines for each tile that will be created. 

Gallery Wrap
The Gallery Wrap feature is designed to help you print on 
canvas. When making enlargements for canvas it is common 
to wrap a portion of the image around wooden stretcher bars. 
These are used for mounting the canvas. These are commonly 
called gallery wraps. However, if the photo has important detail 
near the edges of the image they may be lost in the wrapping 
process. The Gallery Wrap feature in ON1 Resize automatically 
creates extended margins by reflecting or stretching the areas 
near the edge of the image allowing the photographer to cre-
ate a gallery wrap without having to sacrifice any of the original 
image. The Gallery Wrap feature allows you to select the thick-
ness of the canvas mounting bars and offers a variety of tech-
niques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:
•  Set the Thickness control to the amount of margins you would like to add. A good 

rule of thumb is the thickness of the stretcher bars, plus half an inch.
•  Select the Type you would like to use.
•  If you wish to add an overlay to the wrap wings, set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of 
the wrap. The Type pop-up has four options:

•  Reflect: Copies an area equal to the thickness setting around your image, then flips 
each side and adds it as the margins. This is a good general purpose technique.

•  Reflect Soft: Does the same as the Reflect method but softens the added margins.
•  Stretch: The Stretch method takes a small area around the edge of the image and 

stretches it to add the margins.
•  Stretch Soft: Does the same as stretch, but softens the added margins.
The Thickness slider controls how thick your canvas stretcher bars are. Two inches gener-

ally works well for most gallery wraps.
You can also darken the wrap or add a solid color to the wrap area with the Overlay Color 

add Opacity sliders.

Export Presets
Presets remember all of the settings and details selected in the Export window pane. To save 
a group of settings as a preset, click the Save Preset button at the bottom of the panel. Give 
the preset a name, and it will appear in the Presets pop-up at the top of the Export panel.

NOTE: Unlike presets in other parts of ON1 Photo RAW, you can’t export or import 
presets from the Export panel.
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Part 7: ON1 Layers
Layers provides you with an easy-to-use workspace for editing your photos using a full-fea-
tured layered workflow. Because it is designed to be a compositing tool, it is important to 
note that Layers generally is a destructive environment, unlike the Browse-Develop-Effects 
workflow. You can use Layers’ Smart Layers feature to re-edit a layer in Develop or Effects, 
however.

The Layers Workspace
Layers has a built-in file browser, a robust set of selection and transformation tools, all in a 
layered environment. The Browser panel is on the left side, the Preview window in the center, 
and the Layers panel on the right.
A. Browser Section: This where you browse and select your images to open.
B. Tool Well: This is where the tools are located.
C. Preferences/Help: Accesses ON1 Help menu or ON1 Photo RAW Preferences.
D. Tool Options Bar: This strip above the preview window contains the options for the selected tool.
E. Preview Window: This is the main section where you preview and work on images.
F. Navigator, Loupe Histogram and Info Pane.
G. Layers Pane: This is where you control the layer order and apply blending modes.
H. Close & Save Buttons: This is one way to save or close the current image.
I. Module Selector: Switches between ON1 Photo RAW’s modules.
J. Export/Sharing: Opens the Export panel/shows photo sharing options.
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Layers Tools
There are sixteen different tools in the Layers tool well.

Move Tool	 Moves and changes the size and rotation of your layer.
Crop Tool	 Crops your image.
Trim Tool	 Trims a single layer.
Mask Brush	 Masks areas using brush strokes to expose underlying layers.
Quick Mask	 Masks out large similar areas quickly.
Masking Bug	 Masks areas using gradients to expose underlying layers.
Line Mask	 This tool is for creating linear masks.
Refine Brush	 Refines the mask to cleanly mask difficult areas like hair.
Chisel Mask	 Moves the edge of the mask slightly to remove fringes.
Blur Mask	 Softens the mask slightly to blend more naturally.
Perfect Eraser	 Removes unwanted objects with this content-aware brush.
Retouch	 Removes small imperfections.
Clone Stamp	 Paints over an area from a sample of another area.
Red Eye	 Reduces red eye.
Hand Tool	 Repositions your image within the preview window.
Zoom Tool	 Changes the magnification in the preview window.

Navigating the Preview
The Preview Window above is the main section where you preview and work on images. Re-
size includes two tools for navigating this window, the Zoom and Hand tools.

Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the pre-
view zoom is larger than the viewable area.

To pan (scroll) in the Preview window:
•  Select the Hand Tool and drag the image until you locate the area you wish to view.
•  With any other tool selected, hold down the spacebar while you drag the image in 

the window.
•  Double-click the Hand tool in the tool well to set the image to a magnification that 

fits completely in the current window size.

Zoom Tool 
The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:

•  Click in the Preview window to zoom in, centering at the location clicked.
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•  Click and drag in the Preview window to draw a rectangular, the screen fills with the 
area within the rectangle when you release the mouse.

•  Hold the Option key (Mac) or Alt key (Win) and click to zoom out.
•  Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnifi-

cation, showing every pixel. This is best when examining small details.

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window are the Navigator, Loupe, 
Histogram, and Info panes. These four panes can be useful for inspecting and viewing details 
in your image.

The Navigator Pane
This gives you a birds-eye view of your image. The white square region marks the image area 
that is visible in the preview pane. You can pan your image by clicking and dragging inside 

the white region.

At the bottom of the Navigator pane are several Zoom presets. 
Click on a Zoom preset to activate.
•  Fit: Zooms to fit the current canvas size.
•  100: Zooms to 100% or actual pixels.
•  50: Zooms to 50%
•  25: Zooms to 25%
 

The Loupe Pane
This gives you a magnified view of the section of the preview 
under the cursor. This allows you to view the quality of your 
results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting 
the zoom level.

 

The Histogram Pane
This gives you a color chart of the shadow, mid-tone and highlight areas based on the image 
RGB values. This is useful to show areas within the image that may be clipping. Clipping is 

when your image contains pure blacks or white and can signify 
loss of highlight or shadow detail. 

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is a 
triangle. If the triangle is lit, there is clipping on that side of the 
histogram. If you click on the arrows, you will activate the clip-
ping overlay on your image. The areas of your image with a blue 
overlay are pure black, while the areas with the red overlay are 
pure white. You can turn the clipping view off again by clicking 
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on one of the triangles. You can also temporarily enable clipping view by holding down the 
J key at any time. The clipping view is useful when you are making adjusts to the brightness 
and contrast of your image. 

The Histogram pane also displays the RGB values under the cursor at the bottom of the 
pane.

The Info Pane
The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get 
the GPS cordinates for where the image was taken. This feature only works if you have GPS 
enabled on your camera or mobile device. Otherwise you will not see the GPS button.



ON1 Photo RAW 2017 User Guide	 Part 7: ON1 Layers	 115

Using the File Browser
Built into Layers is a file browser, located in the left panel. You 
can use it to browse your images as well as content you down-
load from the ON1 website. Below is a description of the con-
trols in the file browser.

Layers Browser Panel Overview
A. Browser Tabs: This switches between the Files tab and the Extras 
tab. The Extras tab displays the included backgrounds, borders and 
textures.
B. Folder Tree: This drop-down menu displays the folder path of the 
folder you are browsing. You can use this to quickly navigate up the 
folder tree. The current selected root folder is displayed here as well.
C. Search Field: Use the search field to locate files in the current 
sub-folder.
D. Image Thumbnails: Images are displayed as thumbnails and will 
have the filename and extension listed below it.

Browsing a Folder
You can select which folder to browse by selecting a folder in 
the drop down menu under Files. The last folder you browsed 
will be remembered and displayed automatically.

Navigating the Browser
To open a sub-folder, click on it. To close it, click on it again. 
Only one top-level folder can be open at a time.

Double-clicking on a folder sets it to the root folder and its name will appear in the folder 
tree drop-down.

The selected item, either a folder or file, will have a blue box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close folders using the Command (Mac OS) or Control (Windows) up and 

down arrows.
You can select multiple files by holding down the Shift key.

Opening Files from the Browser
You can open an image in the browser by double-clicking it. If you already have an image 
open you will be prompted to either merge the selected file as a new layer or to open it as a 
new file. If you have multiple images selected, you can open them as layers using the Open 
Selected from Browser command in the File menu.

Searching for Files
To search for files in the currently selected folder, type in the name of the file in the search 
field. The search results appear in a new sub-folder called search results, which will be select-
ed automatically. You can clear the search field by pressing the “x” at the right side of the 
search field.

The Browser Panel.
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Resizing and Closing the Browser
The browser can be resized by dragging the right side margin of the browser.
The browser can be closed or reopened by clicking on the arrows in the bottom corners 
or using the cmd (control on Windows) left and right arrow keys. You can also change the 
browser view by using the View > Browser, and choosing one, two or three column thumbnail 
views.

Extras Tab
The Extras tab displays add-on content including backgrounds, borders and textures.
When you download content packs from the ON1 website they are automatically installed in 
the Extras tab.

Creating a New File and Adding Layers
•  You can create a new file in several ways. 
•  Merge one or more images together using the Add Layer from File command.
•  Merge one or more images together using the Lightroom or Aperture plug-ins or 

external editor option.
•  Dragging one or more images onto the ON1 Photo RAW application icon in the 

dock (Mac OS) or task bar (Windows).
•  Create a new, empty file from the File > New menu. The New Image dialog is 

presented, see the image to the right. From the New Image dialog, you have the 
following options:

When creating a new file, you have the following op-
tions to choose from: 
Name: The name of the image.
Preset: Lists a range of preset image dimensions for 
common print sizes.
Width: Sets the width, in inches, cm or pixels.
Height: Sets the height, in inches, cm or pixels.
Swap Dimensions button: Pressing this button will 
swap the current width and height.
Resolution: Sets the resolution in pixels/inch (or cm). 
Color Space: Sets the RGB color space (ICC profile) of 
the image. (The default is set based in Preferences.) 

Bit Depth: Sets the bit depth, 8-bit or 16-bit.

Adding Layers from Files	
You may add images (flat or layered) as layers into an open file by:

•  Using the Add Layer from File command from the File menu.
•  Opening a file from the Browser or the Browse module and choosing the Add as a 

layer option.
 
Working with Tabs	
Each photo you open in Layers is contained in its own tab. The tabs for each photo appears 
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at the top of the interface. Close a tab by clicking on the “X” icon.
To combine two tabs in to one, Choose Layer > Copy Layer in the first tab. Click to switch 

to the second tab and choose Layer > Paste Layer. Then close the first tab.

Canvas Size
The canvas size, or image size is the aperture through which you view the layers. An image 
may have layers that are larger than the canvas size and are partially hidden by the canvas 
size aperture.

•  When creating a new empty file from the File > New dialog, an arbitrary size is set 
by you. When creating a new image, you have the option to set the resolution.

•  When creating a new PSD file by merging other files together using the Add Layer 
from File command, the source image that has the largest pixel dimensions will be-
come the bottom most layer and will set the canvas size. The canvas size is adjust-
able by the user.

•  When opening an existing PSD file, the canvas size is already set. The canvas size is 
adjustable by the user by accessing the Canvas Size dialog from the Edit menu.

Layer image data outside the canvas area is maintained.

Adjusting the Canvas Size
In the top section, current size, displays the current canvas size 
and is non-editable. Below the Current Size is the New Size 
section. It displays the current width and height and is editable. 

The canvas size dialog does not interpolate (resize all the 
layers at the same time). This is the same as the image size dia-
log box in Photoshop when the resize image option is disabled.

There is a lock proportions toggle that locks the width and 
height proportions together. Adjusting the width will change 
the height proportionally. This option is on by default.

The Set To pop-up lets you set the size to the current layer, all layers or custom.
If you select the current layer option, the width and height are set to the size of the cur-

rently selected layer(s). If the user selects all layers, the width and height are set to the union 
of all the layers, making all the pixels on all layers visible in the canvas. 

The Layers Pane
Layers are listed in the Layers Pane, along with the controls to adjust them.

Layer Visibility
You may change the visibility of a layer (hide it) by clicking 
the eye icon to the left of the layer thumbnail, which hides 
the layer without deleting it. You can hide all layers except 
the current layer by holding the Option (Mac OS) or Alt 
(Windows) key when clicking on the eye icon. This is useful 
for viewing the bottom most layer, which in some cases is 
the original image. This acts like a before and after preview.
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Changing the Layer Order
You may change the order of layers by dragging and dropping layers into the order you pre-
fer. You may select multiple layers at the same time by holding down the Command (Mac OS) 
or Control (Windows) key while clicking.

Renaming Layers
You can rename a layer by double-clicking on it. The name turns into an editable field. Type 
in your preferred name and press Enter. When merging files together the layer name is the 
name of the source image. This is a useful verification of the source image.

Deleting a Layer
You may delete a layer by selecting the layer, then pressing the Delete button . You may also 
use the Delete key on your keyboard or right click on the layer and choose Delete from the 
pop-up menu.

Duplicating a Layer
You may duplicate or copy the current layer by pressing the Copy button . You may also use 
the Command-J (Mac OS) or Control-J (Windows) keyboard shortcut or right click on lay-
er>delete.

Merging Layers
You may merge layers by selecting them and then pressing the Merge button . You may also 
use the Command-E (Mac OS) or Control-E (Windows) keyboard shortcut or right-click on the 
layers and choose Merge Layers from the pop-up menu.

Creating Color Fill Layers
Color Fill Layers are new layers filled with a solid color. They are useful for altering the color 
and tone of the image. To create a Color Fill Layer, press the Paint Bucket icon at the bottom 
of the Layer stack, or right-click on a layer and choose New Color Fill Layer from the pop-up 
menu.

Convert to a Smart Layer
You can convert any layer into a Smart Layer, making the photo a Smart Photo. This allows 
you to re-edit any settings you add to a layer in modules like Effects.

NOTE: For more about Smart Photos, their uses and limitations, see Page 7.

Changing Blending Modes
Blending modes determine how the selected layer blend with the layer(s) below it. The de-
fault blending mode is Normal. This maintains the full opacity of the upper layer. Layers also 
supports many other blending modes which can be used to alter the brightness, contrast and 
color of the image by combining either a copy of the underlying layer or a Color Fill Layer.

Changing Opacity
The opacity slider controls how opaque or how strong the selected layer is. The default is 
100%. At lower settings, the layer will blend with the layer(s) under it. Altering the blending 
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mode and opacity of a layer can create a wide range of color and tone effects.

Layer Masks
If you use any of the masking tools, a layer mask will be created automatically. A layer mask 
appears as white thumbnail next to the layer icon. There is no need to select the layer mask 
to work on it, invert it or reset it. Think of it as always selected with the layer. You can also 
copy and paste Layer Masks from the Layers menu or by dragging and dropping them from 
layer to layer.

Using Color Fill Layers
Color Fill Layers provide fast, re-editable ways to alter the brightness, contrast and color of 
your image. Color Fill Layers leverage the power of layers, blending modes and opacity. Col-
or Fill Layers are simply layers filled with a solid color. However by changing the color, blend-
ing mode and opacity along with ON1 Layer’s masking tools you can do the following:

•  Create a burn or dodge layer to selectively lighten or darken the image.
•  Convert the image to black and white.
•  Tint the image any color.
•  Add a vignette.
•  Simulate photographic filters like warming and cooling.
•  Create darkroom looks like sepia toner.

Creating Color Fill Layer
To create a Color Fill layer, press the Fill (Paint Bucket) button in the Layers pane. The Color 
Fill Layer dialog will appear. With this dialog you can select a preset or manually adjust the 
color, blending mode and opacity of the Color Fill layer:

•  Preset: This pop-up list contains presets for many com-
mon filter effects. Select a preset from the menu to 
preview it on your image.

•  Fill Color: This displays the current color. You may press 
the color box to open a color picker dialog. Selecting 
new colors in the color well will be previewed in real-
time on the image.

•  Blending Mode: This option sets the blending mode for the layer.  You can always 
change this later from the Layers pane.

•  Opacity: This slider sets the opacity for the layer. You can think of this as a strength 
slider for the effect. You can always change this later from the Layers pane.

Editing a Color Fill Layer
You can edit Color Fill layer by using the Edit Color Fill Layer option from the Layers menu. It 
will reopen the Color Fill Layer dialog where you can adjust the settings. Color Fill layers work 
similar to a regular layer. You can move, resize, rotate, trim, delete and duplicate them.

Masking a Color Fill Layer
You can mask, or selectively apply a Color Fill layer using any of the masking tools in Layers, 
similar to any other layer. To learn how to mask a layer, see the Masking Layers section.

Add Color Fill Layer dialog box
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Transform Tool
Use the Transform Tool at the top of the tool well to manipulate layers. A layer may be re-
positioned, sized or rotated using the Transform Tool. When the Transform Tool is selected, 
transform handles will appear on the edges of the selected layer. You use these transform 
handles to manipulate the image. You can only transform one layer at a time.

Repositioning a Layer
To reposition a layer, simply click and drag inside the transform box. You can also use the key-
board arrow keys to nudge a layer one pixel in any direction.

Resizing a Layer
To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle 
allows you to adjust two sides simultaneously. Clicking on a side handle allows you to adjust 
that side. If you hold the shift key down while adjusting the size, the proportions of the layer 
are maintained. If you hold down the option (Mac OS X) or alt (Windows) key while resizing 
your image will resize from the center instead of from the edge. You can hold down both the 
shift and option or alt simultaneously to resize, proportionally from the center.
You can type in the size you desire in the Tool Options Bar (see below) in the width and 
height fields. You can also size a layer to fill the canvas automatically by pressing the Fill but-
ton in the Inspector.

Transform Tool Options Bar

Rotating a Layer
To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice 
that the tool cursor changes to a rotate cursor. Now click and drag to rotate the layer. You 
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can also use the opt (alt) left and right arrow keys to rotate a layer when the transform tool is 
selected. To rotate the layer quickly in 90 degree increments, you can use the rotate left and 
rotate right buttons in the Tool Options Bar.

Flipping a Layer
You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool 
Options Bar.

When you have completed your transforms you need to commit the changes. You can do this 
by pressing the Apply button that appears in the Tool Options Bar or by pressing the Enter 
key. You can cancel a transform by pressing the Cancel button in the Tool Options Bar or by 
pressing the Escape key.

Crop Tool
This tool is used to crop and resize the entire image. The crop tool removes any pixels out-
side a crop box and changes the canvas size at the same time.

To crop the image, select the Crop Tool from the tool well. Then adjust the corner handles 
of the crop tool overlay. The area outside the crop box appears darkened for guidance. You 
can resize and move the image inside the crop box. When you are satisfied with your set-
tings, press the Apply button in the Tool Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also 
nudge the image using the arrow keys on your keyboard.

To resize the Crop Box, click and drag on any of the resize handles. Clicking on a corner 
handle allows you to adjust two sides at the same time. Clicking on a side handle allows you 
to adjust that side. If you hold the shift key down while adjusting the size, the proportions of 
the box are maintained. To rotate the crop box, move outside a corner until the tool changes 
to rotate. You can also set the aspect ratio or size of the crop box in the tool options bar.

NOTE: The Crop tool is not available when using a Smart Photo.

Crop Tool Options bar:

Preset pop-up: Controls the crop tool mode.
Width: Sets the width of the crop box.
Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
Height: Sets the height of the crop box.
Units: Determines the unit of measure: Pixels, inches, centimeters, etc.
Leveling Tool: Click and drag this tool across an element in your image that should be level.
Angle: See and adjust the angle of rotation.
Rotate: Rotates the image 90 degrees.
Cancel: Resets the crop tool.
Apply: Applies the crop and resizes your photo.
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Crop Tool Modes
The Crop Tool works in three modes, freeform, to the aspect ratio of 
your photo, or to specific document sizes.

•  Freeform: This is the default setting; it lets you resize the crop 
box to any orientation or size you prefer.

•  Aspect Ratio: You can lock the crop box to an aspect ratio. This 
makes sure the crop box shape doesn’t change, just the size. Use 
this option to trim existing pixels while maintaining a ratio without 
resizing the image.

•  Document Size Presets: Document Size Presets allow you to crop 
and resize your image at the same time. If you know your intent 
is to print the image at a certain size you can crop and resize the 
image at the same time. Many common sizes are included plus 
you can create your own.

The Crop Tool also has a special Leveling Tool for straightening your 
photos:

•  Select the Crop Tool. 
•  Select the Leveling Tool from the Crop Tool Options bar. Your cursor will change to 

the Leveling Tool. 
•  Click and drag a line across your image that should be level, either horizontally or 

vertically. 
•  When you release the mouse the image will be adjusted automatically to the cor-

rect angle.

Trim Tool
The Trim tool is used to trim or crop a layer. It removes any pixels outside of a crop-style box 
for the current layer.

To trim a layer, select the Trim tool from the tool well. It looks like a pair of scissors. Then 
drag a box over the area you wish to keep on the selected layer. The area outside the trim 

box appears darkened for guidance. You can resize and move the trim box. When 
you are satisfied with your settings, press the Apply button in the Tool Options bar.

To move the Trim Box simply click and drag inside the box. You can also nudge 
the box using the arrow keys on your keyboard.

To resize the Trim Box, click and drag on any of the resize handles. Clicking on a corner 
handle allows you to adjust two sides simultaneously. Clicking on a side handle allows you to 
adjust that side. If you hold the Shift key down while adjusting the size, the proportions of the 
box are maintained. You cannot rotate a Trim Box. You can manually enter the size of the trim 
box in pixels using the width and height fields in the Tool Options bar (see below).

When you have completed your adjustments, click the Apply button that appears in the 
Tool Options bar or by pressing the Enter key. You can cancel a transform by pressing the 
Cancel button in the Tool Options bar or by pressing the Escape key.

The Crop Tool can crop 
to one of three modes: 
freeform, to a specific ratio, 
or to specific paper sizes.
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Trim Tool Options bar
Width: Shows current pixels of the trim area width.
Height: Shows the current pixels of the trim area height.
 
Perfect Eraser
The Perfect Eraser can be used to remove distracting elements and blemishes from your 
image. It uses a content-aware algorithm that replaces the pixels with a natural-looking result 
within the boundaries that are painted.

Using the tool is easy: click on it in the tool well, and paint over the area you wish to 
remove. Make sure you cover the entire area. A red overlay appears where you paint. If the 
first attempt does not give you a perfect result, simply paint over it again and it will improve 
with each pass. You can also fine tune the area after applying the Perfect Eraser by using the 
Retouch Brush (see below).

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or 
smaller by clicking on the Brush Size in the Tool Options bar, or by pressing the right or left 
bracket keys on your keyboard. The maximum brush size is 500 pixels.

If you have a Wacom pressure-sensitive tablet, select the Pressure Adjusts Size button in 
the Tool Options bar.

Retouch Brush
Use the Retouch Brush to remove small imperfections like dust or blemishes.

Just dab the brush on areas that contain spots or other imperfections, such as acne, sen-
sor dust, power lines and more. The tool looks at the neighboring areas in your image and 
fills in the brushed area with an area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than mak-
ing large brush strokes. If you dab with the Retouch Brush and don’t like the results, use the 
Undo command and try using a smaller brush or vary your brush stroke and try again. The 
Retouch Brush is also great for retouching skin.

Retouch Brush Options bar:
Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.
Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.
Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click on the button to activate the Wacom sensitivity 
controls.

Clone Stamp
Use the Clone Stamp tool for replacing an area of the image with a sample area from a dif-
ferent part of the image. Hold down the Option (Mac OS) or Alt key (Windows) and click the 



ON1 Photo RAW 2017 User Guide	 Part 7: ON1 Layers	 124

area you want to clone from. Then click and drag on the area you want to clone over and it 
will clone from the point you selected.

Clone Stamp Tool Options bar:
Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.
Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.
Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.
 
Red-Eye Tool
The Red-Eye Tool is the perfect tool for eliminating or reducing red eye in your images. It’s a 
simple one-click stamp that will immediately take care of red eye.

You start by selecting the brush in the tool well. Adjust your brush size to be as close to 
the same size as the red eye effect you are wanting to remove. Then place the brush right 
over the eye and click once to remove.

Red Eye Tool Options bar
Size: Controls the size of the brush
Protect Skin: Protects from the effect leaking out to skin or flesh tones

Masking Brush
The Masking Brush is one of four tools in ON1 Layers designed to 
help layer masks. Layer masks by default are filled with white or 
black. If the mask is white,  When you select the Masking Brush, 
your tool icon changes to a circle that represents the size of the 
brush. It may also appear as two concentric circles, indicating the 
inner hard edge and outer soft edge of the brush if the feather 
control is set above zero. There is also either a plus or minus in 
the center of the brush. Minus means the brush mode is set to 
paint-out, plus means it is set to paint-in.	  

To use the Masking Brush, select it in the tool well. Make sure 
you are on the effect you wish to hide. Then check your brush 
mode and confirm it is set to Paint Out. You are ready to mask 
now, simply paint on the image in the areas you wish to hide. As 
you brush, you will see the underlying layers appear. If you make 
a mistake while brushing there are two options to correct them: 
use the Undo command from the Edit menu, which  will undo 
the last brush stroke you created, or toggle the paint mode to Paint In and brush over your 
mistake.

The Masking Brush consists of two 
concentric circles, representing the 
hardness of the brush (inner circle) 
and the soft feathered edge (outer 

circle).
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Masking Brush Tool Options bar
Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are 
painting-in.  You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.
Invert Mask: Invert swaps the hidden areas for the visible areas. What was hidden is now 
revealed and vice-versa. Inverting a mask can be very useful. It allows you to paint a layer in, 
rather than out, which is handy if you only want to work with a small area. You can invert the 
mask by pressing the Invert button in the Tool Options bar.
Reset Mask: Reseting a mask reveals the entire layer it is associated with. You can reset the 
mask by pressing the Reset button in the Tool Options bar.
Erase Brush Strokes: This is a special mode used when retouching the mask created by a 
Masking Bug. It allows you to erase your brush strokes made with the Masking Brush while 
maintaining the mask from the Masking Bug.

Brush Size
You can control the size of the brush using the Size pop-up in the Tool Options bar. You use a 
small brush at high magnification for precise work and a large brush at fit to screen for gener-
al work. You can control the size of the brush several ways:

•  Use the Size pop-up in the Tool Options bar.
•  Use the left and right bracket keys ( [  ] ).
•  Use the mouse scroll wheel (preferences must be set to this).
•  Use your Wacom pressure sensitive tablet.

Feather
You control the amount of feathering or hardness of the brush by using the Feather pop-up 
in the Tool Options bar. The feather has a range from 1 to 100 percent. You use a small feath-
er at high magnification for precise, hard-edged work and a large, soft-edged brush at fit to 
screen for general work. You can visually see your feather by watching the outer concentric 
circle of the brush tool. To the right you can see examples of different feather options. You 
can control the size of the brush several ways:

•  Use the Feather pop-up in the Tool Options bar.
•  Use the shift + left and right bracket keys ( [  ] ).

Opacity
You can control the opacity, or strength of the brush with the Opacity pop-up in the Tool 
Options bar. Think of the opacity as the shade of gray you are painting with. The opacity has 
a range from 1 to 100 percent. You use a high opacity to paint quickly and hide large areas. 
You use a lower opacity for blending areas together or for subtle work. To the right you can 
see examples of different opacity options. You can control the size of the brush several ways:

•  Use the Opacity pop-up in the Tool Options bar.
•  Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
•  Use your Wacom pressure sensitive tablet.
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Perfect Brush
The Perfect Brush option incorporates a color-based, self-masking technology to help create 
precise selections and masks. When you turn the Perfect Brush option on—by clicking on the 
Perfect Brush icon in the Tool Options bar—the Masking Brush collects the colors under the 
center of the brush and applies the effect only to those colors. This protects the adjustment 
from being applied across edges, such as tree branches.

Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options:
Color Threshold: This option lets you control the balance between keep and drop colors, 
based on the area you are working on. For example, you may want the Perfect Brush to be 
very precise and only paint away very similar colors, while at other times you want it to paint 
away a broad range of colors in the same neighborhood.
Transition: This slider controls the feather of the Perfect Brush based on color. To create a 
soft edge, increase the transition. To create a harder edge, decrease the transition amount.

TIP: You can turn the Perfect Brush on and off using the Command- (Mac OS) or 
Control-r (Windows) keyboard shortcut. You can also temporarily lock the color to 
remove by holding down the Control key or the Command key. This can be useful 
when brushing through areas with a lot of openings like tree branches. 

Wacom Controls
ON1 Layers supports pressure sensitive Wacom tablets. When you use the Masking Brush 
you can enable pressure sensitive controls for the brush size, brush opacity, or both simulta-
neously. Click on the W button next to each control in the Tool Options bar to activate the 
pressure sensitive controls.

The harder you press; the greater the size or opacity will get. You can set the maximum 
value you want to use the Brush Size and Opacity sliders. To the right you can see examples 
of how pressure sensitivity can be used to control the Masking Brush.

TIP: Mask preview modes let you view your mask in either Grayscale or as a Red 
Overlay, which can be extremely helpful when working on complex masks. Turn the 
mask preview on by clicking the mask preview button located at the bottom of the 
screen. You can change the mask preview mode under View > Mask View Mode.

Quick Mask Tool
The Quick Mask Tool is often the best place to start your masks. It automatically masks large 
similar areas without the need to brush over everything. You just need to brush loosely over 
what you want to mask to give it a hint. It then figures out the rest on its own.

To use the Quick Mask Tool follow these steps:
•  Select the Quick Mask Tool from the Tool well.
•  Make sure the tool mode is set to Paint Out.
•  Loosely brush over the area you want to mask. This could be a background you 

want to remove or a sky or an area you want to remove an effect from. When you 
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release the mouse button the area is automatically expanded and masked. In sim-
ple cases your work may be done.

•  Continue to brush over the area you want to mask in (areas that were not automat-
ically removed). You can also try the Grow button. Stop brushing when you get to 
difficult areas like hair.

•  It is often helpful to switch to the Refine Brush and go over difficult areas—like 
hair—to refine your mask.

Quick Mask Tool Options bar
Mode: Controls whether you want to paint out (mask) or paint in (restore). Generally you will 
use the paint out mode.
Size: Sets the size of the tool.
Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet you can control certain 
parameters with pressure. 
Box Tool: The box tool allows you to drag a box over your subject, then press return to re-
move anything outside the box.
Grow: Intelligently expands the mask to include more similar regions.
Invert: Inverts or flips the mask so that what was hidden is now revealed and vice versa.
Reset: Resets the mask to all white.

Box Mode
The Quick Mask Tool is generally used as brush but it has a second option called Box Mode. 
This mode is perfect for when your subject is isolated and not touching the edges of your im-
age. To enable Box Mode, select the Box tool in the Tool Options bar. Then drag a box over 
your subject. You can adjust the size and position of the box using the corner handles. Then 
hit the Return key to automatically remove anything outside of the box and anything similar 
from inside the box.

Masking Bug
This is used for blending layers by creating radial, gradient and reflected gradient mask 
shapes quickly.
Masking Bug Tool Options bar

Preset: The preset pop-up includes several common ways to use the Masking Bug. These 
presets change the current Masking Bug to match the preset.
Shape: The shape pop-up controls the shape of the Masking Bug. The shapes are center, 
edges, gradient and reflected gradient.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new Masking Bug using the current settings.
Delete: Deletes the current Masking Bug
Reset: Resets the mask on the layer completely. This removes all Masking Bugs and clears any 
brushing that has been done.
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How to use the Masking Bug
Start by adding a Masking Bug to a layer by clicking on it or pressing the Add button. Then 
set the Mask View mode to Mask – Grayscale. This will let you see the Masking Bug in simple 
black and white.
Move: Click the large circle and drag.
Size: Adjust the size of the masking bug by using the solid line.
Feather: Use the dashed line to adjust the feather or hardness of the mask.
Rotate: The handle of the center circle will rotate the mask.

Working with Multiple Masking Bugs
You can use up to six Masking Bugs per layer. Each Masking Bug is re-editable until you hit 
Apply and save your image.

To add another Masking Bug, to create a complex mask shape, press the Add button or 
click outside of the current Masking Bug while the Masking Bug tool is selected.

Only one Masking Bug may be adjusted at a time. This is the active Masking Bug. You 
will see the overlay controls for the active Masking Bug while your mouse is over the preview 
area. Inactive Masking Bugs are marked with a small circle. You can select an inactive Masking 
Bug by clicking on the small circle marker.

Masking Bugs are subtractive. Each Masking Bug hides more and more of the current 
layer. When Masking Bugs overlay each other they may hide more of the layer too. You can 
always use the Masking Brush to over-ride and paint areas back in hidden by the Masking 
Bugs.

Line Mask Tool
The Line Mask tool creates linear masks that are made up of straight lines. They can include 
angles, but not curved lines. This tool is useful for masking geometric shapes like buildings 
and windows. For organic shapes like trees or ridgelines use the other masking tools.

Line Mask Tool Options bar
Mode: Add/Remove
Feather: Adjusts the feather of mask i.e. the hardness of the line transition from black to 
white.

Using the Line Mask Tool
•  Begin by selecting the tool from the tool well. Choose a point on the photo to 

begin the Mask. It is recommended you begin a point that will be good to end the 
line. Essentially you will be creating mask using only linear lines to create a shape. 
When you close the shape by clicking on the first point a paint bucket will appear 
and you simply click to remove the inside or outside of the shape.

•  Click once to establish the first point or anchor.
•  Move the cursor to the next point and click again to establish another anchor. A 

straight line from the original anchor point to the  second point will appear.
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•  Continue to set points and create lines to establish the shape of the mask.Close the 
mask snap by connect the last line to the original point. The crosshairs will display a 
circle to indicate you are at the original anchor point.

•  A paint bucket icon will appear. Click once on either the inside or outside to re-
move or add.

Refining Masks
There are three tools in ON1 Photo RAW designed to help you refine, or clean up, a mask: 
the Refine Brush, the Chisel Mask tool, and the Blur Mask tool. You use these tools after you 
have created the bulk of your masking, but want to smooth rough edges.

Refine Brush
The Refine Brush is used to clean up the borders between a subject and background, as well 
as intricate areas like hair, lace, mesh and tree branches. Once you have removed the majori-
ty of the background with the Quick Mask Tool or Perfect Brush, paint the intersection of the 
subject and background with the Refine Brush to clean up the border. This will remove islands 
of background color and make the edge more defined.

Refine Brush Tool Options
Mode: Controls the refinement mode, either paint out, which always refines to remove, paint 
in, which always refines to restore or Auto which does both at the same time. Paint out is 
recommended in most cases.
Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.
Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain param-
eters with pressure. Controls with a W icon next to them support this when they are turned 
on.
Color Decontamination: When enabled, colors from the drop regions are filtered out of the 
keep regions. This changes the colors of the pixels in the image. This is useful when the back-
ground you are trying to remove have a strong color such as green or blue screens.

Chisel Mask Tool
The Chisel tool works to remove fringes or halos along hard edges. Fringes are common 
when the background to be removed is brighter than the foreground. The chisel works like a 
chisel or plane in a wood shop. It removes just a sliver along the edges. The Chisel tool only 
works on the edges so you don’t have to be too careful when using it.

Chisel Mask Tool Options
Mode: Select remove or add
Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
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The size of the chisel does not affect how much is chiseled off.
Amount: Controls the amount of pixels that will be removed or added during each brush 
stroke.

TIP: You can double-click on the chisel tool icon in the tool well to apply the chisel to 
the entire image.

Blur Mask Tool
The Blur Mask tool softens edges of the mask where you paint. Softening the edges on 
blurred or semi-transparent subjects like hair can make them blend with a new background 
in a more realistic manner. Like the Chisel tool, the Blur tool only works on the edges in your 
masks.

Blur Mask Tool Options
Mode: In/Out/Normal lets you adjust exactly what part of the mask edge to blur. In blurs and 
lightens the mask, Out blurs and darkens the mask, and Normal blurs both light and darks.
Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.
Amount: Controls the amount of blur. Use the lowest amount needed to maintain as much 
detail as possible.

TIP: You can double-click on the blur tool icon in the tool well to apply the blur to the 
entire image
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Layers Menus

ON1 Photo RAW (Mac OS Only)
About ON1 Photo Raw: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)
Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)
Quit ON1 Photo RAW: Quits ON1 Photo RAW.

File Menu
New: Creates a new file.
Open: Open an existing file.
Add Layer(s) from File: Open a file and add it as a layer to the 
currently open file in Layers.
Open Selected from Browser: Opens the images selected in 
the mini-browser.
Browse Folder: Fly-out sub-menu of sources to Browse. You 
can also opens the browse dialog where you can select which 
folder you would like to browse in a new browser tab.
Browse Extras: Switches the browser to the Extras tab where 
you can view and open pre-installed content.
Manage Extras: Opens the Extras Manager where you can 
import and manage extras like Borders, Backgrounds, Textures 
and Presets.
Open Recent: Displays a list of recently opened files.
Close: Closes the current file. You will have the opportunity to 
save or not.
Close All: Closes all open files. You will have the opportunity to 
save or not.
Save: Saves the current file.
Save As: Opens the Save As dialog where you can select the 
filename and location to save to.
Revert to Saved: Reopens the file without your changes.
Export: Opens the Export pane.
Print: Allows you to print your image.
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Edit Menu
Undo: Removes the last file operation.
Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.
Copy: Copies the currently selected item.
Paste: Pastes the items in the clipboard to the current location.
Rename: Renames the currently selected item in the Browser.
Delete: Deletes the currently selected item in the Browser. 
Add Subfolder: Adds a subfolder inside the current folder in 
the Browser.
Adjust Canvas Size: Lets you enlarge the current dosument’s 
canvas size. 
Preferences (Windows): Opens the Preferences dialog.

Layer Menu
Duplicate: Duplicates or copies the current layer.
Delete: Deletes the current layer.
Copy Layer: Copies the current layer into memory so you can 
paste it later.
Copy Luminosity as Mask: Creates a luminosity mask from the 
current layer and copies it to the clipboard.
Paste Layer: Pastes the layer in memory into a new layer in the 
current image.
Merge Layers: Merges the selected layers into a single layer.
Merge All: Merges all layers into a single layer.
New Stamped Layer: Creates a new layer above the current 
layer that contains a merged version of all the layers under it.
Hide Other Layers: Toggles the visibility off of all layers except 
the current one. Makes it easy to see just the current layer.
New Color Fill Layer: Adds a new color fill layer.
Edit Color Fill Layer: Opens the color fill layer dialog where you 
can set the properties of the selected color fill layer.
Convert to Smart Layer: Allows you to change your layer to a 
smart layer.

Mask Menu
Invert Mask: Inverts the current mask.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask.
Paste Mask: Pastes the mask.
Create Luminosity Mask: Creates a luminosity layer mask based 
off of a photo’s black or white tonal values.
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View Menu
Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.
Zoom Out: Zooms the preview window out one increment. This 
will make the preview images smaller.
Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.
Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you to 
see every pixel in the image. This is useful when making preci-
sion adjustments.
Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.
Preview Background Color: Lets you set the background color 
options.
Show Mask: Displays the current mask either as a red overlay 
or as grayscale.
View Mode: Sets the Show Mask mode to either red overlay or 
grayscale.

Window
Minimize: Minimizes your screen.
Zoom: Zooms your window to full-size (doesn’t hide menu bar). 
Full Screen: Toggles full-screen mode (hides menu bar).
Navigator/Loupe/Histogram: Hides or shows the Navigator, 
Loupe, Histogram and Info pane.
Layers: Opens and closes the Layers pane.
Show Browser Panel: Hides or shows the Control Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Document Name: Shows the name of the open image.
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Help
Search: Searches the menu options (Mac OS only).
ON1 Photo RAW 2017 Online Help: Opens ON1.com support 
page in your default web browser.
Video Tutorials: Opens ON1.com product training page in your 
default web browser.
Welcome to ON1 Photo RAW 2017: Displays the Welcome 
window.
Check for Updates: Checks with the ON1 update server to see 
if you are running the current version. If there is a newer ver-
sion, you will be notified and be walked through the update 
process.
Sign-In: Uses your ON1 account login information to authenti-
cate your copy of ON1 Photo RAW 2017. (Sign-out will remove 
an existing authentication.)
Provide Feedback: Opens the default web browser and navi-
gates to the feedback page of the ON1 website.
About ON1 Develop (Windows Only): Opens the about box 
with the version number and license code displayed.
Help Improve ON1 Products: Opens the Improve ON1 Prod-
ucts dialog.
Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Photo RAW 2017.
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 New File  Command N  Control N
Open Command O Control O

Add Layer(s) from File Command Shift O Control Shift O

Open Selected from Browser Command Option O Control Alt O

Close Command W Control W

Save Command S Control S

Save As Command Shift S Control Shift S

Print Command P Control P

Quit Command Q Control Q

Undo Command Z Control Z

Redo Command Shift Z Control Shift Z

Copy Command C Control C

Paste Command V Control V

Delete File Delete Delete

Duplicate Layer Command J Control J

Merge Layers Command E Control E

Merge Visible Command Shift E Control Shift E

New Layer from Compo-site Command Shift J Control Shift J

Next Blend Mode Shift + Shift +

Previous Blend Mode Shift – Shift –

Layer Opacity Number keys 1-0 (10% to 100%) Number keys 1-0 (10% to 100%)

Brush Size ] (larger)
[ (smaller)

] (larger)
[ (smaller)

Brush Feather Shift ] (softer)
Shift [ (harder)

Shift ] (softer)
Shift [ (harder)

Brush Opacity Option ] (higher)
Option [ (lower)
Option number keys 1-0 (10% to 
100%)

Option ] (higher)
Option [ (lower)
Option number keys 1-0 (10% to 
100%)

Paint in/ Paint Out X X

Invert Mask Command I Control I

Toggle Perfect Brush Command R Control R

Show/Hide Mask O O

Zoom In Command + Control +

Zoom Out Command – Control –

Fit to Screen Command 0 Control 0

Actual Pixels Command Option 0 Control Alt 0

Layers Keyboard Shortcuts
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Next Browser View Mode Command B Control B

Navigate Browser Selection Arrow Keys Arrow Keys

Navigator Command 1 Control 1

Layers Command 2 Control 2

Transform Tool V V

Red Eye Tool E E

Crop Tool C C

Trim Tool T T

Masking Brush B B

Masking Bug M M

Quick Mask Tool W W

Refine Brush F F

Chisel Tool K K

Blur Tool L L

Perfect Eraser Q Q

Retouch Brush R R

Pan Tool H H

Zoom Tool Z Z

Rotate Crop Clockwise Option Right Arrow Alt Right Arrow

Rotate Crop Counter Clockwise Option Left Arrow Alt Left Arrow
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